DIGITAL VINYL SYSTEM

SPIN!

QS

WARNUNG!

Um Feuer oder einen elektrischen Schock zu vermeiden,
setzen Sie dieses Gerdt nicht Wasser oder Flussigkeiten aus!
Offnen Sie niemals das Gehduse!

WARNING!

To prevent fire or avoid an electric shock do not expose the
device to water or fluids! Never open the housing!

ATTENTION !

Afin d'éviter un incendie ou une décharge
électrique, veillez a tenir cet appareil a I'écart des liquides et
de I'humidité I N “ouvrez jamais le boitier !

Fiir weiteren Gebrauch aufbewahren!

Keep information for further reference!
Gardez ces instructions pour des utilisations ultérieurs !

www.reloop-spin.com
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DEUTSCH
Seite 02-47
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page 48-93

FRANCAIS
page 94-139

Bedienungsanleitung

ACHTUNG!

Lesen Sie sich vor der ersten Inbetriebnahme zur eigenen Sicherheit
diese Bedienungsanleitung sorgfaltig durch! Alle Personen, die mit der
Aufstellung, Inbetriebnahme, Bedienung, Wartung und Instandhaltung
dieses Geréates zu tun haben, missen entsprechend qualifiziert sein und
diese Betriebsanleitung genau beachten. Dieses Produkt erfllt die
Anforderungen der geltenden europdischen und nationalen Richtlinien,
die Konformitat wurde nachgewiesen, die entsprechenden Erkldrungen
und Unterlagen sind beim Hersteller hinterlegt.

Operation Manual

CAUTION!

For your own safety, please read this operation manual carefully before
initial operation! All persons involved in the installation, setting-up,
operation, maintenance and service of this device must be
appropriately qualified and observe this operation manual in detail. This
product complies with the requirements of the applicable European and
national regulations. Conformity has been proven. The respective
statements and documents are deposited at the manufacturer.

Mode d'emploi

ATTENTION !

Pour votre propre sécurité, veuillez lire attentivement ce mode d'emploi
avant la premiére utilisation ! Toutes les personnes chargées de
I'installation, de la mise en service, de I'utilisation, de I'entretien et la
maintenance de cet appareil doivent posséder les qualifications
nécessaires et respecter les instructions de ce mode d'emploi. Ce
produit est conforme aux directives européennes et nationales, la
conformité a été certifiée et les déclarations et documents sont en
possession du fabricant.
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DEUITSCH

BEDIENUNGSANLEITUNG

DEUTSCH

Wir gratulieren Ihnen zum Kauf des Reloop Spin! Systems. Vielen Dank, dass
Sie unserer Diskjockey-Technologie Ihr Vertrauen schenken. Vor
Inbetriebnahme bitten wir Sie, alle Anweisungen sorgfaltig zu studieren und
zu befolgen.

Nehmen Sie das Reloop Spin! Interface aus der Verpackung. Bitte Uberprifen Sie
vor der ersten Inbetriebnahme, ob kein offensichtlicher Transportschaden
vorliegt. Sollten Sie Schdden am Stromkabel oder am Gehduse entdecken,
nehmen Sie das Gerat nicht in Betrieb und setzen Sie sich bitte mit Ihrem
Fachhandler in Verbindung.

SICHERHEITSHINWEISE

ACHTUNG! Seien Sie besonders vorsichtig beim Umgang mit der

Netzspannung 240 V. Bei dieser Spannung konnen Sie einen

lebensgefahrlichen elektrischen Schlag erhalten! Bei Schaden, die durch

Nichtbeachtung dieser Bedienungsanleitung verursacht werden, erlischt

jeder Gewahrleistungsanspruch. Bei Sach- oder Personenschdaden, die durch

unsachgemape Handhabung oder Nichtbeachtung der Sicherheitshinweise
verursacht werden, iibernimmt der Hersteller keine Haftung.

- Dieses Gerat hat das Werk in einwandfreiem Zustand verlassen. Um diesen
Zustand zu erhalten und einen gefahrlosen Betrieb sicherzustellen, muss der
Anwender unbedingt die Sicherheitshinweise und die Warnvermerke
beachten, die in dieser Gebrauchsanleitung enthalten sind.

- Aus Sicherheits- und Zulassungsgrinden (CE) ist das eigenmadchtige
Umbauen und/oder Verdndern des Gerates nicht gestattet. Beachten Sie
bitte, dass Schaden, die durch manuelle Veranderungen an diesem Gerat
verursacht werden, nicht unter den Gewahrleistungsanspruch fallen.

- Im Gerateinnern befinden sich keine zu wartenden Teile, ausgenommen die
von aufen austauschbaren Verschleiffteile. Die Wartung darf nur von
fachkundigem Personal durchgefihrt werden, ansonsten verfdllt die
Gewabhrleistung!

- Die Sicherung darf nur gegen Sicherungen des gleichen Typs, der gleichen
Ausldsecharakteristik und Nennstromstarke ausgetauscht werden.

- Stellen Sie sicher, dass die Stromversorgung erst nach dem Aufbau des
Gerates erfolgt. Den Netzstecker immer als letztes einstecken. Vergewissern
Sie sich, dass der Netzschalter auf "OFF" steht, wenn Sie das Gerat ans Netz
anschlief3en.

- Benutzen Sie nur vorschriftsmdpige Kabel. Achten Sie darauf, dass alle
Stecker und Buchsen fest angeschraubt und richtig angeschlossen sind. Bei
Fragen wenden Sie sich bitte an Ihren Handler.

- Stellen Sie sicher, das beim Aufstellen des Produktes das Netzkabel nicht
gequetscht oder durch scharfe Kanten beschadigt wird.

- Lassen Sie das Netzkabel nicht mit anderen Kabeln in Kontakt kommen!
Seien Sie vorsichtig beim Umgang mit Netzkabeln und -anschlissen. Fassen
Sie diese Teile nie mit nassen Handen an!

- Stecken Sie das Stromkabel nur in geeignete Schukosteckdosen ein. Als
Spannungsquelle darf dabei nur eine ordnungsgemape Netzsteckdose des
offentlichen Versorgungsnetzes verwendet werden.

- Trennen Sie das Gerat bei Nichtbenutzung und vor jeder Reinigung vom
Netz! Fassen Sie dazu den Netzstecker an der Griffflache an und ziehen Sie
niemals an der Netzleitung!

- Stellen Sie das Gerat auf einer horizontalen und stabilen, schwer
entflammbaren Unterlage auf.

- Vermeiden Sie Erschitterungen und jegliche Gewaltanwendung bei der
Installation oder Inbetriebnahme des Gerétes.

- Achten Sie bei der Wahl des Installationsortes darauf, dass das Gerét nicht
zu grofier Hitze, Feuchtigkeit und Staub ausgesetzt wird. Vergewissern Sie
sich, dass keine Kabel frei herumliegen. Sie gefdahrden lhre und die Sicherheit
Dritter!



Gerateinnere gelangen sollte, sofort den Netzstecker ziehen. Lassen Sie das

Gerdt von einem qualifizierten Servicetechniker prifen, bevor es erneut

genutzt wird. Beschadigungen, die durch Flissigkeiten im Gerat e

hervorgerufen wurden, sind von der Gewdahrleistung ausgeschlossen. @A
- Betreiben Sie das Gerat nicht in extrem heifen (liber 35° C) oder extrem

kalten (unter 5° C) Umgebungen. Halten Sie das Gerdt von direktem

Sonnenlicht und von Warmequellen wie Heizkérpern, Ofen, usw. (auch beim

- Stellen Sie keine Flussigkeitsbehdlter, die leicht umfallen kénnen, auf dem ’l
Gerat oder in dessen N&he ab. Falls doch einmal Flissigkeit in das

Transport in geschlossenen Wagen) fern. Verdecken Sie niemals vorhandene i i*igg‘
Lifter oder Liftungsschlitze. Sorgen Sie immer fiir eine ausreichende w’ﬁ
Ventilation.

- Das Gerat darf nicht in Betrieb genommen werden, wenn es von einem kalten
Raum in einen warmen Raum gebracht wurde. Das dabei entstehende
Kondenswasser kann unter Umstanden Ihr Gerat zerstéren. Lassen Sie das
Geréat solange uneingeschaltet, bis es Zimmertemperatur erreicht hat!

- Regler und Schalter sollten niemals mit Sprihreinigungsmitteln und
Schmiermitteln behandelt werden. Dieses Gerdt sollte nur mit einem
feuchten Tuch gereinigt werden, verwenden Sie niemals Losungsmittel oder
Waschbenzin zum Reinigen.

- Bei Umzlgen sollte das Gerat im urspringlichen Versandkarton
transportiert werden.

- Zu Beginn miissen die Uberblendregler und Lautstarkeregler lhres
Verstarkers auf Minimum eingestellt und die Lautsprecherschalter in "OFF"-
Position geschaltet sein. Vor dem Lauterstellen 8 bis 10 Sekunden warten,
um den durch Einschwingung erzeugten Schroteffekt zu vermeiden, welcher
zu Lautsprecher- und Frequenzweichenschdden fihren kénnte.

- Gerate, die an Netzspannung betrieben werden, gehdéren nicht in
Kinderhande. Lassen Sie deshalb in Anwesenheit von Kindern besondere
Vorsicht walten.

- In gewerblichen Einrichtungen sind die Unfallverhidtungsvorschriften des
Verbandes der gewerblichen Berufsgenossenschaft zu beachten.

- In Schulen, Ausbildungseinrichtungen, Hobby- oder Selbsthilfewerkstatten
ist das Betreiben des Gerates durch geschultes Personal verantwortlich zu
Uberwachen.

- Heben Sie diese Bedienungsanleitung fir spatere Fragen und Probleme gut
auf.

HHYSINEA

BESTIMMUNGSGEMABE VERWENDUNG
Bei diesem Gerat handelt es sich um ein digitales Timecode System, mit dem
sich Software Uber die beigelegten Timecode Vinyl Platten bzw. CDs steuern
lasst. Das Interface wird dabei mit einem USB Kabel am Computer
angeschlossen.

- Dieses Produkt ist flir den Anschluss an 240 V, 50 Hz Wechselspannung
zugelassen und wurde ausschlieflich zur Verwendung in Innenrdaumen
konzipiert.

- Wird das Gerat anders verwendet als in dieser Bedienungsanleitung
beschrieben, kann dies zu Schaden am Produkt flihren und der
Gewahrleistungsanspruch erlischt. Auperdem ist jede andere Verwendung
mit Gefahren wie z.B. Kurzschluss, Brand, elektrischem Schlag, etc.
verbunden.

- Die vom Hersteller festgelegte Seriennummer darf niemals entfernt werden,
da ansonsten der Gewéhrleistungsanspruch erlischt.



L
O
N
j—
-
Lol
a

WARTUNG

Uberpriifen Sie regelmapig die technische Sicherheit des Geradtes auf
Beschadigungen des Netzkabels oder des Gehduses, sowie auf die
Abnutzung von Verschleifiteilen wie Dreh- und Schiebereglern.

Wenn anzunehmen ist, dass ein gefahrloser Betrieb nicht mehr méglich ist,
so ist das Gerat aufer Betrieb zu setzten und gegen unbeabsichtigten
Betrieb zu sichern. Netzstecker aus der Steckdose ziehen!

Es ist anzunehmen, dass ein gefahrloser Betrieb nicht mehr mdglich ist,
wenn das Gerat sichtbare Beschdadigungen aufweist, das Gerat nicht mehr
funktioniert, nach ldngerer Lagerung unter unginstigen Verhaltnissen oder
nach schweren Transportbeanspruchungen.

Dieses Handbuch, Video-Tutorials, Tipps & Tricks und weitere Downloads
kénnen Sie unter folgender Webseite finden:

www.reloop-spin.de

MINDESTE SYSTEMANFORDERUNGEN:

aktueller Prozessor (empfohlen wird mindestens Pentium IIl, 1GHz)
Windows 2000, XP, NT, Vista Betriebssystem

freier USB-Port

min. 512 MB RAM

1. Anschluss & Softwareinstallation

1.1 Anschluss
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a) Verbinden Sie die Ausgange lhres Plattenspielers oder CD-Players mit den
entsprechenden Eingdangen (1 oder 2) vom Reloop SPIN! Interface -1-.
Gegebenenfalls erden Sie Ihre Plattenspieler an der GND Erdungs-
schraube -3-.

b) Verbinden Sie die Line-Ausgange des Reloop SPIN! Interfaces mit den Line
Eingdngen lhres Mixers. -2-

¢) Verbinden Sie das Reloop SPIN! Interface mit Ihrem Computer Uber einen
freien USB-Anschluss. Nun sollten folgende Meldungen, im Beispiel XP, auf
Ihrem Monitor erscheinen:

Neue hardware gefunden -
Reloop Spin! Interface

jr} Neue Hardware gefunden |

Reloop Spin!-Interface

Neue Hardware gefunden -
USB Audiogerat

._:lf.} Meue Hardware gefunden | *
[J5E-audioger &t

Neue Hardware gefunden -
Die Hardware wurde installiert und kann jetzt verwendet werden.

) Neue Hardware gefunden x

Die neue Hardware wurde installiert und kann jetzt verwendet
werden,

HINWEIS!
Die Installation Ihres Spin!-Interfaces erfolgt unter Windows XP & Vista
nach dem Plug 'N' Play-Prinzip ohne spezielle Treiber.

d) Nachdem Ihr Spin!-Interface vom System erkannt und installiert wurde,
sollten Sie die Lautstdarke in den Windows Audioeinstellungen maximieren.

Beispiel XP:
Start > Systemsteuerung > Sounds und Audiogerate > Reiter ,,Audio”

Eigenschaften von Sounds und Audiogerite m
| Lautstiike | Sounds | Audio | Stmme | Hadware |
Soundwiedergabe
Standardgerat:
| Feloop SpinlInterface M
[ Lautstarke... J[ Ernweitert... ]
Soundaufnahime
ﬁ Standardgerat:
| Feloop SpinlInterface M
[ Lautstarke... ][ Erweitert... I

MIDI-Musikwiedergabe

% Standardgerat:

ety |Microsoft G5 Wavetable 5w Sunth M

[ Lautstarke: ] [ Infao ]

Mur Standardgerate verwenden

Ut
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DEUITSCH

Drlcken Sie die Schaltflache ,Lautstarke” unter dem Punkt ,,Sound Wiedergabe"
und ,Sound Aufnahme”. FUr best mdégliche Ergebnisse maximieren Sie alle

Regler.
m[autsprecher E_ﬂg]m
Optionen 2
Lautzprecher Wave SW-Synthesizer CD-Flayer Line
Balance: Balance: Balance: Balance: Balance:
PO ¢ 00 96T 9> >0 ¢
Lautstarke: Lautstarke: Lautstarke: Lautstarke: Lautstarke:
[Ion a:us : [ Ton aus []Ton aus [ Ton aus []Ton aus
Reloop Spin!-Interface
Die Option .Soundaufnahme" fc..-JoEs
unterscheidet sich flr ein Vinyl- oder | gptienen 2 Optioren
CD'SetUp. Line Line
. . Balance: Balance:
1) Vinyl Einstellungen 3 <@ Py
Dricken Sie die Schaltflache C Y 0 Y
Lauts'térkf_: _____

2)

,Soundaufnahme” und maxi- R
mieren Sie den Regler.

CDJ Einstellungen - =g

Dricken Sie die Schaltflache DTE\ ................. |:|Ti .................
- Ton auz Ton aus

.Soundaufnahme” und  mini-

mieren Sle den Regler 1) Reloop Spin!-Interface 2) Reloop Spin!-Interface

Sie kdnnen danach die Systemsteuerung schliefen.

e)

Weitere Funktionen bzw. Anschlisse lhres Spin!-Interfaces:

USB-LED -4-:
Leuchtet wenn das Interface vom Computer erkannt wird und aktiv ist.

HINWEIS!
Das Interface wird per USB mit Strom versorgt. Es ist also kein
Stromanschluss noétig.

Kopfhérer -5 / 6-:

Hier kénnen Sie einen Kopfhorer anschlieBen (3,5 mm Klinke) um das
Master-Ausgangssignal direkt am Interface vorzuhéren -5-. Mit dem Monitor-
Regler -6- kdnnen Sie die Lautstarke einstellen.

HINWEIS!
Sie kénnen diesen Ausgang auch als Record-Anschluss nutzen, um
beispielsweise ein Set aufzunehmen.

Mikrofon -7 / 8-:
Am Anschluss -7- kdnnen Sie ein Mikrofon (6,3 mm Klinke)
anschlieffen. Die Lautstarke kdnnen Sie mit dem Regler -8- einstellen.

ACHTUNG!

Der Mikrofon-Eingang ist mit dem Stereo-Ausgang gekoppelt, d.h. Sie
konnen entweder ein Mikrofon benutzen oder das Ausgangssignal von
Kanal 1. Achten Sie darauf, dass wahrend der normalen Timecode-
Benutzung von Spin! kein Mikrofon angeschlossen wird, ansonsten ist
der Kanal blockiert.



CD or Turntable CD or Turntable

Turntable 1 I Mixer Turntable 2 CD 2

N—

1.2 Softwareinstallation

Nachdem Sie das Hardware-Setup vorgenommen haben, kommen wir nun zur
Softwareinstallation. Legen Sie dazu die SPIN! Installations-CD in das CD-ROM
Laufwerk Ihres Computers. Sollte das Setup nicht automatisch starten, fihren

Sie bitte die Datei , Install.exe” manuell aus.

Wahlen Sie die Installations-Sprache aus und bestatigen mit ,,0K".

ﬁ

Language ?

" Deutsch

" Frangais

ok | Cancel |

Lesen und akzeptieren Sie danach die Lizenzvereinbarungen.

)

Fleaze read the license term before installing.

RELOOF LICENSE AGREEMENT |§‘

B CLICKING THE ACCEPTANCE BUTTOM OR INSTALLING OR USING THE RELOOP
SOFTWARE [THE "PRODUCT"), THE INDIVIDUAL OR ENTITY LICENSING THE PRODUCT
["LICENSEE"] 1S CONSENTING TO BE BOUMD BY AND |5 BECOMING & PARTY TO THIS
AGREEMENT. IF LICENSEE DOES NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, THE BUTTON INDICATING MOM-ACCEPTANCE MUST BE SELECTED, AND
LICEMSEE MUST MOT INSTALL OR USE THE PRODLICT.

1. LICEMSE: The Product is Iic:en_sx_ed, not zold. The Product iz protected by copyright law and

international copyright treaty provisions, as well as other intellectual property laws and treaties. You

Do you accept all terms of this license " hccept | Decline
agreement ? b : —

7
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Nun mussen Sie lhren Namen, ggf. Firma, E-Mail Adresse (notwendig) und die
Seriennummer eingeben. Die Seriennummer finden Sie auf der Rickseite der
Spin! Installations-CD-Hdlle. Bestéatigen Sie Ihre Eingabe mit , weiter”.

X}

Mame

IYDur harme

Company

IYDur company

Email

Iyour@email.con’]
Code

Copyright © 2008 RES1GH . Refoop | |
’WI Cancel |

Wahlen Sie dann das Installationsverzeichnis in der Ihre Spin! Software installiert
werden soll, oder verwenden Sie das Standardverzeichnis (empfohlen). Bitte
bestdtigen Sie mit , weiter"”.

(INSTALL B

Install Directary:

|C:\Frogramme’ ReloopsReloop Spin
Browse...l
@recoop) |
Beadie | < Back | Mext > | Cancel |

Nach erfolgreicher Installation schliefen Sie das Setup wieder mit ,,Finish".

X

rm‘l’nLL

EreLoop)

ReI66

Beadie |

HINWEIS!
Uberpriifen Sie regelmapig www.reloop-spin.de auf neue Updates.

ACHTUNG VISTA USER!

Falls Sie das Programm aufgrund der Fehlermeldung “The Serial Number is
not correct” 6ffnen konnen, so miissen Sie die Benutzerkontensteuerung
deaktivieren.

> Systemsteuerung > Sicherheitscenter > Benutzerkontensteuerung >
deaktivieren

Alternativ starten Sie die Software durch Rechtsklick auf das Spin!-lcon mit
der Option “Als Administrator ausfiihren”.



1.3 Easy Setup

Beim ersten Start von Reloop Spin! startet das Easy Setup automatisch.

HINWEIS!
Das Easy Setup kann auch manuell unter dem Meniipunkt >Help>Easy Setup!
Ausgefiihrt werden.

1. Resolution/Auflésung
Im ersten Schritt wahlen Sie lhre Bildschirmaufldsung aus.

SPIN!
SPINIT 024

Resolution:

1280 Widescreen

USPINE 1280

Step1 /6

< ZUriich I Weiter » I Abbrechen

2. Kalibrierung Eingang 1

Nun muss die Kalibrierung vorgenommen werden. Wdahlen Sie dazu das
entsprechende Abspielmedium aus. Gehen Sie in den Wiedergabemodus und
dricken Sie ,Weiter".

m

Source connected :

7 Mo Source

" CD Player

» Choose source > Play the timecaode souwrce > Press 'Mest!
Tip:
Please set Fitch to 0% and spin in forward direction

Step 2 /B

< Zuriick I wieiter > I Abbrechen

N

HHYSINEA
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3. Kalibirierungsergebnis fiir Eingang 1
Nach erfolgreicher Kalibrierung sollte die Meldung ,Spin! has been calibrated
successfully” erscheinen.

HINWEIS!

Sollte die Meldung ,,Spin! has not been installed properly” erscheinen,
liberpriifen Sie Ilhre Anschliisse oder wechseln Sie die Nadeln an lhrem
Plattenspieler aus.

SPIM! haz been calibrated sucessfully!

Tip:
Pleaze check connections and hardware setup.
More options under File > Options » Audio devices AMD > Timecode

Step3 /6

< Zuriick  |{ wieiter > Abbrechen |

4. Kalibirierung Eingang 2
Nehmen Sie die gleichen Einstellungen fir Ihr zweites Abspielgerét vor.

¥ Setupl! - Cali ﬁ

Source connected :

" NoSource

" CD Player

» Choose source > Flay the timecode souce » Press Mest'
Tip:
Please set Fitch to 0% and spin in forward direction

Stepd /B

< Zuriick. I Wwieiter > I Abbrechen




5. Kalibrierungsergebnis Eingang 2

Auch hier sollte eine erfolgreiche Kalibrierungs-Meldung erscheinen.

HINWEIS!

Die Kalibrierung ist nur fiir Plattenspieler notwendig. Beim Anschluss von

CD-Playern wird dieser Punkt i{ibersprungen.

Easy Setup! - Result 2 w
SPIM! haz been calibrated sucesshully!
Tip:
Pleaze check connections and hardware zetup.
tore options under File > Options > Audio devices AMD > Timecode
Step5 /6
< Zuriick  |i Welter» ¢ Abbrechen |

6. Bei erfolgreichem Setup werden lhre Einstellungen bestatigt.
Beenden Sie das Schnellsetup durch Betatigen der , Fertig stellen”-Taste.

Easy Setup! - ﬁptlmlzati"on .

&

Optimize SPIMI:

Set thiz optian if vou control SPIMI mainly with vingl or od

v Tick scrolling

Set this option for display optimization

[~ MoBPM and Waveform calculation on load

Set this option to optimimize the loading of files. However no BPM AW aveform will be displayed

StepB /B

< Zuriick. I Fertig slellenl Abbrechen |

HINWEIS!

Im abschliefenden Installations-Schritt haben Sie noch drei Moglichkeiten
um Spin! zu optimieren. Nahere Informationen dazu finden Sie im Kapitel 4.1

»Optionen".

HHYSINEA
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1.4 Erste Software-Schritte
Folgend werden die ersten Schritte, die Sie vornehmen mussen, erklart um mit
der Spin! Software arbeiten zu kénnen.

HINWEIS!
Die Anleitung erreichen Sie auch aus dem Menii
> Help > Manual.

a) Musik importieren

Importieren Sie zundchst Ihre Musik in die Spin! Library. Gehen Sie dafir im
Meni auf den Punkt

> Spin! Library > Auto Search.

Hier kdnnen Sie entweder einzelne Ordner oder Laufwerke automatisch nach
Musik durchsuchen lassen. Bestdtigen Sie Ihre Auswahl mit ,,0K".

b) Track laden
Nachdem Sie |hre Musik importiert haben, kdnnen Sie einzelne Tracks in die
Player 1und 2 laden. Dazu stehen Ihnen drei Mdglichkeiten zur Verfigung:

e Via Maus
Ziehen Sie per Drag & Drop den Titel in den Player.

e Via Trax Select
Auf der B-Seite der Spin! Timecode Vinyl Platte ist der letzte Rillenabschnitt
far die Auswahl der Titel konzipiert worden. Setzen Sie die Nadel in diesen
Abschnitt um durch die Spin! Library zu navigieren. Halten Sie die Platte am
gewtlinschten Track an und setzen die Nadel an den Anfang der Platte zurick
um den gewlnschten Track in den Player zu laden.

e Via Tastatur
Navigieren Sie in der Spin! Library mit den hoch/runter-Pfeiltasten zum
gewilnschten Track und dricken Sie die Enter-Taste um diesen Track zu
laden. Der aktive Player wird mit der Tab-Taste angewahit.

c) Timecode Modus aktivieren
Aktivieren Sie den Timecode Modus durch die Taste ,Vinyl”, rechts unter dem
Label-Monitor.

Jetzt kénnen Sie mit dem Auflegen beginnen.



2. SOFTWAREUBERSICHT:

Main «»
Volume

3

e Fred Falke - Love lost | /

Remain: 02:54.30

S

Repeat: OFF Qut Port:
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1. Shortcut: New Spin! Library
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.2.1.

2. Shortcut: Open Spin! Library
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.2.2.

3. Shortcut: Auto Search
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.2.7.

L@

4. Shortcut: Save Spin! Library
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.2.3.

i

B
%#%sizgzsrg@&ﬁ

5. Shortcut: Stop Spin! List
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.4.2.

6. Shortcut: Play Spin! List
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.4.1.

7. Shortcut: Loop Spin! List
Hiermit wird die Spin! Playlist in einer Endlosschleife wiederholt.

8. Shortcut: Shuffle Spin! List
Hiermit wird eine zufdllige Wiedergabe der Spin! List erzeugt.

9. Shortcut: Previous
Hiermit wird der vorherige Track aus der Spin! List in den Player geladen.

10. Shortcut: Next
Hiermit wird der nachste Track aus der Spin! List in den Player geladen.

11. Shortcut: Music Explorer / Audio Input
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.5.9.1.

12. Shortcut: Spin! Library
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.5.7.

13. Shortcut: Spin! List
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.5.8.

DEUITSCH

14. Shortcut: Category View
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.5.9.

15. Shortcut: X-Fader Match View
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.5.9.2.

16. Shortcut: Master/Rec. Volume
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.5.9.3.

17. Shortcut: Beat Match View
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.5.9.4.

18. Shortcut: Options
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.1.2.

19. Safe Mode
Bitte entnehmen Sie Informationen hierzu dem Kapitel 3.4.4.

QIEIICIOEIGIC IBIOOO«/QIO,
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20. Beatmatch View

Die Beat Match-Ansicht zeigt lhnen die Peaks beider Tracks - die beiden
Ansichten stehen sich dabei gegentber. Hier kann schnell erkannt werden, ob
beispielsweise die Bassdrums oder Snares Ubereinander laufen. So kénnen Sie
schnell und einfach, sofern beide Tracks vom Tempo angeglichen wurden, die
Stlicke synchronisieren. Dabei wird der linke Player 1in grin dargestellt und der
rechte Player 2 in grau.

21. Complete View

In der Complete View Ubersicht sehen Sie den gesamten Wellenverlauf eines
Tracks. Hier kénnen Sie beispielsweise sehr gut den Spannungsbogen eines
Tracks erkennen und auf einen Blick sehen, wo Intros und Breaks einsetzen. Der
bereits abgelaufene Teil eines Tracks wird dabei grin dargestellt, der noch
verbleibende Teil ist grau dargestellt.

22. Needle View

Die Needle View ist eine vergroferte Ansicht der Wellenformdarstellung. So
kdnnen Sie beispielsweise einzelne Bass-Kicks gut erkennen.

Sie kdnnen den Zoom-Bereich von 2 bis 16 Beats einstellen. Klicken Sie dazu mit
der rechten Maus-Taste in die Needle View und wahlen im Untermenl den
entsprechenden Wert aus.

Ferner kénnen Sie auswdhlen ob die linke, rechte, Stereo oder beide Kandle
gemischte Wellenform angezeigt werden sollen. Wahlen Sie die entsprechende
Option mit Rechtsklick in der Needle View aus.

Sie haben zwei Varianten der Needle View Darstellung:

e Waveform Scrolling
Die Wellenform bewegt sich. Ein vertikaler Strich in der Mitte reprdsentiert
die Nadel.

e Tick Scrolling
Die Wellenform bleibt stehen. Der Strich (entspricht der Position der Nadel)
bewegt sich.

HINWEIS!
Diese Option ist Systemresourcen-sparender.

Wahlen Sie die entsprechende Option mit Rechtsklick in der Needle View aus.

23. Master
Hier stellen Sie die Hauptlautstarke fir Player 1 bzw. Player 2 ein.
Main ===

Volume 2

17
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24. Track 6ffnen/laden
Hiermit kdnnen Sie eine einzelne Datei in den Player laden.

25. Bypass-Funktion

Ist die Bypass-Funktion aktiviert, so wird das Eingangssignal vom Spin! Interface
direkt durch die Software geschleift. So kdnnen Sie eine normale Vinyl Platte
abspielen. Deaktivieren Sie die Bypass-Funktion fir den normalen Timecode-
Gebrauch. Die Schnelltasten daflr sind ,,N” (Player 1) bzw. ,,M" (Player 2).

26. Label-Monitor

Der Label Monitor ist eine Art virtuelle Platte, die sich entsprechend der
Timecode-Platte mitbewegt. Jede Bewegung, die Sie mit der Platte ausfihren,
wird synchron zum Label Monitor Ubertragen. Fir Beat Juggling kdnnen Sie den
Label Monitor beispielsweise gut als virtuellen Marker benutzen.

T

*- Bypass

—_—
. DRGITAL VIRYL 5YSTEM
.

27. Gain Regler

Der Gain-Regler ist, ahnlich wie beim Mischpult, die Endverstdrkung eines
Kanalzuges. Hiermit kdnnen Sie Tracks unterschiedlicher Aufnahmelautstarken
einander angleichen ohne die Master-Lautstarke zu erhéhen.

HINWEIS!

Unter > File > Options > Reiter ,,BPM And Tools!" > Abschnitt ,,Auto BPM"
konnen Sie die Auto Gain-Funktion aktivieren. Somit werden die Gain-Werte
der Tracks, ohne manuelles Zutun, automatisch angeglichen.

Gﬂlﬂ TR

i EE R




28. Pitch Mode

Sie haben die Mdglichkeit mit dem Pitch Fader -29- drei verschiedene Pitch-Modi
einzustellen. Sie verandern den Modus, indem Sie mit der Maus auf die
Schaltflache -28- dricken oder via der Schnelltaste ,,A” (Player 1) bzw. K"
(Player2).

a)

b)

Speed Mode

Im eingestellten Speed-Mode kdnnen Sie ganz reguldr, wie bei einem
Plattenspieler, die Pitch-Geschwindigkeit einstellen. Im eingestellten Pitch-
bereich wird der aktuelle Wert auch in der Info View -48- an der Stelle -7-
dargestellt.

Master Tempo Mode (MT)

Ist der Master Tempo-Modus aktiviert, so kdnnen Sie mit dem Pitch-Fader -

29-im Bereich +/- 6% das Tempo verdandern, ohne dass die Tonhdhe dadurch
beeinflusst wird. Das bedeutet, dass die Tonhdhe bei verdndertem Tempo

gehalten wird.

HINWEIS!
Der Master Tempo-Modus funktioniert nur im Advanced- und Battle-Modus
(siehe Punkt 31).

c)

Key Mode
Der Key-Modus stellt den Gegensatz zum Master Tempo-Modus dar. Hier wird
die Tonhdhe, unabhangig vom eingestellten Tempo, variiert.

HINWEIS!
Der Key-Modus funktioniert nur im Advanced- und Battle-Modus.

29. Pitchfader

Der Pitchfader stellt einen herkémmlichen Pitchfader eines Plattenspielers bzw.
CD-Players dar. Im Timecode Vinyl Modus -30- bewegt sich der Fader synchron
zu den am Plattenspieler ausgefiihrten Bewegungen.

Dieser ist abhdngig vom eingestellten Pitch-Modus (siehe Punkt 28). Im
deaktivierten Timecode Modus kann der Pitchfader auch mit der Maus bewegt
werden.

N

HHYSINEA
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30. Vinyl Timecode-Aktivierung

Mit dieser Taste aktivieren Sie den Timecode-Modus, d.h. die Steuerung per
Timecode-Vinyl und Timecode-CD sind mdoglich. Ist diese Taste deaktiviert,
kénnen Sie die Software nur per Maus kontrollieren.

31. Spin! Mode-Taste

Durch Betatigen dieser Taste kdnnen Sie zwischen den Abspiel-Modi Spin! Mode,
Classic Spin!, Advanced Spin!, Battle Spin! wahlen. Die Schnelltasten sind , A"
(Player 1) bzw. ,,K" (Player 2).

a) Classic Spin!
Die Audio-Dateien werden wie bei einer normalen Platte, von Anfang bis zum
Ende abgespielt (Needle Drop). Klassisches Mixen und Scratchen ist mdglich,
jedoch ohne Loop-, Cue-Punkt-, und Effekt-Optionen.

b) Advanced Spin!

In diesem Modus ist ,,Needle Drop” ebenfalls mdglich. Dieser ist aber
proportional zur Vinyl-Lange. Will man also beispielsweise in die Mitte eines
Liedes springen, dann muss man die Nadel in die Mitte der Timecode-Platte
platzieren. Klassisches Mixen und Scratchen ist unter Hinzunahme von
Loops, Cue-Punkten und Effekten mdglich.

c) Battle Spin!
In diesem Modus ist kein Needle Drop mdglich. Das bedeutet, dass der Track
immer weiter 1duft, egal wo sich die Nadel auf dem Timecode-Vinyl befindet.
Dieser Modus ist sehr gut zum Scratchen geeignet, selbst wenn die Nadel
springen sollte. Battlemixen unter Hinzunahme von Loops, Cue-Punkten und
Effekten ist hier mdglich.

HINWEIS!
Dieser Modus ist nur fiir die Vinylkontrolle gedacht.

| Battie
32. Play/Pause-Taste

Durch Betatigen dieser Taste starten Sie den zuvor ausgewdahlten Track. Diese
Funktion steht Ihnen nur im PC-Kontroll-Modus zur Verfiigung. Die Schnelltaste
ist die Space Bar-Taste, je nach aktiviertem Player (TAB-Taste).



33. Cue-Taste
Durch Betatigen dieser Tasten gelangen Sie in den Cue-Modus. Um einen Cue-
Punkt zu setzen haben Sie zwei Méglichkeiten.

a) Cue-Pause
Im Wiedergabe-Modus driicken Sie die Play/Pause-Taste -32- um in den
Pause-Modus zu gelangen. Driicken Sie nun die Cue-Taste um den Cue-Punkt
zu setzen.

b) Loop In
Wahrend der Wiedergabe oder im Pause-Modus kénnen Sie die Loop In-Taste
betdtigen um einen Cue-Punkt zu setzen. Die Schnelltasten dazu sind ,,F1”
(Player 1) bzw. ,,F9" (Player 2).

34. Vor- und Riickwartslauftaste

Mit der Vor- und Rickwartstaste bestimmen Sie die Abspielrichtung des Tracks
(forward oder reverse). Im Timecode-Modus zeigt diese Taste die Laufrichtung
der Platte an.

35. Skip-Tasten

Driicken Sie diese Tasten, um den vorherigen bzw. nachfolgenden Track aus lhrer
SPIN! Library zu laden.

36. Schnellsuchlauftasten

Mit diesen Tasten ist es mdglich innerhalb eines Tracks schnell vor- oder
rickwarts zu spulen. Im Timecode-Modus ist diese Funktion deaktiviert.

37. Pitch Bend-Tasten

Aktivieren Sie die Geschwindigkeits-Feinregelung mit der Pitch Bend-Taste. Mit
den Pitch Bend-Tasten kénnen Sie durch Gedrickthalten die Geschwindigkeit
temporar erhéhen bzw. vermindern. Lassen Sie die Taste los, so kehrt der Player
zur mit dem Pitch-Fader eingestellten Geschwindigkeit zurtick. Durch Drehen des
Jog-Wheels im PC-Kontroll Modus ist diese Funktion ebenfalls ausfihrbar (siehe
Jog SPIN! Mode). Im Timecode-Modus ist diese Funktion deaktiviert.
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38. SPIN! Library

In diesem Browser finden Sie alle wichtigen Informationen zu den Tracks lhrer
SPIN! Library. Um einen Track direkt aus der Library auszuwdahlen, klicken Sie
diesen an und bewegen ihn per Drag & Drop auf den gewlinschten Player.
Alternativ kdnnen Sie auch direkt Uber die Time Code-Platte die Track-Select-
Funktion auswdhlen (siehe Kapitel 1.4, Punkt b).

Per Schnelltaste , V" aktivieren Sie die Spin! Library um mit den Pfeil
hoch/runter-tasten in dieser zu navigieren. Durch Drlicken der Enter-Taste
kénnen Sie den Track in den aktiven Player laden. Mit der TAB-Taste kann man
zwischen Player 1 und Player 2 hin- und herwechseln.

n Last Played

dh

1. Search Filter
In diesem Feld haben Sie die Mdglichkeit Stichwort-artig nach einem Track zu
suchen. Je genauer die Einagbe, desto genauer wird die angezeigte Auswahl.

2. Exact Match
Ist diese Option aktiviert, werden nur exakte, mit dem Suchwort
Ubereinstimmende Ergebnisse angezeigt.

3. Selection Filter
Hier kénnen Selektionsfilter nach denen gesucht werden soll definiert
werden. Zur Auswahl stehen:

o Al
Bei diesem Filter werden alle Kategorien bei der Suche beachtet.

e File
Ist dieser Filter aktiviert, so werden bei der Suche nur Dateinamen
beachtet.

e Title
Ist dieser Filter ausgewdhlt, so werden bei der Suche nur Titelnamen
beachtet.

e Artist
Ist dieser Filter ausgewdhlt, so werden bei der Suche nur
Interpretennamen beachtet.

e Album
Ist dieser Filter ausgewahlt, so werden bei der Suche nur Album-Namen
beachtet.

e Genre
Ist dieser Filter ausgewahlt, so werden bei der Suche nur Genre-Namen
beachtet.

e Remix
Ist dieser Filter ausgewdhlt, so wird bei der Suche nur nach Remixen
gefiltert.

e Year
Ist dieser Filter ausgewdahlt, so werden bei der Suche nur Jahreszahlen
beachtet.

e BPM
Ist dieser Filter ausgewahlt, so wird bei der Suche nur nach
Geschwindigkeiten gefiltert.

e Directory
Ist dieser Filter ausgewahlt, so werden bei der Suche nur Ordner-Namen
beachtet.



4. Categories

In dieser Ansicht werden alle Informationen zum Track, wie Titel, Name oder
BPM angezeigt. Sie kénnen die Kategorien selber definieren, indem Sie mit
Rechtsklick auf die Kategorie-Leiste dricken (Columns Properties).

Zur Auswahl stehen:

Title

Artist
Album
Genre

BPM
Duration
Last Played
Remix
Rating
Comments
Year

Track

File
Directory
File Name
File Extension
Date Created
Label
Producer
Key
Counter

HINWEIS!

Sie konnen samtliche Informationen zum Track seber editieren, indem
Sie mit der Maus ins jeweilige Kategoriefeld doppelklicken. Falls Sie
mochten, dass diese Attribute (ID3 TAG) permanent zum Track
gespeichert werden, so klicken Sie im Menii beim jeweiligen Track auf:

> Track > Save ID3 TAG Attributes

Mit Rechtsklick in die Spin! Library View kénnen Sie ein Untermenu aufrufen,
welches folgende Optionen beinhaltet:

O
=
C
=
n
O
L

Add Track (siehe 3.2.8)
Auto Search (siehe 3.2.7)
Track Preferences (siehe 3.3.1)
Analyse BPM manually (siehe 3.3.3)
Analyse BPM automatic (siehe 3.3.4)
Select All
Hiermit werden alle Tracks der aktuell geladenen Spin! Library markiert.
e Delete
Hiermit werden die markierten Titel aus der Spin! Library entfernt.
e Add to Spin! List
Die markierten Tracks werden der Spin! List hinzugeflgt.
e Group
Hiermit kdnnen Sie die markierten Tracks einer selbst erstellten
Gruppe/Playlist zuweisen bzw. I6schen. Ndheres dazu finden Sie unter
Punkt 49.
e List View
Hiermit kdnnen Sie Ihre Spin! Library auf den Anzeige-Modus List View
stellen. In der List View wird nur der Titel angezeigt. Somit kbnnen mehr
Titel auf einmal in der Liste angezeigt werden, ohne scrollen zu mussen.
e Detail View (voreingestellt)
In dieser Ansicht werden alle eingeblendeten kategorien zum Track
angezeigt.
e Column Properties
Hier kdnnen Sie, wie zuvor beschrieben, einzelne Kategorien ein- bzw. 23
ausblenden.
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39. Delay-Effekt

Driicken Sie zuerst die Effektaktivierungstaste -39- liber dem Delay-Drehregler.
Der Delay-Effekt ist nun aktiviert. Durch Drehen des Delay-Drehreglers kénnen
Sie die Intensitat des Delay-Effektes einstellen. Dricken Sie erneut die
Effekaktivierungstaste, um den Effekt wieder zu deaktivieren.

40. Filter-Effekt

Dricken Sie zuerst die Effektaktivierungstaste -40- Uber dem Filter-Drehregler.
Der Filter-Effekt ist nun aktiviert. Durch Drehen des Filter-Drehreglers kénnen
Sie die Intensitdt des Filter-Effektes einstellen. Dricken Sie erneut die
Effekaktivierungstaste, um den Effekt wieder zu deaktivieren.

41. Flanger-Effekt

Drlcken Sie zuerst die Effektaktivierungstaste -41- iber dem Flanger-Drehregler.
Der Flanger-Effekt ist nun aktiviert. Durch Drehen des Flanger-Drehreglers
kénnen Sie die Intensitat des Flanger-Effektes einstellen. Dricken Sie erneut die
Effekaktivierungstaste, um den Effekt wieder zu deaktivieren.

e e ey

Flanger--: Filter =+« Delay ---
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42. Beat Loop/Auto Loop-Funktion

Ihre Reloop Spin! Software besitzt eine intelligente Beat Loop-Funktion. Mit
dieser kénnen Sie mit einem Knopfdruck automatisch, abhdngig vom
eingestellten Takt, Beat-genaue Loops erstellen. Es ist somit nicht mehr nétig die
In- und Out-Punkte manuell zu setzen.

Wahlen Sie den gewilinschten Takt mit den Beat Loop Takt-Tasten -42 b- aus
(1/2 - 16 Takte). Aktivieren Sie den Beat Loop mit der Beat Loop-Taste -42 a-;
diese blinkt im Beat Loop-Modus. Verlassen Sie den Beat Loop mit der
Play/Pause-Taste -32-.

Verwendung mit der Tastatur:

+ Drlcken Sie im Wiedergabe-Modus ,,F4" (Player 1) bzw. ,F12" (Player 2) um
in den Beat Loop-Modus Uberzugehen.

« Mit den Tasten ,F5"/"F6" (Player 1) bzw. ,,F7"/"F8" (Player 2) kdnnen Sie den
Loop verldngern bzw. verklrzen.

+ Drlcken Sie die Space Bar um den Auto Loop zu verlassen (den aktiven
Player mit der TAB-Taste auswahlen).

43/44. Manuelle Loop-Funktion

+ Um einen Loop manuell zu setzen, driicken Sie die Loop In-Taste -44- zum
gewilinschten Anfangspunkt und die Loop Out-taste -44- zum gewiinschten
Endpunkt.

+ Durch erneutes Drlicken verlassen Sie den Loop.

+  Durch Driicken der Reloop-Taste -43- kehren Sie zum zuletzt gesetzten Loop

zuruck.
[Funktion [Player 1 [Player 2
Loop In F1 F8
Loop Out F2 F10
Reloop F3 F11

(i) o) (oo ] fommmn]
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45, Crossfader

Der Crossfader -45- ist lediglich fir den PC-Kontroll-Modus gedacht. Im
regularen Timecode Modus (externes Mischpult) werden Sie diesen nicht
bendétigen. Hiermit kann von Kanal 1 zu Kanal 2 Gbergeblendet werden.

HINWEIS!
Im Timecode-Modus sollte dieser in der Mitte stehen.

B ECooP)y
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46. Beat Match-Funktion

Die Beat Match-Funktion ist eine praktische Hilfe um schnell per Knopfdruck die
Tempi zweier verschiedener Tracks anzugleichen. So kann entweder der linke
dem rechten Player angeglichen werden, oder der rechte dem linken Player.

Beatmatch Schnelltaste
Player 1 Y
Player 2 X

47. Cue-Punkte
Sie haben die Méglichkeit bis zu 6 Cue-Punkte pro Track zu setzen. Diese werden
automatisch dauerhaft gespeichert bis sie wieder Uberspielt werden.

+ Um einen Cue-Punkt mit der Maus zu setzen, driicken Sie im entsprechenden
Moment die rechte Maustaste

+ Um einen Cue-Punkt abzurufen reicht ein Klick mit der linken Maustaste

« Ist ein Cue-Punkt gespeichert, erkennt man dies an der dicken griinen
Markierung der entsprechenden Cue-Taste

« Setzen Sie den Cue-Punkt einmalig fir Player 1 mit den Nummern1-5 (nur
5 Cue-Punkte pro Player) und fur Player 2 mit den Tasten 6 - O.

« Erneutes Dricken der entsprechenden Nummern ruft den Cue-Punkt auf
(Hot Cue)

O
=
C
=
n
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48. Info-View

Nathan Fake - The Sky Was F

Remain: 05:50.98

Repeat: OFF Out Port: @

1. Title

— Hier wird der Titel des aktuellen Tracks angezeigt. Mit Rechtsklick darauf
kénnen Sie wdahlen, ob nur Titel, nur Artist oder Artist und Titel angezeigt
werden sollen.

2. Elapsed
Hier  wird die verstrichene Zeit des Tracks angezeigt
(Minuten/Sekunden/Frames).

3. Remain
Hier wird die noch verbleibende Zeit eines Tracks angezeigt (Minuten /
Sekunden / Frames).

4. BPM
Hier wird der aktuelle BPM-Wert angezeigt.

5. Repeat-Funktion

Hier kénnen Sie die Track-Wiederholung ein- bzw. ausstellen. Bei
eingestellter Repeat-Funktion wird der geladene Titel automatisch
wiederholt.

6. Out Port

Hier wird angezeigt welchem Ausgangskanal des Interfaces der Player
zugewiesen ist. Bei einer korrekten Einstellung sollte beim linken Player ,,01"
und beim rechten Player ,,02" stehen. Durch Anklicken kénnen Sie den Port
verandern.

7. Pitch
Hier wird der aktuelle Pitch-Wert angezeigt.

49, Category View

Die Category View ist eine Art Schnellauswahl-Filter fir die Spin! Library. In
dieser kdnnen Sie beispielsweise nach Alphabet, Jahr oder BPM-Geschwindigkeit
die Spin! Library View anzeigen lassen.

Unter dem Punkt ,,Groups” kdnnen Sie eigene Playlists bzw. Sortierungen
vornehmen. Um eine neue Gruppe zu erstellen, driicken Sie mit Rechtsklick in
der Category View auf den Punkt ,,Add Group”. Sie werden nun aufgefordert,
einen Namen einzugeben - bestatigen Sie diesen mit der Enter-Taste.

X
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50. Music Explorer/Audio Input

Der Music Explorer ist, wie Sie es vom Windows Explorer kennen, ein Datei-
Browser in Baumansicht. Hier kdnnen Sie nach Dateien in lhrem Arbeitsplatz
oder lhrer Netzwerkumgebung suchen. Zusatzlich ist hier auch das Spin!
Interface unter dem Punkt , Audio Input” zu finden. Die einzelnen Eingdnge sind
dort aufgelistet. Per Drag & Drop kdnnen auch einzelne Eingange fir eine
einfache Zuweisung auf die Player gezogen werden.

HINWEIS!

Per Voreinstellung sind die Eingange bereits richtig gesetzt. Nur fiir eine
Mikrofonaufnahme muss der Eingang ,,0: Reloop Spin!-Interface 1" einem
Player zugewiesen werden.

51. Mic Rec-Funktion

Mit der integrierten Mic Rec-Funktion (Mic Spin!) kénnen Sie ein Mikrofon-
Sample aufnehmen, welches spater beispielsweise gescratcht werden kann.
Gehen Sie dazu wie folgt vor:

e Sample Aufnahme

- Ziehen Sie den Eingang ,,0: Reloop Spin!-Interface 1" unter Audio Input
(Music Explorer) per Drag & Drop in einen der Player.

- Stellen Sie den Pegel mit dem Mic Lautstarkeregler ein.

- Dricken Sie auf die Rec-Taste.

- Ein Speichern Dialog 6ffnet sich; geben Sie hier Namen und Ort an, wohin
das Sample gespeichert werden soll.

- Nachdem Sie auf ,speichern” gedriickt haben fangt die Aufnahme an;
beenden Sie die Aufnahme durch erneutes Driicken der Rec-Taste.

e Mic Spin! Funktion (Sample abspielen bzw. scratchen)
- Ziehen Sie nun einen gewdinschten Track aus der Spin! Library oder das
aufgenommene Mic-Sample aus dem Music Explorer per Drag & Drop in den
Player, um es mit der Platte zu manipulieren.

HINWEIS!

Der Mic-Eingang ist mit dem Input 1 gekoppelt. Sobald Sie das Mikrofon
anschliefen ist der Phono/Line-Eingang 1 deaktiviert. Falls Sie also wahrend
einer Mixing-Session ein Sample aufnehmen wollen, achten Sie darauf, dass
der Player 2 gerade lauft. Ziehen Sie unbedingt nach der Aufnahme das
Mikrofon wieder ab, um den Player 1 wieder per Platte steuern zu kénnen.
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52. Monitor Funktion

Mit der Software Monitor-Funktion kdnnen Sie einen Track vorhodren. Diese
Funktion ist jedoch bei Verwendung eines externen Mischpultes nicht nétig, da
Sie in der Regel Uber dessen Cue-Funktion vorhoren.

3. RELOOP SPIN! MENUFUHRUNG:

In diesem Abschnitt werden alle MenUpunkte Schritt fir Schritt erklart.

3.1 Meniipunkt File:

3.1.1 Options:

Hierliber gelangen Sie in das Menid Optionen in dem Sie diverse Einstellungen
vornehmen kénnen. Nahere Informationen hierzu erhalten Sie im Kapitel 4.1 in
dieser Anleitung.

3.1.2. Quit Spinning:
Hiermit beenden Sie die Reloop Spin! Software

Mit der Reloop Spin! Library verwalten Sie lhre Audiodateien. Auf Wunsch
kénnen Sie auch diverse Libraryen anlegen und abspeichern. Sie kbénnen lhre
Musik in die Spin! Library importieren um eine zentrale Sammelstelle lhrer
Dateien zu erhalten. Es ist mdglich, Libraryen zu editieren, exportieren oder
neue Listen zu importieren (z.B. iTunes Playlisten).

3.2.1 New:
Hiermit wird eine neue, leere Library erstellt, die Sie nach Bedarf mit Audio-
Dateien flllen kénnen.

3.2.2 Open:
Hiermit 6ffnen Sie eine vorhandene Library.

3.2.3 Save:
Hiermit kdnnen Sie Ihre Library abspeichern.

3.2.4 Save as...:
Hiermit speichern Sie die aktuelle Library unter anderem Namen, ohne die
vorherige Library zu Uberschreiben.

3.2.5 Import:
Hiermit kdnnen Sie Dateien importieren. [ iTunes (*.xml) / m3u Files (*.m3u)]

3.2.6 Export:
Hiermit kdnnen Sie Dateien exportieren. [m3u Files (*.m3u)]

3.2.7 Automatic Search:

Zum Massenimport von Musik-Dateien kdnnen Sie mit dieser Funktion
komfortabel lhre Festplatte oder gegebenenfalls gezielt einzelne Ordner
durchsuchen.

3.2.8 Add Track:
Hiermit kdnnen einzelne Tracks zur Library hinzugefligt werden.

3.2.9 Select All:
Hiermit wahlen Sie alle Tracks aus der Library aus.



3.2.9.1 Delete:
Hiermit kénnen Dateien aus der aktuell geladenen Library entfernt werden, ohne
diese jedoch von der Festplatte zu I6schen.

3.3 Track Meni:

N

3.3.1 Track Preferences:
Hier kbnnen Sie Track-spezifische Einstellungen vornehmen.

3.3.2 Save ID3 TAG Attributes:
Falls Sie ID3 TAG-Attribute dndern, kénnen Sie diese abspeichern.

3.3.3 Analyze BPM manually:

Mit diesem Tool kénnen Sie die BPM (Beats Per Minute) manuell ermitteln. Dies
kénnen Sie entweder durch Klicken der Space-Schaltflache mit der Maus erzielen
oder mit Hilfe der Leerzeichen-Taste. Je ldnger Sie im Takt die entsprechende
Taste dricken, desto genauer wird der Wert ermittelt.

3.3.4 Analyze BPM automatically:

Durch diese Funktion wird der BPM-Wert automatisch ermittelt. Beats sind fur
die Software nicht zahlbar, wenn keine kontinuierliche Rhythmusstruktur
vorhanden ist oder sich die Beats zu schwach vom Rest des Tracks abheben, um
als Rhythmuselement identifiziert zu werden. Beats im 4/4 Takt sind ideal fir die
Reloop Spin! Software.

HINWEIS!

Sie konnen auch mehrere Tracks automatisch analysieren lassen. Wird ein
Track zum ersten Mal in den Player geladen, so wird automatisch die BPM-
Zahl ermittelt und dauerhaft abgespeichert.

3.3.5 Delete tracks permanently:
Mit dieser Funktion kénnen Sie einen Track l6schen.

ACHTUNG!
Der Track wird in diesem Fall dauerhaft von lhrer Festplatte geléscht und
nicht nur aus der Library entfernt.

3.4 Spin! List Menii:

Die Spin! List ist eine Art ,,Party”-Playlist. Die darin enthaltenen Tracks werden
im Falle einer Wiedergabe abwechselnd von den Playern 1 und 2 abgespielt und
automatisch Ubergeblendet. Diese Funktion bietet sich optimal an, wenn Sie
ohne DJ die Software im Stand Alone-Modus betreiben wollen.

3.4.1 Play Spin! List:
Hiermit starten Sie die Wiedergabe der Spin! Playlist.

3.4.2 Stop Spin! List:
Hiermit kdnnen Sie die Wiedergabe der Spin! Playlist anhalten.

3.4.3 Add to Spin! List:
Hiermit fligen Sie den aktuell gwahlten Track in der Library der Spin! List hinzu.

HINWEIS!
Sie konnen auch per Drag & Drop Tracks zur Spin! List hinzufiigen.

3.4.4 Safe Mode:
Ist der Safe Mode aktiviert, kann kein neuer Track in den laufenden Player
geladen werden. Dies verhindert ein ungewolltes Laden neuer Musik im
laufenden Betrieb.

N
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3.5 Menii Spin! Workspace:
In diesem MenlU kénnen Sie einzelne Elemente ein- und ausblenden, um die
Ansicht individuell gestalten zu kénnen.

3.5.1 Workspace Arrangeable:
Ist dies aktiviert, kénnen einzelne Fensterelemente neu arrangiert und
geschlossen werden.

3.5.2 Full Screen View:
Aktiviert die Vollbildansicht. Alternativ kann dies durch die Tastenkombination
ALT+S durchgefihrt werden.

3.5.3 Menii Bar View:
Blendet die Menleiste ein/aus.

3.5.4 Shortcut View:
Blendet die Schnellzugriffansicht ein/aus.

3.5.5 Info View:
Blendet die Infoleistenansicht ein/aus.

3.5.6 Preview
Blendet die Previewleiste ein/aus.

3.5.7 Spin! Library View:
Blendet die Spin! Library ein/aus.

3.5.8 Spin! List View:
Blendet die Spin! List ein/aus.

3.5.9 Category View:
Blendet die Kategorieansicht ein/aus.

3.5.9.1 Music Explorer / Audio Input:
Blendet die Music Explorer / Audio Eingdnge-Ansicht ein/aus.

3.5.9.2 X-fader Match View:
Blendet die X-Fader Match-Ansicht ein/aus.

3.5.9.3 Master/REC-Volume:
Blendet die Master/REC Lautstarkeansicht ein/aus.

3.5.9.4 Beatmatch View:
Blendet die Beatmatch-Ansicht ein/aus.

3.6 Help Menii:

3.6.1 Easy Setup:
Hierliber kénnen Sie das Schnell-Setup aufrufen.

3.6.2 Manual:
Hiermit kdnnen Sie das Handbuch als PDF-Datei aufrufen.

3.6.3 www.reloop-spin.com
Hiermit rufen Sie die Internetseite www.reloop-spin.com auf. Besuchen Sie diese
Seite in regelmafigen Abstdanden um aktuelle Downloads oder Infos zu erhalten.

3.6.4 Configuration Log:
Hiermit wird eine aktuelle Systemkonfigurationsibersicht als Textdatei erstellt.
Diese wird zur eventuellen Problemsuche bendtigt.

3.6.5 About Spin!:
Hier wird die aktuelle Spin!-Version angezeigt.



4. EINSTELLUNGEN

4.1 Options

Sie erreichen das Options-Meni unter

> File > Options.

4.1.1 System

Em— 8|

System | BPM and Tooks | Audio devices | Timecods | wirkspass | Shetteuts | MIDI-Contier |

i~ Track

g Set directory of \
1 W fgad st ack (sp\w Plalst [ J) 04
2 (% RecodPlay  View List ) Set diectory where )
O L warveltommns ane saved J J 5
3 (TAES I ID3Tag¥.1
¥ ID3Tag.2

- Optimizatior

6 £ Software Mult-Open
7 ¥ Sound before Graphic prioity

Load track to RAM  |nomal =

() (=

(Lnad tack in RAM |13 = Ienglh\imit/minulas}

10 ¥ Easy Kepboard Search Tone pitch B 3: # n

Abbrechen

1. Load last Track
Ist diese Option aktiviert, wird bei einem Software-Start der zuletzt gespielte
Track und Spin! Library geladen.

2. Record Play

Ist diese Funktion aktiviert, werden alle gespielten Tracks mit Angabe von
Datum und Uhrzeit in einer Liste gespeichert. Durch Dricken auf die
Schaltflache ,,View List"” kénnen Sie diese einsehen.

3. TAGs
Hier kénnen Sie auswahlen welche Version der ID3 TAGs angezeigt werden
soll. Es sollte hier nur eine Option gewdahit werden.

4. Play List Directory
Hier kdnnen Sie den Pfad wahlen wohin die Spin! List gespeichert/geladen
werden soll.

5. Waveform Directory
Hier kdénnen Sie den Pfad angeben, in dem die Waveform Peaks-
Informationen gespeichert werden sollen.

6. Software Multi Open
Ist diese Funktion aktiviert, so kann Reloop Spin! mehrmals ge&ffnet werden
(nicht empfehlenswert / ASIO-abhdngig).

7. Sound before Graphic Priority

Ist diese Option aktiviert, so wird die Systemleistung vorrangig der
Musikleistung als der Grafikleistung zugeordnet. Dies ist bei dlteren oder
leistungsschwacheren Rechneren von Vorteil (wenn es beispielsweise zu
Aussetzern kommt).

N

)

HHYSINEA

31



8. Load Track to RAM
Hier kdnnen Sie einstellen wie schnell der Track in den RAM Speicher
geladen werden soll. (langsam / normal / schnell).

9. Load Track in RAM/Min.
Hier kénnen Sie in Minuten die maximale Tracklange angeben, die in den
RAM-Speicher geladen werden soll.

10. Easy Keyboard Search
Ist diese Funktion aktiviert so kann man in der Library und dem Music
Explorer per Buchstabeneingabe navigieren.

11. Tone Pitch
Hier kénnen Sie den prozentualen Bereich einstellen, in dem die Tonhdhe
gepitcht werden soll (siehe auch Kapitel 2, Punkt 28).

4.1.2 BPM and Tools

Spstem  BPM andTDDIS|Audiudevices Timecode | Workspace | Shorteuts | MIDI-Controller

i~ Auto-BPM

(EPMHangefurAulo-Euuntmg Min: |78 3: BPM Max: |150 3: BFM)

| Show Pitch Value

| Calculate EPM and Waveform on load

|v Auto-Gain Function

¥ EPM Match Function

OI0I0I0I6

- Cue-Pain

(Autn-ﬁua- Mo FYES) (T\melangefnlSEEIDhiI’\gfilStEue-PDil’\t 10 3: s) (dE Sensitivity |30 3: )

(=)o)

~ Time-Adj

DEUITSCH

(Fadmglime[F'\aylisl—Autumm] 10 3: s) (Tlmelangefcrwammgalendoftlack 10 3: s)

Abbrachen

1. BPM Range

Hier kénnen Sie die BPM-Spanne, in der die Software kalkulieren soll,
einstellen. Je kleiner die Differenz, desto schneller und praziser kann Spin!
die BPM ermitteln. Die Voreinstellung liegt zwischen 78 - 150 BPM.

Empfohlene Einstellungen:

. All-Round 78 - 150 BPM
+  Hip Hop 80 - 120 BPM
+  House/Techno 110 - 150 BPM

2. Show Pitch Value
Aktiviert die Pitch-Anzeige (voreingestellt und empfohlen).

3. BPM and Waveform
Ist diese Option aktiviert, kalkuliert Spin! die BPM und Wellenform beim
Laden eines Tracks (voreingestellt und empfohlen).
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4. Auto Gain

Ist diese Funktion aktiviert, werden die Gain-Werte bei Tracks
unterschiedlicher Lautstarke angepasst. Somit ist ein manuelles Angleichen
mit dem Gain-Regler -27- nicht mehr nétig.

5. BPM Match
Aktiviert die Auto Match-Funktion bei neu geladenen Tracks.

N

HINWEIS! ' Y 4
Mit der Beat Match-Taste -46- konnen Sie auch jede Seite miteinander

synchronisieren. T
6. Auto Cue \

Hiermit kdnnen Sie die Auto Cue-Funktion ein- und ausschalten.

7. First Cue Point Search
Hiermit kdnnen Sie den Zeitrahmen in Sekunden setzen, bis wann der erste
Cue-Punkt gesucht werden soll.

8. dB Sensitivity
Hier kénnen Sie die Empfindlichkeit in Dezibel einstellen, ab dessen
Schwellenwert der Cue-Punkt gesetzt wird.

9. Fading Time
Hier kdnnen Sie die Uberblendungszeit fiir die Auto Mix-Funktion der Spin!
List einstellen.

10. End of Track Warning
Hier kdnnen Sie die Zeit in Sekunden einstellen, ab wann optisch Uber das
Ende eines Tracks gewarnt werden soll.

4.1.3 Audio Devices
M

System | BPM and Tooks Audio devices | Tinecods | workspass | Shortcuts | MIDI-Contoler |

Output Device Feloop Spw-ltte.faca - e ﬂ
G B

HHYSINEA
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Abbrechen

1. Output Device
Hier wird das Reloop Spin! Interface ausgewahlt und sollte dort angezeigt
werden.
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2. Out Ports
Hier wird die Anzahl der Ausgange definiert. Es sollte eine ,,2" eingestellt
werden.

3. Setup

Hier kdnnen die einzelnen Ausgange fir die linke und rechte Seite eingestellt
werden. Auch kann mit der Schaltflache ,,Control Panel” im ASIO-Setup die
Buffer-Grépe eingestellt werden.

HINWEIS!

Samtliche Audio Devices-Einstellungen sind mit dem Easy Setup
automatisch vorgenommen worden, so dass Sie hier keine
Veranderungen vornehmen miissen.

4.1.4 Timecode
Options ﬁ

System | BPM and Tools | Audio devices  Timecods | warkspace | Shaiteuts | MIDI Contioler |

Naise Level 40 =
Moise Filter (=]

~Player 1 Player 2
@— +—Timecads fiom [virgt | [vinyl =l
@——ww Mode | Battle SPIN! | | Classic SPINI =l
@— —Audio device Jasio =l Jasin =l
—Audio Sourcs | 0Retoop Spintinterace 1-Felaop Spintd x| | 2Relnop Spinnterface 3Reinop Spind > |
@— —Timecode ualy o 100
@— —{Adiusl Gain (0B) El= 1 = s = v = HE
—Diract Phors Input No  w ne =] BEE
45 RPM I ] I I
@— —Left/Right Inverse o u
—FPhase Inverse r o
— s [l =1 Saveposiion [0 = Saveposiion
O E
(13}
(=)

15 Calirate 1 Calibrate 2
Apply ;ﬁov;“‘[ﬁfi&ns‘““; Circle diagram | 1 Tumntable Mode |
[ [ok ] _asbrechen

In diesem detailierten Timecode-MenlU kdnnen einzelne Einstellungen fir
Player 1 und Player 2 vorgenommen werden. Diese sind bei erfolgreichem Easy
Setup allerdings nicht ndétig. Sie sollten also nur zur Problembehebung und
Optimierung die erweiterten Einstellungen vornehmen.

1. Timecode from
Hier kdnnen Sie die Timecode-Quelle, also Vinyl oder CD, einstellen.

2. Spin! Mode
Hier kann der Spin! Mode eingestellt werden (siehe Kapitel 2, Punkt 31).

3. Audio Device
Hier sollte der ASIO-Treiber eingestellt sein.

4. Audio Source
Hier werden die entsprechenden Anschlisse des Spin! Interfaces
zugewiesen.

Voreingestellt sind:
+ Player 1: 0: Reloop Spin!-Interface 1 - Reloop Spin!-Interface 2
«  Player 2: 2: Reloop Spin!-Interface 3 - Reloop Spin!-Interface 4



5. Timecode Quality

Hier wird prozentual die Signalqualitdt des Timecodes angezeigt.
Schwankungen oder eine zu geringe Prozentzahl kdnnten eine verschmutzte
oder verschlissene Nadel als Ursache haben. Idealerweise sollte der Wert
zwischen 90 - 100% liegen.

6. Adjust Gain

Hier kann der Dezibel-Wert des Input-Signals fur die linke und rechte Seite
eingestellt werden. Die virtuelle LED-Kette dient dabei als
Aussteuerungsanzeige. Diesen Wert sollten Sie nur bei einer
Problembehebung manuell dndern. Im Easy Setup-Verfahren wird der
optimale Gain-Wert automatisch fir Sie konfiguriert.

7. Direct Phono Input
Hier kann definiert werden ob ein Plattenspieler direkt am Rechner
angeschlossen wurde. In Verwendung mit dem Spin! Interface (Line Output)
muss hier ,No" stehen.

8. 45 RPM
Hier kann eingestellt werden, ob die Timecode-Platte mit 45 RPM (Rounds
Per Minute = Umdrehungen pro Minute) abgespielt werden soll.

Voreingestellt und Gblich sind 33 RPM.

9. Left/Right Inverse

Bei bestimmten Nadeln oder Kalibrierungsproblemen kann es sein, dass die
linke und rechte Seite vertauscht sind. Dies kdnnen Sie in der Software mit
dieser Option beheben.

10. Phase Inverse
Hiermit kdnnen Sie die Phase umkehren.

11. Timecode Start Delay

Hier kann der Startpunkt der Timecode-Platte definiert werden. Da
Ublicherweise das erste Drittel einer Timecode-Platte zuerst verschlissen ist,
kann man den Startpunkt an eine gewilinschte Position versetzen. Setzen Sie
dazu die Nadel an die gewiinschte Startposition und driicken die Schaltflache
.Save Position”. Der Wert wird in Millisekunden angegeben.

12. Noise Level/Noise Filter
Diese beiden Werte sind nur zur Problembehebung bzw. Optimierung
gedacht. Beim Easy Setup sind diese Werte bereits vorkonfiguriert.

e Noise Filter:
Bei Masseproblemen 0.4. kénnen Sie den Noise Filter erhéhen um das
Eingangssignal zu verbessern, beispielsweise auf 150. Je hdher das
Rauschen, desto hdher sollte die Frequenz angehoben werden.

ACHTUNG!
Die Timecode-Prdzision konnte bei zu hoch eingestelltem Noise
Filter abnehmen.

e Noise Level:
Hier kdnnen Sie den Rauschpegel in Dezibel einstellen. Fir eine bessere
Empfindlichkeit sollten Sie den Wert erhéhen. Voreingestellt sind 40 dB.

13. Kalibrierungs-Display

Hier wird das Timecode-Signal optisch dargestellt. Idealerweise sollte das
Signal wie eine Sinuskurve dargestellt werden.

Bei einem verzerrten Signal (Rechteckwelle) sollten Sie entweder die Nadel
Uberprifen oder die oben genannten Einstellungen anpassen.

ﬁgzg
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14. Circle Diagram
Alternativ kann das Kalibirierungs-Display auch als Kreisdiagramm angezeigt
werden. Aktivieren Sie dazu diese Schaltflache.

15. Calibrate-Taste
Betatigen Sie diese Taste, um den jeweiligen Player mit den voreingestellten
Optionen automatisch zu kalibrieren.

16. 1 Turntable Mode

Falls Sie nur einen Plattenspieler einsetzen, sollten Sie diesen Modus
aktivieren, um beide Player zu kontrollieren. Achten Sie darauf, dass unter
Audio Source (siehe Punkt 4) der gleiche Interface-Eingang gewahlt ist.

TIPP!
Den aktuellen Player konnen Sie mit der TAB-Taste umschalten.

17. More Options
Aktivieren Sie diese Schaltflache, um die erweiterten Optionen einzublenden
(Noise Level/Noise Filter und 1 Turntable Mode).

18. Apply
Dricken Sie diese Schaltflache, um die Einstellungen zu Ubernehmen.
Driicken Sie abschliefend auf ,,OK", um das MenU zu verlassen.

4.1.5 Workspace
M

System | BPM and Tools | Audio devices | Timecods Warkspacs | Shaiteuts | MIDI-Contoler |

| Warkspace Fil

SFINI
SPINIT 024

Resolution:

1280 Widescreen

DEUITSCH

1
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“SPINE 280 —

Abbrechen

1. Resolution Selection
Hier werden die vorhandenen Auflésungen aufgelistet. Wahlen Sie hier die
entsprechende Auflésung fir Ihren Bildschirm.

2. Apply
Ubernehmen Sie die Einstellungen mit dem Apply-Button.
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4.1.6 Shortcuts
[ |

System | BPH and Tools | Audic dvices | Timecods | Workspace  Shertcuts | MIDI-Contioler |

+ Shortcut-Setting Fil

Spin_Keyboardds
Spin_Kepboard?ZERTY
Spin_Kepboardd'W
Spin_KeyboarddWERTY

LooP BEATLOOP BEATLOOP LOOP

am— s |
[ o 3

Abbrechen

1. Shortcut Setting File
Hier kdnnen Sie das Schnelltasten-Layout fir Ihre Tastatur auswahlen.

Zur Auswahl stehen:

+  Spin_keyboardQWERTZ
(Deutschland, Osterreich, Schweiz, Ungarn)

+  Spin_keyboardQWERTY
(Amerika, England, Niederlande, Italien, Skandinavien, Polen,
Spanien, Portugal)

*  Spin_keyboardAZERTY
(Frankreich, Belgien)

2. Layout Preview
Hier wird die Tastaturbelegung in einer Vorschau dargestellt.

N
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4.1.7 MIDI Controller

Options

System | BPM and Tools | Audio devices | Timecods | Workspacs | Shortcuts MIDI-Contioler |

i~ MIDI Input

ActivateMIDI: [T

)

nnnnn D I =]
- -

MIDI-Setup-Fils{s)

()

()

Abbrechen

1. Activate MIDI
Hiermit aktivieren Sie die MIDI-Steuerung fir Spin!

2. MIDI Device
Hier werden kompatible MIDI-Controller aufgelistet, z.B. Reloop Digital
Jockey (www.digital-jockey.dj).

3. MIDI Setup File
Hier werden die vorkonfigurierten MIDI-Konfigurations-Dateien aufgelistet.

4. Omni Mode
Ist diese Option aktiviert, empfangt Spin! auf allen MIDI-Kandalen.

DEUITSCH

HINWEIS!

Bitte (iberpriifen Sie regelmdpig Spin! auf Updates unter
www.reloop-spin.de um beispielsweise neue MIDI-Mappings
herunterzuladen.

38



4.2 Auto Search

P

0 >Ca rive or directory

O ([ J

%_ | Select directary &)l drives |
1

a
@_ | &dd directony I Subdirectories I Mo duplicate @
@ Advanced zearch

Artigt Title

Albrmn Genre

Comments ear

Exact search |, &llfields search |, Iritialize SPIM! Library [,

QK Cancel b e |

© © "

Mit der Auto Search-Funktion kénnen Sie ganz einfach Musikdateien auf
Ihrer Festplatte lokalisieren und lhrer Spin! Library hinzuflgen lassen.

1. Pfad
Hier wird der aktuell ausgewahlte Pfad angezeigt.

2. Select Directory
Hiermit kdnnen Sie einzelne Ordner auswahlen.

3. Add Directory
Ist diese Option aktiviert, wird ein Ordner hinzugeflgt.

4. All Drives
Wahlen Sie diese Option um automatisch alle Laufwerke lhrer
Arbeitsumgebung auszuwahlen und nach Tracks zu durchsuchen.

HHYSINEA

5. Subdirecories
Ist diese Option ausgewahlt, werden Unterordner bei der Suche ebenfalls
eingeschlossen.

6. No Duplicate
Ist diese Option aktiviert, werden bei erneuter Suche im gleichen Ordner die
bereits hinzugefligten Tracks nicht erneut der Spin! Library hinzugefigt.

7. Advanced Search
Hier kénnen Kategorien wie Artist, Title oder Genre bei der Suche gefiltert
werden.

8. Exact Search
Ist diese Option aktiviert, werden nur exakt Ubereinstimmende Ergebnisse
hinzugeflgt.

9. All Fields Search
Ist diese Option aktiviert, wird in allen Kategoriefeldern gesucht.

10. Initialize Spin! Library
Wird diese Option aktiviert, so wird die Spin! Library initialisiert.
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4.3 Track Preferences

In den Track Preferences kdnnen Sie diese Einstellungen und Daten eines Tracks
aktivieren. Sie erreichen die Track Preferences entweder unter dem MenUpunkt:
> Track > Track Preferences

oder auch durch Rechtsklick auf den Track selber in der Spin! Library.

4.3.1 Infos

Hier kénnen Sie diverse Informationen, wie z.B. Titel, Interpret oder Label,
einsehen und editieren. Es kénnen auch zusatzlich Kommentare zum Track
gespeichert werden.

M
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Cover I E qualization I Cue-Points I Loop
Infoz | File | Track. zettings | Walume | Lyricz
Tile  |ChubKartuscheD3 Track |04
Arist  |typ2 Year |2003

Album |F'ress Flay

Genre IEIec:tn:nnic j R ating I‘II:I.a"IEI
R emix |Fleh-1i:-: Label Ithru:unfu:ulger

Comments | muspace. com/typ?

Ok I Abbrechen

4.3.2 File

Hier werden Informationen zum Speicherort und zur Audio-Qualitdt angezeigt.

M

Cover I
Infog File

E qualization I

Cue-Points I Loop

Track zeftings | Waolume I Lyrics

IE: yp2_Clubk.artbuzche. mp3

IF'EM Stereo 16 Bitz 44100

Encode by I

Encoder IGHB

ISRC |

CCr (D I

Language |Electru:|

YWwieb |myspau:e.u:u::m£typ2

(] I Abbrechen




4.3.3 Track Settings

Hier kdnnen Sie diverse Einstellungen, wie Start- und Endpunkt, Loops oder

Tempo einsehen und editieren.

M

Cover I E qualization I Cue-Points I Loop
Irifios I File Track zettingz | Yalume I Lyrics
Pozition File

Start End Cruration

[oo:ooonoo0 = Jon043soez | |0435982 Hesetl

Paosition &

Loop
Poszition B

[oo:0000000-s]  [ooooo0oo0=s [ Loopwhale media [

Speed [%]

Baze tempo IU 3: Saong gainlﬂ 3: Saong key I

0 : Out il =

oKk | Ahbrechenl

4.3.4 Volume

Hier kdnnen Sie Gain, Pan oder Fade In/Out auf Wunsch fur den Track

voreinstellen.

M

Cover I E qualization I Cue-Points I Loop
Irifios I File I Track setings Wolume | Lyrics
Yalume/Pan Fade [zec]

Gain [dB) |I ]
[ n
J |u -
L Pan R [ Out
I IEI 3:

oK | .&I:ul:ureu:henl

N

)i
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4.3.5 Lyrics

Hier kdnnen gegebenenfalls Songtexte eingetragen und eingesehen werden.

ﬁm

Cover
Infos

| File

E qualization

I Track zettings

Cue-Pointz
| Walume

Loop
Lyricz

(] I Abbrechen

4.3.6 Cover

Hier kann ein Cover Artwork zum Track geladen und angezeigt werden.

M

I Track zettings

E qualization

-

| Yolume
Cue-Points

Lyrics
Loop

C:hipp2_back. gif

0k

Abbrechen




4.3.7 Equalization

Hier kdnnen Sie EQ-Einstellungen vornehmen.

M

Infog I File | Track zettings | Yalume I Lyricz
Cover Equalization | Cue-Paints I Laop
Equalization Sterea

" Marmal
{ Bass II 5:

" Mid IU 3: " Waice removal [center

" Treble ID 3: " Channels inverted [L<->R)

" Mono

 Vaice removal [phaze]

(] I Abbrechen

4.3.8 Cue Points

Hier kbnnen gegebenenfalls bis zu 10 Cue-Punkte vordefiniert werden.

M

Infog I File I Track zettings | Yalume I Lyricz
Cover I E qualization Cue-Points | Loop

1 | Sort |
2 =

3 E Initialize |
4 —|

5 =

; =

7 -

; —

3 -

10 —

(] I Abbrechen
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4.3.9 Loop
Hier kbnnen gegebenenfalls bis zu 10 Loops vordefiniert werden.

1 !
it Track m

Infog I File I Track zeftings | Walume I Lyricz I

Cover I E qualization I Cue-FPoints Laop

O P
o

= W 00 - M e L a2

(] I Ahbbrechen

5. FAQ

5.1 Braucht man spezielle Nadeln fiir die Plattenspieler, um Spin! benutzen
zu kénnen?

Nein. Prinzipiell wird Spin! mit jeder Nadel funktionieren. Allerdings sollten ein
paar Dinge sichergestellt sein, um einen reibungslosen Ablauf zu erreichen:

Die Nadel darf nicht abgenutzt sein und sie sollte nicht verdreckt sein. Sofern es
sich um ein Headshell-System handelt, sollte sie richtig justiert sein. Auperdem
sollte sie eine mdglichst hohe Ausgangsspannung haben, um ein ,reines”
Timecodesignal an die Software zu schicken. Aus diesem Grund ist Spin!
ebenfalls im Bundle mit den ORTOFON DIGITRACKS erhaltlich. Durch die Ortofon
,Concorde”-Bauart entfallt das Justieren der Nadel unter einer Headshell - die
sehr hohe Ausgangspannung von 8mV garantiert ein ,kraftiges”, wenig
stérungsanfalliges Timecodesignal.

5.2 Kann man die Timecodevinyls auch einzeln nachkaufen?

Natdrlich. Timecodevinyls verschleifen schneller als normale Vinyls, da sie
wahrend des Auflegens nicht gewechselt werden. Abgesehen von der normalen
Abnutzung und den Kratzern, die sich daraus ergeben, setzen Staub, Fett, Nikotin
und der ein oder andere Spritzer Vodka-Martini den Platten ganz schén zu. Aus
diesem Grund gibt es im Fachhandel Ersatzvinyls in den Farben Schwarz,
Mattweif3 und Giftgrin.

5.3 Warum erkennt der Computer das Spin!-Interface nicht?

Das kann verschiedene computerbezogene Grinde haben. Als erstes empfehlen
wir samtliche anderen USB-Gerate vom Computer abzuziehen, um Konflikte (z.B.
mit anderen Soundkarten) auszuschlief3en.

Des weiteren ist es nach Mdglichkeit zu vermeiden, das Interface Uber einen Hub
mit dem Rechner zu verbinden. Muss unbedingt ein USB-Verldangerungskabel
benutzt werden, so gilt die Regel ,,so0 lange wie ndtig, so kurz wie moglich”.



5.4 Wieso kommt von einem Plattenspieler kein Timecodesignal an?

Ein Plattenspieler kann problemlos MP3s abspielen, nur der Zweite will partout
nicht funktionieren, weil Spin! meldet, dass es kein Timecodesignal gefunden
hat?

Es gibt zwei Moglichkeiten: Ein Mikrofon ist in das Interface gesteckt und Player
1 funktioniert nicht mehr. In diesem Fall reicht es, das Mic vom Interface
abzuziehen, alles sollte wieder normal funktionieren (das Mic ist mit Input 1
gekoppelt).

Ist kein Mic eingesteckt? Hier eine zweite Md&glichkeit, den Fehler zu suchen:
Wenn unter ,,Options / Timecode" nur EINE oder KEINE Wellenform dargestellt
wird, liegt ein Problem mit der Verkabelung zwischen Nadel und Interface vor.
Damit Spin! funktionieren kann, MUSSEN eine rote und eine weife Sinuswelle
dargestellt werden (nur der Klarheit halber: das sind ZWEI Wellen PRO
FENSTER)!

Als Erstes sollten beide Nadeln untereinander ausgetauscht werden, um zu
Uberprifen, ob das Problem weiterhin besteht. Wenn das Problem zusammen
mit der Nadel zum anderen Plattenspieler wandert, dann ist die Nadel entweder
kaputt oder die Kontakte sind verdreckt. Um sie zu reinigen benutzt man ein
Wattestabchen und etwas Reinigungsalkohol, das gleiche sollte auch mit den
Kontakten im Tonarm geschehen. Bitte KEIN Kontaktspray in den Tonarm
sprihen! Man kann Uberprifen, ob wieder ein Stereosignal anliegt indem man
eine normale Platte abgespielt und mit dem Pan-Regler am Mischpult sicherstellt
das Links und Rechts etwas zu héren ist.

Sollten beide Nadeln auf z.B. dem rechten Turntable tadellos funktionieren, aber
beim Linken nicht - obwohl die Kontakte im Tonarm grindlich gereinigt wurden -
dann besteht noch die Mdéglichkeit, dass die Kabel an deinem Plattenspieler
defekt sind. Diese sollten dann ausgetauscht werden. Sollten die Kabel fest
installiert sein, so sollte in dem Fall der Handler oder eine qualifizierte Werkstatt
um Hilfe gebeten werden.

5.5 Warum ist nur ein Pfeifen zu horen?

,Vinyl Bypass" (rechts Uber dem Label Monitor) ist aktiviert. Diese Funktion
ermdglicht es, normale Schallplatten abzuspielen, das Audiosignal der Platte
wird durchgeschleift. Da der Timecode essentiell aus einem Pfeifen besteht, kann
man dieses nun horen. Einfach den Bypass deaktivieren und die Kontrollvinyls
steuern wieder die digitalen Tracks.

5.6 Kann man auch normale Vinyls abspielen?

Ja. Der ,,Bypass“-Schalter, der sich in den Playern rechts liber dem Label Monitor
(das drehende Ding in der Mitte) befindet, muss aktiviert werden. Das Signal der
Platte wird nun durchgeschliffen und ist hérbar. Die Hotkeys daflr sind ,,N* flr
den linken und ,,M" flr den rechten Player.

5.7 Wieso lauft der Track riickwarts?

Der Plattenspieler ist evtl. falsch am Interface angeschlossen, d.h. rechter und
linker Kanal sind vertauscht. Die Kabel sollten andersrum ans Interface
angeschlossen werden und alles lauft wieder vorwarts. Sollte aus irgend einem
Grund die Verkabelung schlecht zu erreichen sein, dann kann man unter ,File ->
Options ->» Timecode" ein Hakchen in die Box bei , Left/ Right Inverse" setzen, das
hat den gleichen Effekt wie das Umstdpseln der Kabel. Trotzdem ist es
empfehlenswerter, die Verkabelung richtig herum angeschlossen zu haben.

5.8 Ist es mdglich statt mit 33 RPM mit 45 RPM aufzulegen?

Ja. unter ,File -> Options -> Timecode"” das Hakchen im Kasten ,45 RPM"
aktivieren und Spin! neu kalibrieren (dabei darauf achten, dass der Pitchfader am
Plattenspieler bei 0% steht).
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5.9 Warum werden beide Tracks auf dem gleichen Kanal abgespielt?

Beide Player haben den gleichen OUT PORT zugewiesen. Im Info Screen auf die
Ziffer hinter ,,Out Port"” klicken um die Zuweisung zu andern. Typischerweise
wird der linke Kanal auf Port 1 und der rechte Kanal auf Port 2 gestellt werden.

5.9.1 Warum kommt kein Signal?
Es gibt mehrere Mdglichkeiten warum nichts zu héren ist. Es zahlt sich aus, diese
Liste der Reihe nach durchzugehen, um dem Fehler auf die Spur zu kommen:

« Ist das Mischpult/ der Verstarker angeschaltet? Sind die Gainregler und
Linefader sowie der Masterregler aufgedreht? Ist der korrekte Eingang
gewadahlt (Phono statt Line)?

+ Ist die Vinylkontrolle aktiviert (Schalter ,Vinyl" unter dem Label Monitor
muss grin sein)?

« Ist Spin! fur die Steuerung mit Vinyl eingerichtet?

+  Stimmt die Verkabelung?

+  Wird das Timecodesignal erkannt?

+ Ist ein Mikrofon eingesteckt? Micro abziehen, es blockiert Input 1.

« Istim Info Screen der richtige Out Port eingestellt? Linker Player: Out Port 1,
rechter Player: Out Port 2.

5.9.2 Kann das Interface auch als Soundkarte verwendet werden?

Das Spin!-Interface kann auch als Soundkarte mit zwei Stereo-Eingdngen und
zwei Stereo-Ausgdngen fungieren. Desweiteren hat das Interface einen
Mikrofoneingang mit regelbarem Eingangspegel. Ist ein Mic eingesteckt, so
funktioniert es anstelle von Stereoinput 1.

5.9.3 Was ist mit einer Shure M44-7 zu beachten?
Diese Nadeln bendtigen eine Phaseninversion. Unter ,File -> Options ->
Timecode" das Hakchen bei ,,Phase Inverse" setzen.

5.9.4 Wieso sind hin und wieder Spriinge in der Musik zu horen?

Die Ursache hierflr ist eine langsame Festplatte. Eine Ldsung ist unter ,,Options
-> System” die Einstellung ,Load Tracks to RAM" auf ,rapid” zu setzen.
Desweiteren empfiehlt es sich, daflir zu sorgen, dass die Festplatte, auf der sich
die Tracks befinden, defragmentiert ist, um die Lesezugriffe zu beschleunigen.

5.9.5 Warum schwankt die Geschwindigkeit / der Pitch beim Abspielen?
Dafir kann es verschiedene Griinde geben:

+  Spinlist nicht kalibriert

« Die Nadel ist verstaubt / dreckig

« Das Auflagegewicht der Nadel ist zu hoch

+ Die Nadel ist verschlissen

+ Das Timecodevinyl ist verschlissen (Kratzer, cue burn) oder verschmutzt

5.9.6 Gibt es eine Automix / Partymix-Funktion?

Ja. Einfach ein paar Tracks in die Spin! List (nicht die Spin! Library) laden und mit
mit einem Rechtsklick ,,Play Spin! List” auswdhlen. Die Tracks in der Spin! List
werden nun von beiden Playern abwechselnd gespielt.



5.9.7 Wie optimiere ich meinen Computer fiir Spin! ?

Ein gut und stabil laufender Computer ist eine wichtige Voraussetzung, um mit
Spin! zuverldssig arbeiten zu kdnnen. Es gibt ein paar Kniffe den Rechner zu
optimieren:

« In der Systemsteuerung unter ,System -> Erweitert” die Einstellungen zur
Systemleistung 6ffnen
Hier die Einstellung ,Fir optimale Leistung anpassen” wahlen

+  Energiesparmodi und andere Hintergrundprogramme (Virenscanner,

Netzwerkmonitor, etc.) abschalten A
- Netzwerkverbindungen und LAN / WLAN deaktivieren —
« In der Systemsteuerung unter ,System -> Erweitert” die Einstellungen zur Ty

Systemleistung offnen. Hier unter ,Erweitert” die Prioritat fir
Prozessorleistung auf ,Hintergrunddienste” stellen

+ Die Festplatten defragmentieren

+ Keine anderen Programme parallel zu Spin! laufen lassen

+ Um die Performance zu steigern, kann unter ,,File -> Options” ein Hakchen in
die Box ,,Sound before Graphic priority” gesetzt werden

5.9.8 Was kann man machen, wenn ein Brummen oder Surren bei
Verwendung eines Laptops zu horen ist?

Versuchen Sie das netzteil vom Laptop abzuziehen. Sollte jetzt kein Brummen
mehr zu hdren sein, so ist dies ein Erdungs- bzw. Massenschleife-Problem. Sie
kénnen versuchen das Problem durch folgende Mapnahmen zu beheben:

+ Verwenden Sie ein Netzteiladapter ohne Erdung.

« Versuchen Sie all Ihre Gerate an nur einen Stromkreis anzuschlief3en.

« Versuchen Sie Netzkabel und Cinch-Kabel getrennt zu verlegen, so dass sie
sich nicht berdhren.

+  Uberpriifen Sie ob Ihr Plattenspieler korrekt geerdet wurde.

+ Schalten Sie einen Anti-Brumm-Filter dazwischen.
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OPERATION MANUAL

ENGLISH

Congratulations on purchasing your Reloop Spin! system. Thank you for
placing your trust in our disc jockey technology. Before operating this
equipment we ask you to carefully study and observe all instructions.

Please remove the Spin! interface from its packaging. Check before initial
operation to make sure that the device has not been visibly damaged during
transport. If you detect any damage to the power cable or the casing, do not
operate the device. Contact your specialised dealer.

SAFETY INSTRUCTIONS

CAUTION!

Please exercise particular caution when handling 240 V power voltage. This

voltage rating may lead to a critical electrical shock! Any damage caused by

the non-observance of this operation manual excludes any warranty claims.

The manufacturer is not liable for any damage to property or for personal

injury caused by improper handling or non-observance of the safety

instructions.

- This device left the factory in perfect condition. To maintain this condition
and to ensure a risk-free operation the user must observe the safety
instructions and warnings contained in this operation manual.

- For reasons of safety and certification (CE) the unauthorised conversion
and/or modification of the device is prohibited. Please note that in the event
of damage caused by the manual modification to this device any warranty
claims are excluded.

- The inside of the device does not contain any parts which require
maintenance, with the exception of wear parts that can be exchanged from
the outside. Qualified staff must carry out maintenance, otherwise the
warranty does not apply!

- The Fuse must exclusively be exchanged against fuses of the same class,
with the same trigger features and nominal current rating.

- Ensure that the power will only be supplied after the device has been fully
set up. Always plug in the mains plug last. Ensure that the mains switch is in
the "OFF" position when connecting the device to power.

- Only use cables that comply with regulations. Observe that all jacks and
bushes are tightened and correctly hooked up. Refer to your dealer if you
have any questions.

- Ensure that when setting up the product the mains cable is not squashed or
damaged by sharp edges.

- Prevent the mains cable from coming into contact with other cables! Exercise
great care when handling mains cables and connections. Never touch these
parts with wet hands!

- Connect the power cable exclusively to appropriate shock-proof outlets. The
only supply point to be used is a supply outlet in accordance with
specifications of the public supply network.

- Disconnect the device from the supply outlet when not in use and before
cleaning! Be sure to hold the mains plug by the body. Never pull the mains
cord!

- Position the device on a horizontal and stable low-flame base.

- Avoid any concussions or violent impact when installing or operating the
device.

- When selecting the location of installation make sure that the device is not
exposed to excessive heat, humidity, and dust. Be sure that no cables lie
around openly. You will endanger your own safety and that of others!

- Do not rest any containers filled with liquid that could easily spill onto the
device or in its immediate vicinity. If, however, fluids should access the inside
of the device, immediately disconnect the mains plug. Have the device
checked by a qualified service technician before re-use. Damage caused by
fluids inside the device is excluded from the warranty.



- Do not operate the device under extremely hot (in excess of 35° C) or
extremely cold (below 5° C) conditions. Keep the device away from direct
exposure to the sun and heat sources such as radiators, ovens, etc. (even
during transport in a closed vehicle). Never cover the cooling fan or vents.
Always ensure sufficient ventilation.

- The device must not be operated after being taken from a cold environment
into a warm environment. The condensation caused hereby may destroy
your device. Do not switch on or operate the device until it has reached
ambient temperature!

- Controls and switches should never be treated with spray-on cleaning agents
and lubricants. This device should only be cleaned with a damp cloth. Never
use solvents or cleaning fluids with a petroleum base for cleaning.

- When relocating, the device should be transported in its original packaging.

- When starting operation, the crossfaders and volume controls of your
amplifier must be set to minimum level. Bring the loudspeaker switches into
the "OFF" position. Wait between 8 to 10 seconds before increasing the
volume to avoid shot noise created by transient effect, which could cause
damage to loudspeakers and the diplexer.

- Devices supplied by voltage should not be left in the hands of children.
Please exercise particular care when in the presence of children.

- At commercial facilities the regulations for the prevention of accidents as
stipulated by the organization of professional associations must be
observed.

- At schools, training facilities, hobby and self-help workshops the operation of
the device must be monitored with responsibility by trained staff.

- Keep this operation manual in a safe place for later reference in the event of
guestions or problems.

APPLICATION IN ACCORDANCE WITH REGULATIONS
This device is a professional digital timecode system that can control
software via the included timecode vinyl records and CDs respectively. The
device should be connected via USB cable to a computer.

- This product is authorised for connection to 240 V, 50 Hz AC and is designed
exclusively for indoor application.

- If the device is used for any other purposes than those described in the
operation manual, damage can be caused to the product, leading to
exclusion of warranty rights. Moreover, any other application that does not
comply with the specified purpose harbours risks such as short circuit, fire,
electrical shock, etc.

- The serial number determined by the manufacturer must never be removed
to uphold the warranty rights.

)
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1.1

AINTENANCE
Check the technical safety of the device reqularly for damage to the mains
line or the casing, as well as for wearout of wear parts such as rotary and
sliding switches.
If it is to be assumed that a safe operation is no longer feasible then the
device must be disconnected and secured against accidental use. Always
disconnect the mains plug from the outlet!
It must be assumed that a safe operation is no longer feasible if the device
bears visible defects, if the device no longer functions, following longer
storage under unfavourable conditions or after major transport stress.

This manual, video tutorials, tips and tricks and additional downloads can be
found on:

www.reloop-spin.com

INIMUM SYSTEM REQUIREMENTS:

current processor (Pentium Ill, 1 GHz recommended)
Windows 2000, XP, NT, Vista operating system

free USB port

512 MB RAM minimum

1. Connection & Software Installation

Connection

® .
el

,: SFIN!

DIGITAL VINYL SYSTEM
°

. o . .
® g °
MIC MONITOR

o esss INPUT seoe e




a) Connect your turntable's or CD player's outputs to the corresponding inputs
(1 or 2) of the Reloop Spin! interface -1-. If required connect your turntables
to the GND grounding screw -3-.

b) Connect the line outputs of the Reloop Spin! interface to the line inputs of
your mixer -2-.

c¢) Connect the Reloop Spin! Interface to your computer via a free USB port.
Now the following messages should appear on your monitor (example for
XP):

New hardware found -
Reloop Spin! Interface

jr.! Neue Hardware gefunden |

Reloop Spin!-Interface

New hardware found -
USB audio device

._y Meue Hardware gefunden | *
[J5E-audioger &t

New hardware found -
Your new hardware is installed and ready to use.

i) Neue Hardware gefunden x

Die neue Hardware wurde installiert und kann jetzt verwendet
werden,

NOTE!
The installation of your Spin! interface under Windows XP & Vista is carried
out Plug 'N' Play without the need for special drivers.

d) After the system has recognized and installed your Spin! interface you
should maximise the volume in the Windows audio settings.

Example Windows XP:
start > control panel > sounds and audio devices > rider ,,audio”

Eigenschaften von Sounds und Audiogerdte m

| Lautstike | Sounds | Audio | Stimme | Hardware |

Soundwiedergabe

Standardgerat:
| Feloop SpinlInterface M
[ Lautstarke.. [ Ernweitert... ]
Soundaufnahime
ﬁ Standardgerat:
| Feloop SpinlInterface M
[ Lautstarke... ] [ Erweitert... I

MIDI-Musikwiedergabe

% Standardgerat:

ety |Microsoft G5 Wavetable 5w Sunth M

[ Lautstarke: ] [ Infao ]

Mur Standardgerate verwenden

Ut
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Click on ,Volume" under the item ,,Sound Playback" and maximise all faders.

[ Lautsprecher M
Optionen 2
Lautzprecher Wave SW-Synthesizer CD-Flayer Line
Balance: Balance: Balance: Balance: Balance:
PO ¢ 00 96T 9> >0 ¢
Lautstarke: Lautstarke: Lautstarke: Lautstarke: Lautstarke:
[Ion a:us : [ Ton aus []Ton aus [ Ton aus []Ton aus
Reloop Spin!-Interface
e Ok Bc. o) &l
The option ,,Sound Recording” for a | gptienen 2 Optionen 7
vinyl record or CD setup differ. Line Line
1) Vin Isettin s Balance: Balance:
n g MU By S >3 9
Click on the ,Sound Recording Y Y
Lauts'térkf_: _____

button and maximise the fader. R

2) CDJ settings
Click on the ,Sound Recording’ :
button and minimise the fader. S M

inl- inl-
1) Reloop Spin!-Interface 2) Reloop Spin!-Interface

Afterwards you can close the control panel.
e) Additional functions and connections of your Spin! interface:

USB LED -4-;
Shines when the interface has been recognized by the computer and is
active.

NOTE!
The interface is supplied with power via USB. A connection to mains is
not necessary.

Headphones -5 / 6-:
Here you can connect headphones (3,5 mm jack) in order to be able to
monitor the master output signal directly from the interface -5-. Via the
monitor knob -6- you can adjust the volume.

NOTE!
You can also use this output as recording connection in order to record
a set for example.

Microphone -7 / 8-:
You can connect a microphone to this jack (6,3 mm jack). The volume can be
adjusted with the knob -8-.

ATTENTION!
The microphone input is linked to the stereo output. This means you can
either use a microphone or the channel 1 signal. Make sure that no
microphone is connected during normal Spin! timecode use as the
channel would be blocked.



CD or Turntable CD or Turntable

Turntable 1 I Mixer Turntable 2 CD 2

N—

1.2. Software Installation

After having carried out the hardware setup now you can continue with the
software installation. To do so please insert the Spin! installation CD in the CD
ROM drive of your computer. If the setup does not start automatically please

carry out the file ,Install.exe” manually.

Choose the installation language and confirm with , OK".

fnstae g

Language ?

" Deutsch

" Frangais

ok | Cancel |

Read and accept the licensing agreement.

(FRTRL T —— |

Fleaze read the license term before installing.

RELOOF LICENSE AGREEMENT |§‘

B CLICKING THE ACCEPTANCE BUTTOM OR INSTALLING OR USING THE RELOOP
SOFTWARE [THE "PRODUCT"), THE INDIVIDUAL OR ENTITY LICENSING THE PRODUCT
["LICENSEE"] 1S CONSENTING TO BE BOUMD BY AND |5 BECOMING & PARTY TO THIS
AGREEMENT. IF LICENSEE DOES NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, THE BUTTON INDICATING MOM-ACCEPTANCE MUST BE SELECTED, AND
LICEMSEE MUST MOT INSTALL OR USE THE PRODLICT.

1. LICEMSE: The Product is Iic:en_sx_ed, not zold. The Product iz protected by copyright law and

international copyright treaty provisions, as well as other intellectual property laws and treaties. You

Do you accept all terms of this license " hccept | Decline
agreement ? b : —

5

N
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Now you have to enter your name, company if required, e-mail address (required)
and the serial number. You can find the serial number on the back side of the
Spin! installation CD-cover. Confirm the entries with ,Next".

X}

Mame

IYDur harme

Company

IYDur company

Email

Iyour@email.con’]
Code

Copyright © 2008 RES1GH . Refoop | |
’WI Cancel |

Now choose the installation directory where you would like to install your Spin!
software or use the standard directory (recommended). Please confirm with
Next".

(INSTALL B

Install Directary:

|C:\Frogramme’ ReloopsReloop Spin
Browse...l
@recoop) |
Beadie | < Back | Mext > | Cancel |

After successful installation close the setup with ,Finish".
rm‘l’nLL

EreLoop)

ReI66

Beadie |

NOTE!
Log regularly onto www.reloop-spin.com for latest updates.

ATTENTION VISTA USERS!
If the program does not start because of the error the serial number is not
correct”, please deactivate the user account control.

> Control Panel > Security Center > User Account Control > Deactivate

Alternatively open the software by clicking the right mouse button on the
Spin! Icon and choose the option “execute as administrator’.



N

1.3 Easy Setup
When starting Reloop Spin! for the first time the easy setup will start
automatically.

NOTE!
You can also carry out the setup manually under the menu item > Help >
Easy setup!

1. Resolution
In this first step please choose the screen resolution.

SPIN!
SPINIT 024

Resolution:

1280 Widescreen

USPINE 1280

Step1 /6

< ZUriich I Weiter » I Abbrechen

2. Calibration input 1
Now you have to carry out the calibration. Choose the according playback
medium. Switch to play mode and click ,Next".

Source connected :

7 Mo Source

" CD Player

» Choose source > Play the timecaode souwrce > Press 'Mest!
Tip:
Please set Fitch to 0% and spin in forward direction

Step 2 /B

< Zuriick I wieiter > I Abbrechen

HSITTONJ
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3. Calibration result for channel 1
After the successful calibration the message ,Spin! has been calibrated
successfully” should appear.

NOTE!

If the message ,,Spin! has not been installed properly" should appear please
check your connections or change your turntables’ needles.

SPIM! haz been calibrated sucessfully!

Tip:
Pleaze check connections and hardware setup.
More options under File > Options » Audio devices AMD > Timecode

Step3 /6

< Zuriick  |{ wieiter > Abbrechen |

4. Calibration input 2
Carry out the same adjustments for your second playback device.

Source connected :

" NoSource

" CD Player

» Choose source > Flay the timecode souce » Press Mest'
Tip:
Please set Fitch to 0% and spin in forward direction

Stepd /B

< Zuriick. I Wwieiter > I Abbrechen




5. Calibration result input 2
A successful calibration result should appear here as well.

NOTE!
The calibration is only necessary for turntables. If CD players have been
connected this step will be skipped.

Easy Setup! - Result 2 Ed

SPIM! haz been calibrated sucesshully!

Tip:
Pleaze check connections and hardware zetup.
tore options under File > Options > Audio devices AMD > Timecode

Step5 /6

< Zuriick  |i Welter» ¢ Abbrechen |

6. If the setup has been successful your entries will be confirmed.
Close the easy setup by clicking ,,Finish".

Easy gegup! - ﬂp!lmlzatmn m‘

Optimize SPIMI:

Set thiz optian if vou control SPIMI mainly with vingl or od

v Tick scrolling

Set this option for display optimization

[~ MoBPM and Waveform calculation on load

Set this option to optimimize the loading of files. However no BPM AW aveform will be displayed

StepB /B

< Zuriick. I Fertig stellen I Abbrechen

NOTE!
In order to optimise Spin! there are three possibilities in the last installation
step. Additional information can be found in chapter 4.1 ,,Options".

HSITTONJ
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1.4 First software steps

Following, the first necessary steps in order to be able to work with the Spin!
software will be explained.

NOTE!
The manual can be found following the menu > Help > Manual

a) Importing music
First import all your music to the Spin! library. To do so go to the menu item
> Spin! library > Auto search.

It is possible to either search single files or directories automatically for music.
Confirm your choice with ,,OK".

b) Loading tracks
After having imported all your music you can load single tracks into player 1 and
2. There are three possibilities to do so:

Via mouse
Use the drag & drop function in order to load tracks.

Via Trax select

On the Spin! timecode record's B-side the last groove has been conceived for
searching tracks. Drop the needle on this groove in order to browse the Spin!
library. Stop the record at the desired track and put the needle back to the
beginning of the record in order to load the desired track.

Via keyboard

Activate the Spin! library via the hot key , V". Browse the Spin! library with
the up/down cursors to the desired track and push the enter key in order to
load this track. The active player can be selected via the TAB key.

c) Activating the timecode mode
Activate the timecode mode via the ,,Vinyl” button, right below the label monitor.

Now you can start mixing!




2. SOFTWARE GENERAL SURVEY

Main «»
Volume

3

e Fred Falke - Love lost | /

Remain: 02:54.30

S

Repeat: OFF Qut Port:
ininl~Inlm]
B EEEE

£ I }E

Flanger- - - Filter - - Delay -

doonesg

FEPLE0E ®OREE

()
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1. Shortcut: New Spin! Library
Please see chapter 3.2.1 for further information.

2. Shortcut: Open Spin! Library
Please see chapter 3.2.2 for further information.

3. Shortcut: Auto Search
Please see chapter 3.2.7 for further information.

4. Shortcut: Save Spin! Library
Please see chapter 3.2.1 for further information.

5. Shortcut: Stop Spin! List
Please see chapter 3.4.2 for further information.

6. Shortcut: Play Spin! List
Please see chapter 3.4.1 for further information.

7. Shortcut: Loop Spin! List
The Spin! list will be repeated in an endless loop.

. Shortcut: Shuffle Spin! List
random playback of the Spin! list will be started.

> 0

e

. Shortcut: Previous
oad the previous track from the Spin! list to your player.

—

10. Shortcut: Next
Load the next track from the Spin! list to your player.

11. Shortcut: Music Explorer / Audio Input
Please see chapter 3.5.9.1 for further information.

12. Shortcut: Spin! Library
Please see chapter 3.5.7 for further information.

13. Shortcut: Spin! List
Please see chapter 3.5.8 for further information.

14. Shortcut: Category View
Please see chapter 3.5.9 for further information.

15. Shortcut: X-Fader Match View
Please see chapter 3.5.9.2 for further information.

16. Shortcut: Master/Rec. Volume
Please see chapter 3.5.9.3 for further information.

17. Shortcut: Beat Match View
Please see chapter 3.5.9.4 for further information.

18. Shortcut: Options
Please see chapter 3.1.2 for further information.

19. Safe Mode
Please see chapter 3.4.4 for further information.

®OPO®GH@OO0EO®O®E@OV®@O®O



20. Beatmatch View

The beatmatch view shows you the peaks of both tracks - the two displays are
arranged vis-a-vis. It is possible to quickly recognize whether bass drums and
snares are running simultaneously. This way, if the two tracks have been
matched regarding the pitch, it is possible to easily and quickly synchronise two
tracks. The left player 1is displayed green and the right player 2 is displayed grey.

21. Complete View

In the complete view you can see the complete waveform of a track. The
dramatic arch of a track can be recognized well and at the blink of an eye you
can also see where the intros and breaks are. The elapsed part of a track is
displayed green and the remaining part of a track is displayed grey.

22. Needle View

The needle view is a zoomed view of the waveform display. This way it is easy to
recognize bass kicks for example.

The zoom range can be adjusted from 2 - 16 beats. To do so click the right mouse
button in needle view and select the according value from the submenu.
Furthermore you can choose whether the left, right, stereo or both channels
mixed should be shown in the waveform. Select the according option with a right
mouse click in needle view.

There are two types for the needle view display:

e Waveform Scrolling
The waveform moves. A vertical line in the middle represents the needle.

e Tick Scrolling
The waveform remains still. The line (corresponds to the needle's position)
moves.

NOTE!
This option is system resources saving.

Select the corresponding option with a right mouse click in needle view.

23. Master
Adjust the master volume for player 1 and player 2.
Main ===

Volume 2

63
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24. Load Track
With this function it is possible to load single files to the player.

25. Bypass function

If the bypass function has been activated the input signal of the Spin! interface
will be directly routed through the software. This way it is possible to play a
normal record. Deactivate the bypass function for timecode use. The hot keys
are “N" (player 1) and "M" (player 2).

26. Label Monitor

The label monitor is a kind of virtual record that moves along according to the
timecode record. Each movement that is made with the record will be carried out
synchronously to the label monitor. The label monitor is a helpful marker for beat

juggling.

*- Bypass

————r———
@ GiGmALVINYL BvaTEM
-

27. Gain Knob

The gain knob is, similar to a mixer, the final amplification of a channel. Tracks of
a different recording volume level can be adjusted to one another without
increasing the master volume.

NOTE!

Under > File > Options > Rider ,,BPM and Tools!" > item “Auto BPM" you can
activate the auto gain function. This way the gain values of the tracks will
be adjusted automatically without any further need for manual adjustment.

Gﬂlﬂ EEEE

& bEE




28. Pitch Mode

You have the possibility to select three different pitch modes via the pitch fader
-29-. You can change the mode by clicking the -28- button or via the hot keys “A”
(player1) and “K" (player 2).

a) Speed Mode
If speed mode has been selected you can adjust the pitch like with a normal
turntable. Within the adjusted pitch range the current value is also shown in
the info view -48-, position -7-.

b) Master Tempo Mode (MT)

If the master tempo mode has been activated it is possible to change the
pitch via the pitch fader -29- ranging from -/+6% without influencing the
tone pitch. This means that the tone pitch remains the same when changing

the pitch.
NOTE!

The master tempo mode is only available for advanced and battle mode (see
point 31).

L VAR

c) Key Mode
The key mode is the opposite of the master tempo mode. Here the tone pitch
is varied independent from the adjusted pitch.

NOTE!

The key mode is only available for advanced and battle mode.

HSITTONJ

29. Pitch fader

The pitch fader represents a conventional pitch fader of a turntable or CD player.
When in timecode vinyl mode -30- the fader moves synchronously to the
adjustments made with the turntable.

This depends on the adjusted pitch mode (see point 28). In deactivated timecode
mode the pitch fader can also be moved via the mouse.
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30. Vinyl Timecode Activation

Via this button you can activate the timecode mode, which means that an
operation via timecode records and CDs becomes possible. If this button is
deactivated it is only possible to control the software via the mosue.

31. Spin! Mode button

By using this button you can choose between the playback modes Spin! Mode,
Classic Spin!, Advanced Spin! and Battle Spin!. The hot keys are “A" (player 1) and
"K" (player 2).

a)

b)

c)

Classic Spin!

The audio files will be played from beginning to end, just like a normal record
(needle drop). Classic mixing and scratching is possible but without the loop,
cue points and effects options.

Advanced Spin!

In this mode needle dropping is also possible. But it is commensurate to the
vinyl record's length. So if you would like to jump to the middle of a song, you
have to place the needle in the middle of the record. Classic mixing and
scratching is possible, loops, cue points and effects are available.

Battle Spin!

No needle drop is available here. This means that the track will always
continue no matter where the needle is palced on the record. This mode is
appropriate for scratching even if the needle should skip. Battle mixing is
possible, loops, cue points and effects are available.

NOTE!
This mode is only for vinyl control.

32. Play/Pause button

By pushing this button you will start the previously selected track. This function
is only available in PC controll mode. The hot key is the space bar, depending on
the activated player (TAB button).



33. Cue button
By using this button you will change to cue mode. There are two possibilities in
order to set a cue point.

a) Cue pause
In playback mode push the play/pause button -32- in order to change to
pause mode. Now push the cue button in order to set a cue point.

b) Loop in
During playback or in pause mode you can push the loop in button in order
to set a cue point. The hot keys are “F1” (player 1) and “F9" (player 2).

34. Forward and reverse button
Via this button you can determine the playback direction of the track (forward or
reverse). In timecode mode this button shows the direction of the record.

35. Skip buttons
Push these buttons in order to load the previous or next track from your Spin!

library.
36. Fast Search buttons

Via these buttons it is possible to fast search within a track. In timecode mode
this function is deactivated.

37. Pitch Bend buttons

Activate the pitch vernier adjustment via the pitch bend button. By pushing and
holding the pitch bend buttons you can temporarily increase or decrease the
pitch. Release the button and the player will return to the pitch that has

previously been set via the pitch fader. By turning the jog wheels in PC control
mode this function is also available. In timecode mode this function is

deactivated.

J
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38. Spin! Library

In this browser you will find all necessary information regarding the tracks of
your Spin! library. In order to directly select a track from the library click on the
corresponding track and move it via drag & drop to the desired player.
Alternatively you can also choose the track select function via the timecode
record (see chapter 1.4, item b).

Via the hot key “V" you can activate the Spin! library in order to navigate the
library via the up/down cursor buttons. By pushing the enter button you can
assign the track to the active player. Via the TAB button you can select between
player 1 and player 2.

n Last Played

dh

1. Search Filter
In this field it is possible to search for a track by entering some letters. The more
precise the input the more precise the result will be.

2. Exact Match
If this option is activated only exact results corresponding to the entry will be
shown.

3. Selection Filter
Here you can define selection filters that should be searched for.
The following possibilities are at your disposal:

e All
Via this filter all categories will be observed while searching.
e File
If this filter is active only file names will be considered while searching.
e Title
If this filter is active only title names will be considered while searching.
e Artist
If this filter is active only artist names will be considered while searching.
e Album
If this filter is active only album names will be considered while searching.
e Genre
If this filter is active only genres will be considered while searching.
e Remix
If this filter is active only remix names will be considered while searching.
* Year
If this filter is active only years will be considered while searching.
e BPM
If this filter is active only BPM values will be considered while searching.
e Directory
If this filter is active only directory names will be considered while searching.



4. Categories

In this view all information regarding a track, like title, name or BPM is displayed.
You can define the categories on your own by clicking the right mouse button in
the category bar (columns properties).

The following items are at your disposal:

Title

Artist
Album
Genre

BPM
Duration
Last Played
Remix
Rating
Comments
Year

Track

File
Directory
File Name
File Extension
Date Created
Label
Producer
Key
Counter

NOTE!

You can edit every bit of information regarding the track on your own by
double clicking the mouse in the corresponding category field. If you wish
to save these attributes (ID3 TAG) permantely for a track, go to the menu
and click on the corresponding track > Track > Save ID3 TAG attributes

Via a right mouse click in the Spin! library you can access a submenu that
includes the following options:

Add Track (see 3.2.8)

Auto Search (see 3.2.7)

Track Preferences (see 3.3.1)

Analyse BPM manually (see 3.3.3)

Analyse BPM automatic (see 3.3.4)

Select All

All tracks of the current Spin! library will be marked.

Delete

Delete all marked tracks from the Spin! library.

Add to Spin! list

The marked tracks will be added to the Spin! list.

Group

Via this function you can assign or delete marked tracks of a previously
created group/playlist. For further information please alo see item 49.

List View

Via this function you can change your Spin! library to the display mode ,,List
View". In the list view only the title is displayed. This way various tracks can
be displayed in this list without the need for scrolling.

Detail View (default)

All shown categories regarding a track are displayed in this view.

Column Properties

As already explained, here you can fade in and out single categories.

-
Z
Q
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39. Delay effect

First push the effect activation button -39- above the delay turning knob. Now
the delay effect is activated. By turning the delay turning knob you can adjust
the delay effect's intensity. Push the effect activation button again in order to
deactivate the effect.

40. Filter effect

First push the effect activation button -39- above the filter turning knob. Now the
filter effect is activated. By turning the filter turning knob you can adjust the
filter effect's intensity. Push the effect activation button again in order to
deactivate the effect.

41. Flanger effect

First push the effect activation button -39- above the flanger turning knob. Now
the flanger effect is activated. By turning the flanger turning knob you can adjust
the flanger effect's intensity. Push the effect activation button again in order to
deactivate the effect.

C 3C 3I€ 3,

Flanger--: Filter =+« Delay --

42. Beat Loop / Auto Loop function

Your Reloop Spin! software disposes of an intelligent beat loop function. With
this tool it is possible to create beat matching loops with the push of a button,
depending on the selected bar. This way it is not necessary to set the in and out
points manually. Select the desired bar via the beat loop bar buttons -42 b-
(1/2 - 16 bars). Activate the beat loop via the beat loop button -42 a- (when in
beat loop mode this will flash). Deactivate the beat loop via the play/pause
button -32-.

Operation via keyboard:

+ When in playback mode push “F4" (player 1) or “F12" (player 2) in order to
activate the beat loop mode

«  Via the keys "F5"/"F6" (player 1) and “F7"/"F8" (player 2) you can prolong
or shorten the loop respectively

+ Push the space bar in order to quit the auto loop (select the active player via
the TAB button)

43/44. Manual Loop function

« In order to set a loop manually push the loop in button -44- at the desired
starting point and the loop out button -44- at the desired ending point.

« By pushing this button again you will quit the loop

+ By pushin the reloop button -43- you will return to the last set loop

[Function Player 1 Player 2
Loop In F1 F8
Loop Out F2 F10
Reloop F3 F11

(i) o) [Cmaon ] Fommomn]
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45, Crossfader

The crossfader -45- is just intended for the PC control mode. When in regular
timecode mode (external mixer) you will not need the crossfader. Via the fader
you can crossfade from channel 1to 2 and vice versa.

NOTE!
When in timecode mode the crossfader should be in the middle position.

(=] —imujnz
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46. Beat Match function

The beat match function is a handy helping tool in order to match the pitch of two
different tracks with the push of a button. You can either match the right player
with the left player or you can match the left player with the right player .

Beat Match Shortcut
Player 1 Z
Player 2 X

47. Cue points

It is possible to set up to 6 cue points per track. They will be permanentely saved

automatically until they are replaced by new ones.

« In order to set a cue point via mouse push the right mouse button at the
desired time.

* Inorder to call up a cue point a click of the left mouse button suffices.

« If a cue point has been saved you will see a thick green mark on the
corresponding cue button.

+ Set the cue point for player 1 via the numbers 1 -5 (only 5 cue points per
player) and for player two via the numbers 6 - O.

« If you push the according number again the cue point will be called up (hot
cue).

N
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48. Info View

Nathan Fake - The Sky Was F

Remain: 05:50.98

Repeat: OFF Out Port: @

1. Title

— The title of the current track is displayed here. With a click of the right mouse
button you can select whether only the title, only the artist or both should be
displayed.

2. Elapsed
The elapsed time of the ~current track is shown here
(minutes/seconds/frames).

3. Remain
The remaining time of the current track is displayed here
(minutes/seconds/frames).

4. BPM
The current BPM value is shown here.

5. Repeat function
Here you can (de)activate the track repeat function. If the repeat function is
activated the loaded title will automatically be repeated.

6. Out port

Here you can see which output signal of the interface is assigned to the
player. If set up correctly 01" should be displayed on the left player and “02"
on the right player. You can change the port by clicking on it.

7. Pitch
Here the current pitch value is displayed.

49, Category View

The category view is a kind of fast search filter for the Spin! library. You can
choose whether the Spin! library view should be displayed alphabetically, sorted
according to years or BPM values for example.

Under the point “groups” you can carry out playlists or sortings. In order to
create a new group push the right mouse button in category view on the "Add
Group" item. Now you will be asked to enter a name - confirm by pushing the
enter button.

12




50. Music Explorer/Audio Input

The music explorer is a file browser in tree view just as you know it from the
Windows explorer. Here you can search for files in your work centre or your
network environment. Furhtermore here you can also find the Spin! interface
under the item “Audio Input”. Each input is listed there. Via drag & drop it is
possible to drag single inputs onto the player for an easy assignment.

NOTE!

Due to the pre-settings your inputs have already been set correctly. Only for
a recording via microphone it is necessary to assign the input 0: Reloop
Spin!-Interface 1" to a player.

51. Mic Rec function

Due to the integrated mic rec function (Mic Spin!) you can record a sample via
microphone that can later be used for scratching for example.

Follow these steps:

e Sample recording

- Under Audio Input (music explorer) assign the input “O: Reloop Spin!-
Interface 1" via drag & drop to one of the players

- Adjust the volume level via the mic volume knob

- Push the Rec button

- A save dialogue will appear; enter name and place where the sample should
be stored

- After pushing “save” the recording will start; stop the recording by pushing
the rec button once more

e Mic Spin! function (playing and scratching a sample)
- Via drag & drop assign a desired track from the Spin! library or the recorded
sample to a player in order to manipulate it via record

NOTE!

The mic input is linked to the input 1. As soon as you connect a microphone
the phono/line input 1 will be deactivated. So if you wish to record a sample
during a mixing session make sure that player 2 is currently playing.
Disconnect the microphone after recording in order to be able again to
control player 1 via record.
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52. Monitor function
Via the software monitor function you can monitor a track. This function is
unnecessary when using an external mixer as you would monitor a track via the

mixer's cue function.
o

3. MENU NAVIGATION

In this chapter all menu items will be described step by step.

3.1 Menu item file:

3.1.1 Options:

In this option menu you can carry out a variety of adjustments. Further
information regarding this matter can be found in the chapter “Options” in this
manual.

3.1.2 Quit Spinning
Here you can quit the Reloop Spin! software.

3.2 Menu item Spin! librar

With the Reloop Spin! library you can manage your audio files. If desired it is
possible to create and store various libraries. You can import music to the Spin!
library in order to obtain a central collecting station of your files. It is possible to
edit and export new libraries and you can also import libraries (for example
iTunes playlists).

3.2.1 New
Here you can create a new, empty library that can be filled with audio files as
required.

3.2.2 Open
Opens an existing library.

3.2.3 Save
Saves your library.

3.2.4 Save as
Saves your library under a different name without deleting the previous one.

3.2.5 Import
Imports files [ iTunes (*.xml) / m3u Files (*.m3u)]

3.2.6 Export
Exports files [m3u Files (*.m3u)]

3.2.7 Automatic search
In order to import a bulk of audio files you can comfortably browse your hard
disc or if required single directories via this function.

3.2.8 Add track
With this function you can add single tracks to your library.

3.2.9 Select all
With this function you can select all tracks from a library.



3.2.9.1 Delete
With this function it is possible to delete files from your current library without
deleting them from your hard disc.

N

3.3 Track menu

3.3.1 Track preferences
You can carry out track-specific adjustments here.

3.3.2 Save ID3 TAG attributes
If you want to change ID3 TAG attributes you can save these.

3.3.3 Analyse BPM manually

Via this tool you can manually determine the BPM value. This can be achieved by
either clicking on the space button with the mouse or by pushing the space bar.
The longer you push the according button to the beat the more precise the
calculated value will be.

3.3.4 Analyse BPM automatically

Via this function the BPM value will be calculated automatically although beats
can not be recognized by the software if the beat does not stand out enough
from the rest of the track in order to be identified as rhythm element. 4/4 beats
are ideal for the Reloop Spin! software.

NOTE!

Several tracks can be analysed automatically. If a track is loaded to a player
for the first time the BPM value will automatically be determined and saved
permanently.

3.3.5 Delete tracks permanently
Via this function it is possible to delete tracks permanently.

ATTENTION!
In this case the track will be deleted permanently from your hard disc and
not only from the library.

3.4 Spin! list menu

The Spin! list is a kind of “party” playlist. The featured tracks will be played and
crossed over alternately from player 1 and player 2. This function is ideal if you
want to operate the software in stand-alone mode without a DJ.

3.4.1 Play Spin! list
Starts the playback of a Spin! list.

3.4.2 Stop Spin! list
Stops the playback of a Spin! list.

3.4.3 Add to Spin! list
Adds the currently selected track to the Spin! list.

NOTE!
You can also add tracks to the Spin! list via drag & drop.

3.4.4 Safe mode
If the safe mode is active it is not possible to load a track to the currently active
player. This prevents unwanted loading of new music when using a player.
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3.5 Menu Spin! workspace
In this menu you can fade in and out single elements in order to individually
arrange the view.

3.5.1 Workspace arrangeable
If this is activated it is possible to rearrange and close single window elements.

3.5.2 Full Screen view
Activates the full screen view. Alternatively this can be carried out via the key
combination ALT+S.

3.5.3 Menu Bar view
Fades the menu bar in and out.

3.5.4 Shortcut view
Fades the shortcut view in and out.

3.5.5 Info view
Fades the info view in and out.

3.5.6 Preview
Fades the preview bar in and out.

3.5.7 Spin! library view
Fades the Spin! library in and out.

3.5.8 Spin! list view
Fades the Spin! list in and out.

3.5.9 Category view
Fades the category view in and out.

3.5.9.1 Music Explorer/Audio Input
Fades the music explorer / audio input view in and out.

3.5.9.2 X-fader match view
Fades the X-fader match view in and out.

3.5.9.3 Master/Rec volume
Fades the master/rec volume view in and out.

3.5.9.4 Beatmatch view
Fades the beatmatch view in and out.

3.6 Help menu

3.6.1 Easy setup
Via this you can call up the easy setup.

3.6.2 Manual
Via this you can call up the manual as PDF file.

3.6.3 www.reloop-spin.com
Via this you can visit the web site reloop-spin.com. Visit this site frequently in
order to obtain current downloads or information.

3.6.4 Configuration log
Via this a current system-configuration overview will be created as text file. This
could be required when trying to solve possible problems.

3.6.5 About Spin!
Here the current Spin! version is displayed.



4. ADJUSTMENTS

4.1 Options
You can reach the options menu under
> File > Options.

4.1.1 System
Options %)

System | BPM and Tooks | Audio devices | Timecods | wirkspass | Shetteuts | MIDI-Contier |

i~ Track

g Set directory of \
1 W fgad st ack (sp\w Plalst [ J) 04
2 (% RecodPlay  View List ) Set diectory where Il
O L warveltommns ane saved J J 5
3 (TAES I ID3Tag¥.1
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- Optimizatior

6 £ Software Mult-Open
7 ¥ Sound before Graphic prioity

Load track to RAM  |nomal =

() (=

(Lnad tack in RAM |13 = Ienglh\imit/minulas}

10 ¥ Easy Kepboard Search Tone pitch B 3: # n

Abbrechen

1. Load last track
If this option is activated the last played track and Spin! library will be loaded
when starting the software.

2. Record play
If this function is activated all played tracks will be saved in a list with date and
time. By pushing the “View List" button you can call up this list.

3. TAGs
Here you can select which ID3 TAG version should be displayed. Only one optoin
should be selected here.

4. Play list directory
Here you can determine the path where the Spin! list should be saved/loaded.

5. Waveform directory
Here you can determine the path where the waveform peaks should be saved.

6. Software multi open
If this function is activated Reloop Spin! can be opened several times at once
(not recommended/depends on ASIO).

7. Sound before graphic priority

If this function is activated the sound performance will be assigned before
graphics. This is an advantage when using older or inefficient computers (when
experiencing dropouts for example).

N
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8. Load track to RAM
Here you can determine how fast the track should be loaded to RAM
(slow/normal/fast).

9. Load track in RAM/min.
Here you can determine the maximum track length in minutes that should be
loaded to RAM.

10. Easy keyboard search
If this function is activated you can browse tracks in the Spin! library and music
explorer by simply typing in a letter.

11. Tone pitch
Here you can adjust the percentage that the tone pitch should be played in (also
see cahpter 2, item 28).

4.1.2 BPM and tools

Spstem  BPM andTDDIS|Audiudevices Timecode | Workspace | Shorteuts | MIDI-Controller

i~ Auto-BPM

(EPMHangefurAulo-Euuntmg Min: |78 3: BPM Max: |150 3: BFM)

| Show Pitch Value

| Calculate EPM and Waveform on load

|v Auto-Gain Function

¥ EPM Match Function

OI0I0I0I6

- Cue-Pain
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1. BPM range

Here you can adjust the BPM range that the software should use to calculate.
The smaller the difference the faster and more precise the Spin! software can
calculate. By default the range is 78 - 150 BPM.

Recommended settings:

« All-Round 78 - 150 BPM
+ Hip Hop 80 - 120 BPM
+  House/Techno 110 - 150 BPM

2. Show pitch value
Activates the pitch display (default setting and recommended).

3. BPM and waveform
If this option is activated Spin! determines the BPM and waveforms when loading
a track.



4. Auto gain

If this function is activated the gain values of tracks with a different volume level
will be matched. This way a manual matching via the gain knob -29- is no longer
necessary.

5. BPM match
Activates the auto match function when loading new tracks.

NOTE!
Via the beat match button -46- you can also match each side with the other.

6. Auto cue
Via this you can turn the auto cue function on/off.

7. First cue point search
Via this you can determine the time frame in seconds for the first cue point
search.

8. dB sensitivity
Here you can adjust the sensitivity in decibel and corresponding threshold level
that should be used for setting a cue point.

9. Fading time
Here you can adjust the crossfading time for the auto mix function of the Spin!
list.

10. End of track warning
Here you can adjust the optical end of track warning-time in seconds.

4.1.3 Audio devices
M

ions

System | BPM and Tooks Audio devices | Tinecods | workspass | Shortcuts | MIDI-Contoler |

i SPINLASIO Devics

Output Device

Out Ports

OROIe

Abbrechen

1. Output device
Here you select the Reloop Spin! interface and it should be displayed here.
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2. Out ports
Here you can determine the number of outputs. A “2" should be entered here.

3. Setup
Here you can adjust the single outputs for the left and right side. Furthermore
you can adjust the buffer size via the button “Control Panel” in the ASIO setup.

NOTE!
All audio device settings have been automatically adjusted in the easy
setup; this way you do not have to carry out any changes here.

4.1.4 Timecode

Naise Level 40 =
Moise Filter (=]

Options m
System | BPM and Tools | Audio devices  Timecods | warkspace | Shaiteuts | MIDI Contioler |
~ Player 1 - Player 2
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@— —Audio device Jasio =l Jasin =l
—Audio Sourcs | 0Retoop Spintinterace 1-Felaop Spintd x| | 2Relnop Spinnterface 3Reinop Spind > |
@— —Timecods Qually [0z [100%2
() amsam | = = Fd = EE
| —Direct Phora Input No = m BE
45 RPM I ] I I
@— —Left/Right Inverse r u
—Fhase lnverse I =
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Apply ;ﬁov;“‘[ﬁfi&ns‘““; Circle diagram | 1 Tumntable Mode |
[ [ok ] _asbrechen

In this detailed timecode menu several adjustments for player 1and player 2 can
be carried out although they are not necessary if the easy setup was successful.

You should carry out advanced settings for optimazation and solving problems
only.

1. Timecode from
Here you can set the timecode source, vinyl or CD.

2. Spin! mode
Here you can select the Spin! mode (see chapter 2, item 31).

3. Audio device
Here the ASIO driver should be selected.

4. Audio source
Here you can assign the corresponding connections of your Spin! interface.

The default settings are:
Player 1: O: Reloop Spin!-Interface 1 - Reloop Spin!-Interface 2
Player 2: 2: Reloop Spin!-Interface 3 -Reloop Spin!-Interface 4



5. Timecode quality

Here the timecode's signal quality is displayed in percentages. Fluctuations or a
percentage that is too low could be caused by dirty or worn out needles. Ideally
the value should be between 90 - 100%.

6. Adjust gain

Here the decibel value of the input signal for the left and right side can be
adjusted. The virutal LED chain serves as modulation display. This value should
only be changed manually when trying to solve a problem. In the easy setup the
ideal gain value will be configured automatically for you.

7. Direct phono input

Here you can define whether a turntable has been directly connected to the
computer. When using the Spin! interface (line output) a “No” must be displayed
here.

8. 45 RPM
Here you can determine whether the timecode records should be played at 45
RPM (Rounds Per Minute). Default setting and usual is 33 RPM.

9. Left/right inverse

When using certain needles or when having calibrating problems it could be that
the left and right side have been mixed up. For the software sector this can be
re-adjusted via this option.

10. Phase inverse

Via this function you can invert the phase. Some cartridges, for example the
Shure M44-7 or certain CD players need this phase inversion in order to run
without any problems.

11. Timecode start delay

Here you can determine the starting point of your timecode record. As usually
the first third of the record is likely to be worn out first it is possible to offset the
starting point to a desired position. To do so place the needle on the desired
starting point and push “Save Position"”. The value is displayed in milliseconds.

12. Noise Level/Noise Filter
These two values are only intended for optimisation and for solving problems.
Due to easy setup these values have already been configured.

* Noise Filter:
When experiencing grounding problems or something similar you can
increase the noise filter to 150 for example in order to improve the input
signal. The louder the noise the higher the frequency should be raised.

ATTENTION!
The timecode's precision could decrease if the noise filter is set too high.

e Noise Level:
Here you can adjust the noise level in decibel. For a better sensitivity the
value should be increased. Default setting is 40 dB.

13. Calibration Display

Here the timecode signal is displayed optically. Ideally the signal should look like
a sinus curve.

If the signal is distorted (square wave) you should check your needles or adjust
the settings as described above.
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14. Circle Diagram
Alternatively the calibration display can be shown as a circle diagram. To do so
activate this button.

15. Calibrate Test
Push this button in order to calibrate the respective player automatically with
the pre-set options.

16. 1 Turntable Mode

If you wish to use only one turntable you should activate this mode in order to
control both players. Make sure that the same interface input is selected under
“Audio Source" (see item 4).

TIP!
You can choose between the players via the TAB button.

17. More Options
Activate this button in order to fade in the advanced options (noise level / noise
filter and 1 turntable mode)

18. Apply
Push this button in order to apply the adjustments. Then push “OK" in order to
quit the menu.

4.1.5 Workspace

ﬁ
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1. Resolution Selection
The available resolutions are listed here. Select the according resolution for your
monitor.

2. Apply
Adopt the settings via the apply button.



4.1.6 Shortcuts
[ |

System | BPH and Tools | Audic dvices | Timecods | Workspace  Shertcuts | MIDI-Contioler |

+ Shortcut-Setting Fil

Spin_Keyboardds
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1. Shortcut Setting File
Here you can select the hot key layout for your keyboard.

The following options are at your disposal:

*  Spin_keyboardQWERTZ
(Germany, Austria, Switzerland, Hungary)

+  Spin_keyboardQWERTY
(America, England, Netherlands, Italy, Scandinavia, Poland, Spain, Portugal)

+  Spin_keyboardAZERTY
(France, Belgium)

2. Layout Preview
Here the keyboard layout is displayed in a preview.
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4.1.7 MIDI Controller

Options

System | BPM and Tools | Audio devices | Timecods | Workspacs | Shortcuts MIDI-Contioler |

i~ MIDI Input
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1. Activate MIDI
Via this you can activate the MIDI operation for Spin!

2. MIDI Device
Here you can find a list of compatible MIDI controllers, for example Reloop Digital
Jockey (www.digital-jockey.d)).

3. MIDI Setup File
The pre-configured MIDI configuration files are listed here.

4. Omni Mode
If this option is activated Spin! will receive on all channels.

HINWEIS!
Please check reqularly for Spin! updates under www.reloop-spin.com in order
to download new MIDI mappings for example.



4.2 Auto Search
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Via the auto search function you can easily locate music files on your hard disc
and add them to the Spin! library.

1. Path
The currently selected path is shown here.

2. Select Directory
Via this function you can select single files.

3. Add Directory
If this option is activated a directory will be added.

4. All Drives
Select this option in order to select all drives from your work space and search
for tracks.

5. Subdirectories
If this option has been selected subdirectories will also be considered when
searching.

6. No Duplicate
If this option is activated the already added tracks will not be added again to the
Spin! library when searching in the same directory for a second time.

7. Advanced Search
Categories such as artist, title or genre can be filtered here while searching.

8. Exact Search
If this option is activated only exact matches will be added.

9. All Fields Search
If this option is activated all category fields will be searched.

10. Initialize Spin! Library
If this option is activated the Spin! library will be initialized.
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4.3 Track Preferences

In the track preferences you can activate these settings and data of a track. You
can reach the track preferences under the menu item:

> Track > Track Preferences

or by clicking the right mouse button on the track in the Spin! library.

4.3.1 Information

Here you can see and edit various information like title, artist or label for
example. Additionally it is possible to save comments to a track.
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4.3.2 File

Here you can see information regarding saving location and audio quality.
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4.3.3 Track Settings

Here you can see and edit settings such as starting and ending points, loops or

pitch.
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4.3.4 Volume

If desired you can preset gain, pan or fade in/out for a track.
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4.3.5 Lyrics
If desired you can enter and see song lyrics here.
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4.3.6 Cover
Here you can upload and see cover artwork for a track.
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4.3.7 Equalization

Here you can adjust the EQ settings.
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4.3.8 Cue Points

Here you can pre-define up to 10 cue points if required.
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4.3.9 Loop
Here you can pre-define up to 10 loops if required.
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5. FAQ

5.1 Do | need a special stylus in order to use Spin!?
No. Spin! will work with every needle. Still, some things should be considered to
guarantee a smooth performance:

Your needle should neither be worn out nor be dirty/dusty. If you use a
headshell-mounted system please be sure that it is aligned properly.

Also its output voltage should be as high as possible to ensure a ,clean”
timecode stream. This is why we bundled the Ortofon Digitrack System with
Spin!: due to its ,,Concorde”-design you dont have to make any adjustments and
its very high output (8mV) makes sure that the timecode stream is always nice
and clean.

5.2 Can | buy the timecode vinyl records separately?

Yes, of course. Timecode vinyl records wear out quicker than normal vinyl
because you don't change them after every song. Besides the normal wear and
tear your records get while being used, oil or grease will degrade the quality of
your timecode vinyl. Because of that your dealer has spare records. They come
in black, white and atomic green.

5.3 Why won't my computer recognize the Spin! interface?

There may be several reasons. We would recommend to unplug all your USB
devices to eliminate conflicts with USB soundcards for example.

Also we advise you not to use a hub to connect Spin! to your computer. If
possible, always make a direct connection.



5.4 Why is there no timecode signal?

If Spin! can not detect a timecode signal during installation please make sure you
do not have a microphone plugged to the interface (the mic input disables
input 1).

If your turntables are connected to the interface and there is no mic plugged in
and Spin! can not read a timecode signal then proceed as follows:

Go to ,,Options/ Timecode" and check if any waveforms are displayed. If there is
only one waveform displayed then there is a faulty connection between your
needle and the interface. In order for Spin! to work it needs to read TWO
waveforms. Just to clarify: that means TWO waveforms PER PLAYER, shown in
red and white.

First, swap your needles. If the problem migrates along with your needle to the
second turntable then your needle is either dirty/ broken or the contacts are
dirty. Use a g-tip and some cleaning alcohol to clean both the contacts on the
cartridge and in the tonearm. Please do NOT spray contact spray or anything
else into the tonearm!

You can check whether you get a stereo signal out of your turntable by playing
a normal record and using the panorama knob on your mixer.

If both needles work on one of the turntables but not on the second turntable
then you probably have a bad RCA cord. Please replace it. If the audio cords are
permanently attached to your turntable then contact your specialized dealer /
technician and ask for help.

5.5 Why do | only hear a high-pitched tone?

You're listening to the timecode stream because you activated ,,Vinyl Bypass”,
located right above the Label Monitor. ,,Vinyl Bypass" allows you to play your
normal records. In your case, you're playing the timecode vinyl. Deactivate ,, Vinyl
Bypass” and the control vinyl will play your digital music.

5.6 Can | play my reqular records when | am using Spin!?

Absolutely. Activate ,Vinyl Bypass" (right above the Label Monitor). The signal
coming from your records is now made audible. Use the following hotkeys: ,,N"
will toggle Bypass for the left player, ,,M" for the right.

5.7 Why is the music playing backwards?

Your turntable is playing normally yet your music is playing backwards? Your
turntable may be hooked up incorrectly.

Your cables are mixed up- the left and right channels of your turntable are
reversed. Simply swap them and everything should be back to normal.

If for some reason you can't swap the cables then go to ,File-> Options->
Timecode" and check the box next to ,,Left/Right Inverse”. Basically this has the
same effect as swapping your cables would have, however, it is always a better
to have your equipment connected correctly.

5.8 Can | play my records at 45 RPM instead of 33 RPM?
Yes. Go to ,File -> Options -> Timecode" and check the box next to ,,45 RPM".
Now re-calibrate Spin! (make sure that the turntable's pitch fader is set to ,,0").

| ggﬁi
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5.9 Why are both tracks being played on the same channel?

Both players are routed to the same OUT PORT. In the Info Screen, click on the
number after ,,Out Port” to change the routing. Typically you will want to route
the left channel to Port 1 and the right one to Port 2.

5.9.1 Why is there no signal?
There are several possibilities, please check the following:

« Is your mixer/amp turned on? Are gain, line and master controls turned up?

+ Did you choose the correct input on your mixer (phono instead of line)?

+ Isvinyl control activated? (Button , Vinyl” below the Label monitor has to be
green)

+ Is Spin! correctly configured?

+ Have all the cords been plugged correctly?

+ Does Spin! recognize the timecode?

+ Is a microphone plugged in? Unplug the mic, it blocks Input 1.

+ Is the correct Out Port set? Left Player: Out Port 1, right player: Out Port 2.

5.9.2 Can | use the interface as a sound card?

You can use the Spin! interface as a mobile USB sound card with two stereo
inputs and two stereo outputs. Also it features a microphone input with
adjustable gain. If you use the mic input it will work instead of stereo input 1.

5.9.3 What do | have to observe if | use a Shure M44-7?
This cartridge will need a phase inversion. Go to ,File -> Options -> Timecode"
and tick the box next to ,,Phase Inverse”.

5.9.4 Why is the music skipping a beat now and then?

The cause may be a hard disc that is too slow. One solution is to set the setting
“Load Tracks to RAM"” to “rapid” under "options>system”. Furthermore it is
recommended to defragment the hard disc where the tracks are stored in order
to optimize the reading abilities.

5.9.5 Why does the speed / the pitch of my tracks fluctuate?
There are several reasons for this:

+ Spinlis not calibrated

+ the neddle is dirty/ dusty

« thereis too much weight on the needle

+ the needle is worn out

« the timecode vinyl is worn out (scratches, cue burn) or dirty

5.9.6 Is there an auto mix/party mix function?

Yes. Add some tracks to the Spin! list (NOT the Spin! library) and select ,play
Spin! list” by right-clicking into the list. The tracks will be played alternately
between both players.



5.9.7 How can | optimize the performance of Spin!?
A computer with decent performance and stability is important in order to have
Spin! running reliably. Here are some tricks:

+  Open the settings for your system performance in your control panel under
.System>Advanced”. Here select the setting ,,adjust for ideal setting”.

« Deactivate any LAN / WLAN and network devices.

+ Deactivate virus scanners and power managment software.

+ In Windows, go to ,System Properties ->Advanced -> Performance Options”
and tick ,,Background services" in your Windows settings

+ Defragment your hard disc

+ Don't have other programs running in parallel with Spin!.

+ In Spin!, go to ,File -> Options" and tick ,,Sound before graphic priority"

| ggﬁi

5.9.8 What can | do if | hear humming or buzzing when using a laptop?

Try to disconnect the mains adapter from your laptop. If the humming is no
longer audible this is a grounding problem. You can try to solve the problem via
the following procedures:

+ Try to use a mains adapter without grounding.

« Try to connect all your devices to only one circuit.
« Try to place the mains and RCA cords separately.
+ Check if your turntable is grounded correctly.

« Try to connect an anti-buzzing filter.

6. HOT KEY OVERVIEW
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MODE D'EMPLOI

FRANCAIS

Nous vous félicitons d'avoir choisi le systeme Reloop Spin!, preuve de la
confiance que vous accordez a notre technologie pour Disc Jockey. Avant la
mise en service, nous vous prions de lire attentivement ce mode d'emploi et
de respecter les instructions pendant I'utilisation.

Retirez le Reloop Spin! de son emballage. Avant la premiére mise en service,
vérifiez le bon état de I'appareil. Si le boitier ou le cable sont endommagés,
n'utilisez pas I'appareil et contactez votre revendeur.

CONSIGNES DE SECURITE

ATTENTION !

Soyez particulierement vigilant lors des branchements avec la tension

secteur 230 V. Une décharge électrique a cette tension peut étre mortelle !

La garantie exclu tous les dégats dus au non-respect des instructions de ce

mode d'emploi. Le fabricant décline toute responsabilité pour les dégats

matériels et personnels dus a un usage incorrect ou au non-respect des
consignes de sécurité.

- Cet appareil a quitté I'usine de fabrication en parfait état. Afin de conserver
cet état et assurer la sécurité de fonctionnement, I'utilisateur doit
absolument respecter les consignes de sécurité et les avertissements
indiqués dans ce mode d'emploi.

- Pour des raisons de sécurité et de certification (CE), il est interdit de
transformer ou modifier cet appareil. Tous les dégats dus a une modification
de cet appareil ne sont pas couverts par la garantie.

- Le bofltier ne contient aucune piéce nécessitant un entretien, a I'exception de
pieces d'usure pouvant étre remplacées de I'extérieur. La maintenance doit
exclusivement étre effectuée par du personnel qualifié afin de conserver les
droits de garantie !

- Les fusibles -57- doivent uniquement étre remplacés par des fusibles de
méme type, dotés de caractéristiques de déclenchement et d'un ampérage
identique.

- Veillez a n'effectuer le raccordement secteur qu'une fois linstallation
terminée. Branchez toujours la fiche secteur en dernier. Vérifiez que
I'interrupteur principal soit sur "OFF" avant de brancher I'appareil.

- Utilisez uniguement des cables conformes. Veillez a ce que toutes les fiches
et douilles soient bien vissées et correctement connectées. Si vous avez des
guestions, contactez votre revendeur.

- Veillez a ne pas coincer ou endommager le cordon d'alimentation par des
arétes tranchantes lorsque vous installez I'appareil.

- Prenez garde a ce que le cordon électrique n'entre pas en contact avec
d'autres cables et soyez prudent lorsque vous manipulez des lignes ou des
prises électrigues. Ne touchez jamais ces éléments avec des mains humides!

- Insérez uniquement le cordon d'alimentation dans des prises électriques de
sécurité. La source de tension utilisée doit uniguement étre une prise
électrique en ordre du réseau d'alimentation publique.

- Débranchez I'appareil lorsque vous ne I'utilisez pas ou pour le nettoyer ! Pour
débrancher I'appareil, tirez toujours sur la prise, jamais sur le cable !

- Placez I'appareil sur une surface plane, stable et difficilement inflammable.
En cas de larsen, éloignez les enceintes de I'appareil.

- Evitez tous les chocs et I'emploi de la force lors de I'installation et I'utilisation
de l'appareil.

- Installez I'appareil dans un endroit a I'abri de la chaleur, de I'humidité et de
la poussiére. Ne laissez pas trainer les cables pour votre sécurité personnelle
et celle de tiers !

- Ne placez jamais des récipients de liquides susceptibles de se renverser sur
I'appareil ou a proximité directe. En cas d'infiltration de liquides dans le
boitier, retirez immédiatement la fiche électrique. Faites contrdler I'appareil
par un technicien qualifié avant de le réutiliser. La garantie exclu tous les
dégats dus aux infiltrations de liquides.



- N'utilisez pas I'appareil dans un environnement extrémement chaud (plus de
35°C) ou froid (sous 5° C). N'exposez pas l'appareil directement aux rayons
solaires ou a des sources de chaleur telles que radiateurs, fours, etc.
(également valable lors du transport). Veillez a ne pas obstruer les
ventilateurs ou les fentes de ventilation. Assurez toujours une ventilation
convenable.

- N'utilisez pas I'appareil lorsqu'il est amené d'une piéce froide dans une piece
chaude. L'eau de condensation peut détruire votre appareil. Laissez 'appareil
hors tension jusqu'a ce gu'il ait atteint la température ambiante !

- Ne nettoyez jamais les touches et curseurs avec des produits aérosols ou
gras. Utilisez uniguement un chiffon [égérement humide, jamais de solvants
ou d'essence.

- Utilisez I'emballage original pour transporter I'appareil.

- Réglez d'abord les curseurs de réglage et de volume de votre ampli au
minimum et les interrupteurs des enceintes sur "OFF". Attendez 8 a 20
secondes avant d'augmenter le volume afin d'éviter I'effet de Schottky,
susceptible d'endommager les enceintes et le diviseur de fréguence.

- Les appareils électriques ne sont pas des jouets. Soyez particulierement
vigilants en présence d'enfants.

- Les directives de prévention des accidents de l'association des fédérations
professionnelles doivent étre respectées dans les établissements
commerciaux.

- Dans les écoles, instituts de formation, ateliers de loisirs etc. 'utilisation de
I'appareil doit étre effectuée sous la surveillance de personnel qualifié.

- Conservez ce mode d'emploi pour le consulter en cas de questions ou de
problémes.

UTILISATION CONFORME

Cet appareil est une interface Timecode numérique permettant de contréler
le logiciel par les disques Timecode vinyles ou compacts fournis. L'interface
doit pour cela étre connectée a l'ordinateur par un cable USB.

- Ce produit est certifié pour le branchement sur secteur 230 V, 50 Hz tension
alternative et est exclusivement congu pour étre utilisé en local fermé.

- Toute utilisation non conforme peut endommager le produit et annuler les
droits de garantie. En outre, toute utilisation autre que celle décrite dans ce
mode d'emploi peut étre source de courts-circuits, incendies, décharge
électrique, etc.

- Le numéro de série attribué par le fabricant ne doit jamais étre effacé sous
peine d'annuler les droits de garantie.
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- Controlez régulierement le bon état de I'appareil (boftier, cordon) et 'usure
éventuelle des molettes et curseurs.

- Si vous supposez que l'appareil ne peut plus étre utilisé en toute sécurité,
mettez I'appareil hors-service et assurez-le contre toute réutilisation
involontaire. Débranchez la fiche électrique de la prise de courant !

- La sécurité d'emploi est susceptible d'étre affectée lorsque I'appareil est
visiblement endommagé, ne fonctionne plus correctement, aprés un
stockage prolongé dans des conditions défavorable ou aprés une forte
sollicitation de transport.

Ce manuel, les vidéos de démonstration, conseils & astuces ainsi que
d'autres téléchargements sont disponibles sur le site ci-dessous :

www.reloop-spin.com

CONFIGURATION MINIMUM :

« processeur récent (minimum recommandé : Pentium I, 1IGHz)
« systéme d'exploitation Windows 2000, XP, NT, Vista

+ port USB libre

*+ RAM min. 512 MO

. Branchements & installation du logiciel

1.1 Branchements
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a) Raccorder les sorties de votre platine vinyle ou lecteur de disques compacts
avec les entrées respectives (1 ou 2) du Reloop Spin! Interface -1-. Le cas
échéant, relier votre platine vinyle a la vis de mise a la terre GND -3-.

b) Raccorder les sorties Line de l'interface Reloop Spin! avec les entrées Line
de votre console de mixage. -2-

¢) Raccorder l'interface Reloop Spin! avec I'ordinateur par un port USB libre.
Les messages ci-dessous (exemple XP) doivent a présent s'afficher sur votre
écran :

Nouveau périphérigue détecté -
Reloop Spin! Interface

jr.! Neue Hardware gefunden |

Reloop Spin!-Interface

Nouveau périphérigue détecté -
périphérigue audio USB

._y Meue Hardware gefunden | *
[J5E-audioger &t

Nouveau périphérigue détecté -
Le périphérique a été installé et peut étre utilisé.

i) Neue Hardware gefunden x

Die neue Hardware wurde installiert und kann jetzt verwendet
werden,

NOTE
L'installation de votre interface Spin! avec Windows XP & Vista est de type
Plug 'N' Play et ne requiert aucun pilote spécial.

d) Apreés la détection et I'installation de votre interface Spin! par le systéme, il
faut régler le volume au maximum dans les préférences audio Windows.

Exemple pour XP :
Démarrage > Panneau de configuration > Sons et périphériques audio> onglet
“Audio”

Eigenschaften von Sounds und Audiogerdte m

| Lautstike | Sounds | Audio | Stimme | Hardware |

Soundwiedergabe

Standardgerat:
| Feloop SpinlInterface M
[ Lautstarke.. [ Ernweitert... ]
Soundaufnahime
ﬁ Standardgerat:
| Feloop SpinlInterface M
[ Lautstarke... ] [ Erweitert... I

MIDI-Musikwiedergabe

% Standardgerat:

ety |Microsoft G5 Wavetable 5w Sunth M

[ Lautstarke: ] [ Infao ]

Mur Standardgerate verwenden
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Appuyer sur la touche ,Volume" sous Il'option ,Lecture du son" et
LEnregistrement du son”. Régler tous les curseurs au maximum pour un résultat

optimal.
5] Lautsprecher M
Optionen 2
Lautzprecher Wave SW-Synthesizer CD-Flayer Line
Balance: Balance: Balance: Balance: Balance:
PO ¢ 00 96T 9> >0 ¢
Lautstarke: . Lautstarke: Lautstarke: Lautstarke: Lautstarke:
[Ion a:us : [ Ton aus []Ton aus [ Ton aus []Ton aus
Reloop Spin!-Interface
L'option 'enregistrement sonore' est [Mc..[= )22 B L) o/Edl
différente pour un vinyl et CD | gptionen z Optioren 2
d'installation. Line Line
. < Balance: Balance:
1) Vinyl Parameétres
»—3 9
Appuyez sur le bouton Y

'enregistrement sonore' et Lavtstitke:

maximiser le curseur.

2) CDJ Parameétres

Appuyez sur le bouton
'enregistrement sonore' et
minimiser |e curseur. 1) Reloop Spin!-Interface 2) Reloop Spin!-Interface

Quitter ensuite le Panneau de configuration.
e) Autres fonctions et branchements de votre interface Spin! :

DEL USB -4-:
s'allume lorsque l'interface est détectée par I'ordinateur et activée.

FRANCAIS

NOTE
L'alimentation électrique de I'interface est assurée via USB. Elle ne requiert
donc aucun branchement sur le secteur.

Casque -5 / 6-:

permet de brancher un casque (3,5 mm jack) pour pré écouter le signal de
sortie Master directement sur l'interface -5-. Le régleur Monitor -6- permet
d'ajuster le volume.

NOTE
Vous pouvez aussi utiliser cette sortie comme connexion Record, par
exemple pour enregistrer une session.

Microphone -7 / 8- :
Le connecteur -7- permet de brancher un microphone (6,3 mm jack). Vous
pouvez régler le volume au moyen du régleur -8-.

ATTENTION !

L'entrée microphone est couplée a la sortie stéréo, vous pouvez donc
utiliser soit un microphone, soit le signal de sortie du canal 1. Veiller a ne
pas brancher un microphone pendant I'utilisation Timecode normale de
Spin!, autrement, le canal est bloqué.
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1.2. Installation du logiciel

Apres avoir terminé les branchements, il faut installer le logiciel. Insérer le
cédérom d'installation Spin! dans le lecteur de disque compact de votre
ordinateur. Si l'installation ne démarre pas automatiguement, exécuter

manuellement le fichier ,,Install.exe".

Sélectionner la langue de l'installation et valider avec ,, OK".

fnstae g

Language ?

" Deutsch

" Frangais

ok | Cancel |

Lire et accepter ensuite les clauses de la licence.

(FRTRL T —— |

Fleaze read the license term before installing.

RELOOF LICENSE AGREEMENT |§‘

B CLICKING THE ACCEPTANCE BUTTOM OR INSTALLING OR USING THE RELOOP
SOFTWARE [THE "PRODUCT"), THE INDIVIDUAL OR ENTITY LICENSING THE PRODUCT
["LICENSEE"] 1S CONSENTING TO BE BOUMD BY AND |5 BECOMING & PARTY TO THIS
AGREEMENT. IF LICENSEE DOES NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, THE BUTTON INDICATING MOM-ACCEPTANCE MUST BE SELECTED, AND
LICEMSEE MUST MOT INSTALL OR USE THE PRODLICT.

1. LICEMSE: The Product is Iic:en_sx_ed, not zold. The Product iz protected by copyright law and

international copyright treaty provisions, as well as other intellectual property laws and treaties. You

Do you accept all terms of this license " hccept | Decline
agreement ? b : —

5

A
~
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Saisir a présent votre nom, société le cas échéant, adresse de courriel (obligatoire)
et le numéro de série. Le numéro de série est écrit sur la face postérieure de la
pochette du cédérom d'installation Spin!. Valider les entrées avec ,,Suivant”.

INSTALL 5]

Mame

IYDur harme

Company

IYDur company

Email

Iyour@email.con’]
Code

Erecoos

teloop . Refoop € | |

M I Cancel |

Sélectionner ensuite le répertoire dans lequel vous désirez installer votre logiciel
Spin! ou utiliser le répertoire par défaut (recommandé). Valider ensuite avec
»Suivant”.

(INSTALL B

Install Directary:

|C:\Frogramme’ ReloopsReloop Spin

Browse...l
@Srecoop) |
Cop 2008 REGHH
Beadie | < Back | Mext > | Cancel |

Une fois I'installation achevée, quitter le Setup avec ,Finaliser”.

—
[ INSTALL

@Sirecoor)

Beadie |

NOTE
Vérifier réqulierement les nouvelles mises a jour sur www.reloop-spin.com.

ATTENTION utilisateur Vista!

Lors de la saisie de votre numéro de série, il se peut que le message suivant
apparaisse : “Le numéro de série est incorrect” (the serial number is not
correct).

Si tel est le cas, cliquez sur Démarrer et ouvrez le panneau de configuration.
Dans la rubrique ‘Compte d'utilisateurs’, cliquez sur ‘Activer ou désactiver
le contréle des comptes d'utilisateurs’'.

Puis, décochez 'Utiliser le contrdle des comptes d'utilisateurs pour vous
aider a protéger votre ordinateur’.

Vous pouvez désormais saisir a nouveau votre numéro de série et poursuivre
le processus d'installation.



1.3 Easy Setup
L'installation rapide se lance automatiquement au premier démarrage de Reloop
Spinl.

NOTE
Easy Setup peut aussi étre exécuté manuellement dans I'option >Help>Easy
Setup!.

1. Resolution/Résolution
La premiere étape consiste a sélectionner la résolution de votre écran.

SPIN!
SPINIT 024

Resolution:

1280 Widescreen

USPINE 1280

Step1 /6

< ZUriich I Weiter » I Abbrechen

2. Calibrage entrée 1
II faut a présent effectuer le calibrage. Sélectionner le support de lecture
respectif. Activer le mode de lecture et cliquer sur ,,Suivant”.

Source connected :

7 Mo Source

" CD Player

» Choose source > Play the timecaode souwrce > Press 'Mest!
Tip:
Please set Fitch to 0% and spin in forward direction

Step 2 /B

< Zuriick I wieiter > I Abbrechen

-
AJ
>
P
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3. Résultat du calibrage pour entrée 1
Une fois le calibrage achevé, le message ,,Spin! has been calibrated successfully"
doit s'afficher.

NOTE

Si le message ,,Spin! has not been installed properly” ne s'affiche pas,
contrdler les branchements ou changer ['aiguille de votre platine vinyle.

SPIM! haz been calibrated sucessfully!

Tip:
Pleaze check connections and hardware setup.
More options under File > Options » Audio devices AMD > Timecode

Step3 /6

< Zuriick  |{ wieiter > Abbrechen

4. Calibrage entrée 2
Procéder comme décrit plus haut avec le deuxiéme lecteur.

Source connected :

" NoSource

" CD Player

» Choose source > Flay the timecode souce » Press Mest'
Tip:
Please set Fitch to 0% and spin in forward direction

Stepd /B

< Zuriick. I Wwieiter > I Abbrechen




5. Résultat du calibrage pour entrée 2
La aussi, un message doit s'afficher pour indiguer que le calibrage est achevé.

NOTE
Le calibrage est uniquement nécessaire pour les platines vinyles. Cette
étape est ignorée si des lecteurs de disques compacts sont connectés.

SPIM! haz been calibrated sucesshully!

Tip:
Pleaze check connections and hardware zetup.
tore options under File > Options > Audio devices AMD > Timecode

Step5 /6

< Zuriick  |i Welter» ¢ Abbrechen |

6. Lorsque le Setup est correctement terminé, vos paramétrages sont validés.
Pour quitter l'installation rapide, cliquer sur la touche ,Finaliser".

Easy gegup! . Bpglmlzatmn w

Optimize SPIMI:

Set thiz optian if vou control SPIMI mainly with vingl or od

v Tick scrolling

Set this option for display optimization

[~ MoBPM and Waveform calculation on load

Set this option to optimimize the loading of files. However no BPM AW aveform will be displayed

StepB /B

< Zuriick. I Fertig slellenl Abbrechen |

NOTE
L'étape suivante de l'installation offre trois options pour optimiser votre
interface Spin!. Voir plus amples informations au chapitre 4.1 ,,Options".

-
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1.4 Premiers pas avec le logiciel
Les premiéres opérations devant étre effectuées pour pouvoir travailler avec le
logiciel sont expliquées ci-dessous.

NOTE
Vous pouvez aussi accéder au manuel dans le menu > Help > Manual.

a)

b)

c)

Importer des fichiers audio
Commencer par importer toute votre musique dans la Spin! Library. Dans le
menu, sélectionner I'option > Spin! Library > Auto Search.

Vous pouvez ici rechercher des fichiers de musique dans des classeurs ou
sur des lecteurs. Valider votre sélection avec ,,0K".

Charger une piste
Aprés avoir importé votre musique, vous pouvez charger différentes pistes
dans les lecteurs 1 et 2. Vous disposez pour cela de trois méthodes :

Avec la souris
Tirer le fichier dans le lecteur par cliquer&tirer.

Avec Trax Select

Sur la face B du disque vinyle Timecode Spin!, la derniére section du sillon
est dédiée a la sélection des titres. Poser l'aiguille dans cette section pour
naviguer dans la Spin! Library. Stopper le disque sur la piste désirée et poser
I'aiguille au début du disque pour charger le titre respectif dans le lecteur.

Avec le clavier

Utiliser les touches fléchées haut/bas pour naviguer dans le Spin! Library
jusqu'a la piste désirée et la charger en appuyant sur la touche Enter. La
touche permet de sélectionner le lecteur actif.

Activer le mode Timecode
Cliguer sur la touche ,,Vinyl", a droite sous le Label-Monitor pour activer le
mode Timecode.

Vous pouvez maintenant commencer la session.




2. VUE D'ENSEMBLE DU LOGICIEL :

Main «»
Volume

3

e Fred Falke - Love lost | /

Remain: 02:54.30

S

Repeat: OFF Qut Port:
ininl~Inlm]
B EEEE

£ I }E

Flanger- - - Filter - - Delay -

doonesg
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1. Shortcut: New Spin! Library
Veuillez consulter les instructions du chapitre 3.2.1.

. Shortcut: Open Spin! Library
euillez consulter les instructions du chapitre 3.2.2.

. Shortcut:Auto Search
euillez consulter les instructions du chapitre 3.2.7.

< W

IO

D

. Shortcut: Save Spin! Library
euillez consulter les instructions du chapitre 3.2.3.

<

. Shortcut: Stop Spin! List
euillez consulter les instructions du chapitre 3.4.2.

< u

. Shortcut: Play Spin! List
euillez consulter les instructions du chapitre 3.4.1.

< O

=~J

. Shortcut: Loop Spin! List
épéte la liste de lecture Spin! en boucle sans fin.

Py

8. Shortcut: Shuffle Spin! List
Programme une lecture aléatoire de la Spin! List.

9. Shortcut: Previous
Charge la piste précédente de la Spin! List dans le lecteur.

10. Shortcut: Next
Charge la piste suivante de la Spin! List dans le lecteur.

Y

1. Shortcut: Music Explorer / Audio Input
euillez consulter les instructions du chapitre 3.5.9.1.

<

12. Shortcut: Spin! Library
Veuillez consulter les instructions du chapitre 3.5.7.

13. Shortcut: Spin! List
Veuillez consulter les instructions du chapitre 3.5.8.

14. Shortcut: Category View
Veuillez consulter les instructions du chapitre 3.5.9.

15. Shortcut: X-Fader Match View
Veuillez consulter les instructions du chapitre 3.5.9.2.

16. Shortcut: Master/Rec. Volume
Veuillez consulter les instructions du chapitre 3.5.9.3.

17. Shortcut: Beat Match View
euillez consulter les instructions du chapitre 3.5.9.4.

<

18. Shortcut: Options
Veuillez consulter les instructions du chapitre 3.1.2.

19. Safe Mode
Veuillez consulter les instructions du chapitre 3.4.4.

QIEICICIOEIGIC IBIOOO«/QIO,



20. Beatmatch View

La vue Beat Match affiche les pointes des deux pistes, les deux vues étant face
a face. Ceci permet de reconnaitre rapidement, si par exemple les Bassdrums ou
les Snares sont synchrones. A condition que la vitesse des deux pistes concorde,
vous pouvez aisément et rapidement synchroniser les deux morceaux. Le lecteur
13 gauche est représenté en vert et le lecteur 2 a droite en gris.

21. Complete View

La Complete View affiche le tracé de I'onde de la piste entiére. Vous pouvez ici
par exemple détecter le tracé d'une piste et voir ou les intros et breaks
commencent. La partie écoulée de la piste actuelle est représentée en vert, la
partie restante en gris.

22. Needle View

La Needle View est une vue agrandie de ['oscillogramme. Les différents
battements de grave sont ainsi aisément détectés.

Vous pouvez régler la gamme du zoom de 2 a 16 battements. Cliquer sur le
bouton droit de la souris dans la Needle View et sélectionner la valeur désirée
dans le menu contextuel.

Vous pouvez en outre sélectionner si I'onde gauche, droite, stéréo ou mixte des
deux canaux doit étre affichée. Cliquer sur le bouton droit de la souris pour
sélectionner I'option respective dans la Needle View.

Vous disposez de deux variantes pour I'écran Needle View :

e Waveform Scrolling
Le tracé de I'onde est dynamique. Le trait vertical au milieu représente
['aiguille.

e Tick Scrolling
Le tracé de I'onde est statique. Le trait (position de I'aiguille) se déplace.

NOTE!
Cette option économise plus les ressources du systéme.

Cliguer sur le bouton droit de la souris pour sélectionner ['option respective dans
la Needle View.

23. Master
Régle le volume général pour les lecteurs 1 et 2.
Main ===

Volume
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24. ouvrir/charger une piste
Charge un fichier individuel dans un lecteur.

25. Fonction Bypass

Lorsque la fonction Bypass est activée, le signal d'entrée de l'interface Spin! peut
directement étre mis en boucle par le logiciel. Vous pouvez alors lire un disque
vinyle normal. La fonction Bypass doit étre désactivée pour I'utilisation du mode
Timecode normal. Les raccourcis clavier sont ,,N" (lecteur 1) ou ,,M" (lecteur 2).

26. Label-Monitor

Le Label Monitor est comme un disque virtuel qui suit les mouvements du disque
Timecode. Chagque mouvement exécuté sur le disque est en méme temps
reproduit sur le Label Monitor. Pour le Beat Juggling, vous pouvez par exemple
utiliser le Label Monitor en tant que marqueur virtuel.

T

*- Bypass

27. Gain Regler

Le régleur de Gain, comme sur une console de mixage, sert a I'amplification
finale d'une voie de canal. Ceci vous permet d'accorder des pistes dont le volume
d'enregistrement est différent sans augmenter le volume Master.

NOTE

Sous > File > Options > Onglet ,,BPM And Tools!"” > Rubrique ,,Auto BPM"
vous pouvez activer la fonction Auto Gain. Les valeurs de Gain des pistes
sont alors ajustées automatiguement, sans intervention manuelle.

Gﬂln B EE

& REE R




28. Pitch Mode

Le Pitch Fader -29- vous permet de régler trois différents modes Pitch. Pour
modifier le mode, cliquer avec la souris sur le bouton -28- ou utiliser le raccourci
clavier ,,A" (lecteur 1) ou ,K" (lecteur 2).

a) Speed Mode
Lorsque le Speed-Mode est activé, vous pouvez régler la vitesse Pitch
comme sur une platine vinyle. Dans la gamme de vitesse réglée, la valeur
actuelle est aussi affichée dans Info View -48- a la position -7-.

b) Master Tempo Mode (MT)

Si le mode Master Tempo est activé vous pouvez utiliser le curseur Pitch -29-
pour modifier le tempo de +/- 6%, sans pour autant modifier la tonalité. Cela
signifie que la tonalité est conservée méme si le tempo varie.

NOTE

Le mode Master Tempo fonctionne uniguement avec les modes Advanced et
Battle (voir 31).

L VAR

c) Key Mode
Le mode Key offre la fonction inverse a celle du mode Master Tempo. La
tonalité varie ici indépendamment du tempo réglé.

NOTE

Le mode Key fonctionne uniquement avec les modes Advanced et Battle.

SIVHANVYN 4

29. Pitchfader

Le Pitchfader représente un curseur Pitch conventionnel d'une platine vinyle ou
d'un lecteur de disques compacts. En mode Timecode Vinyl -30-, le curseur se
déplace en méme temps que les mouvements exécutés sur la platine vinyle.
Ceci dépend du mode Pitch réglé (voir 28). Si le mode Timecode est désactivé,
vous pouvez aussi déplacer le Pitchfader avec la souris.

m
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30. Activation de Vinyl Timecode

Cette touche sert a activer le mode Timecode, donc permettre le contrble via
vinyle et CD Timecode. Si cette touche est désactivée, vous pouvez uniguement
contrdler le logiciel avec la souris.

31. Touche mode Spin!

Appuyer sur cette touche pour sélectionner parmi les modes de lecture Spin!
Mode, Classic Spin!, Advanced Spin!, Battle Spin!. Les raccourcis clavier sont , A"
(lecteur 1) ou ,,K" (lecteur 2).

a) Classic Spin!
Les fichiers audio sont lus du début a la fin comme avec un disque normal
(Needle Drop). Les mix et scratchs classiqgues sont alors possibles, mais sans
les options Loop, ni points Cue ou effets.

i

b) Advanced Spin!
Ce mode permet aussi un ,Needle Drop"”. Cependant, celui-ci est
proportionnel a la longueur du vinyle. Si par exemple, vous voulez aller au
milieu d'un morceau, il faut placer l'aiguille au milieu du disque Timecode.
Vous pouvez mixer et scratcher comme d'habitude et en plus disposer des
fonctions Loop, points Cue et des effets.

c) Battle Spin!
Ce mode ne permet pas le Needle Drop. Cela signifie que la lecture de la piste
continue toujours, quelle que soit la position de I'aiguille sur le vinyle
Timecode. Ce mode est idéal pour scratcher, méme si l'aiguille venait a
sauter. Vous pouvez ici mixer en mode Battle avec les fonctions Loop, les
points Cue et les effets.

i

32. Touche Play/Pause

Appuyer sur cette touche pour lancer la piste auparavant sélectionnée. Cette
fonction est uniguement disponible en mode de contrble PC. Le raccourci est la
touche Space Bar selon le lecteur activé (touche TAB).

£



33. Touche Cue
Appuyer sur cette touche pour accéder au mode Cue. Vous pouvez définir un
point Cue selon deux maniéres.

a) Cue-Pause
En mode de lecture, appuyer sur la touche Play/Pause -32- pour activer le
mode Pause. Appuyer a présent sur la touche Cue pour définir le point Cue.

b) Loop In
Pendant la lecture ou en mode Pause, vous pouvez appuyer sur la touche
Loop In pour définir un point Cue. Les raccourcis claviers respectifs sont ,,F1"
(lecteur 1) ou ,,F9" (lecteur 2).

34. Touche marche avant/arriére

La touche marche avant/arriere sert a définir le sens de lecture de la piste
(forward ou reverse). En mode Timecode, cette touche indique le sens de
rotation du disque.

35. Touches Skip
Utiliser ces touches pour charger la piste précédente ou suivante de votre

médiathéque Spin!.

36. Touches de recherche rapide
Ces touches servent a naviguer rapidement en avant ou en arriére dans une

piste.
37. Touches Pitch Bend

Appuyer sur la touche Pitch Bend pour activer le réglage fin de la vitesse.
Enfoncer touches Pitch Bend pour freiner ou accélérer temporairement Ia
vitesse. Relacher la touche pour que le lecteur retourne a la vitesse réglée a
I'aide du Pitch-Fader. Cette fonction peut aussi étre utilisée en tournant la Jog-
Wheel en mode de controle PC (voir mode Jog Spin!). Cette fonction est

désactivée en mode Timecode.

.

J\
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38. Spin! Library

Ce navigateur affiche les principales informations des pistes de votre Spin!
Library. Pour sélectionner directement une piste dans la librairie, cliquer sur la
piste et la tirer via Drag & Drop sur le lecteur désiré.

Vous pouvez aussi directement sélectionner la fonction Track-Select sur le
disque Timecode (voir chapitre 1.4, paragraphe b).

Le raccourci clavier ,,V" permet d'activer la Spin! Library pour naviguer dans
celle-ci avec les touches fléchées haut/bas. Cliquer sur la touche Enter pour
charger la piste dans le lecteur actif. La touche TAB permet de commuter entre
le lecteur 1 et le lecteur 2.

1. Search Filter
Cette option permet de rechercher une piste par des mots-clés. Plus la saisie est
précise, plus la recherche sera affinée.

2. Exact Match
Si cette option est activée, seuls les résultats correspondant exactement au mot-
clé sont affichés.

3. Selection Filter
Permet de définir des criteres de sélection pour la recherche.
Vous pouvez choisir :

o Al
Sélectionner ce critere pour rechercher dans toutes les catégories.
e File

Sélectionner ce critére pour uniquement rechercher dans les noms de
fichiers.
e Title
Sélectionner ce critére pour uniqguement rechercher dans les noms de titres.
e Artist
Sélectionner ce critére pour rechercher uniquement dans les noms
d'interpreétes.
e Album
Sélectionner ce critére pour rechercher uniguement dans les noms d'albums.
e Genre
Sélectionner ce critére pour rechercher uniquement dans les genres.
e Remix
Sélectionner ce critére pour uniguement rechercher dans les remix.
e Year
Sélectionner ce critére pour uniguement rechercher les années.
e BPM
Sélectionner ce critére pour uniguement rechercher selon les vitesses.
e Directory
Sélectionner ce critére pour uniquement rechercher dans les noms de
classeur.



4. Categories

Cet affichage montre toutes les informations de la piste telles que titre, nom ou
BPM. Vous pouvez définir vous-méme des catégories en cliquant avec le bouton
droit sur la barre des catégories (Columns Properties).

Vous pouvez choisir :

Title

Artist
Album
Genre

BPM
Duration
Last Played
Remix
Rating
Comments
Year

Track

File
Directory
File Name
File Extension
Date Created
Label
Producer
Key
Counter

NOTE

Vous pouvez éditer toutes les informations d'une piste en exécutant un
double clic avec la souris dans le champ de catégorie respectif. Si vous
désirez enregistrer définitivement ces informations (ID3 TAG) pour la piste,
sélectionner la piste et cliquer dans le menu sur : > Track > Save ID3 TAG
Attributes

Cliguer sur le bouton droit de la souris dans la vue Spin! Library pour ouvrir un
menu contextuel disposant des options suivantes :

Add Track (voir 3.2.8)

Auto Search (voir 3.2.7)

Track Preferences (voir 3.3.1)

Analyse BPM manually (voir 3.3.3)

Analyse BPM automatic (voir 3.3.4)

Select All

Marque toutes les pistes de la Spin! Library actuellement chargée.

Delete

Supprime les titres sélectionnés de la Spin! Library.

Add to Spin! List

Ajoute les pistes marquées dans la Spin! List.

Group

Permet d'affecter ou de supprimer les pistes marquées d'un groupe ou d'une
liste de lecture personnelle. Voir détails au paragraphe 49.

List View

Permet de régler votre Spin! Library en mode d'affichage List View. La List
View affiche seulement les titres. Ceci permet d'afficher plus de titres dans
la liste sans avoir a la dérouler.

Detail View (préréglé)

Cette vue montre toutes les catégories affichées pour une piste.

Column Properties

Permet d'afficher ou de masquer différentes catégories comme décrit plus
haut.

)
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39. Effet Delay

Cliguer d'abord sur la touche d'activation de lI'effet -39- au-dessus du
potentiométre Delay. L'effet Delay est a présent activé. Tourner le potentiométre
Delay pour régler l'intensité de I'effet Delay. Appuyer de nouveau sur la touche
d'activation de I'effet pour désactiver I'effet.

40. Effet Filter

Appuyer d'abord sur la touche d'activation de [I'effet -40- au dessus du
potentiométre Filter. L'effet Filter est a présent activé. Tourner le potentiométre
Filter pour régler I'intensité de I'effet Filter. Appuyer de nouveau sur la touche
d'activation de I'effet pour désactiver I'effet.

41. Effet Flanger

Appuyer d'abord sur la touche d'activation de ['effet -41- au dessus du
potentiométre Flanger. L'effet Flanger est a présent activé. Tourner le
potentiométre Flanger pour régler l'intensité de I'effet Flanger. Appuyer de
nouveau sur la touche d'activation de I'effet pour désactiver I'effet.

e e ey

Flanger--: Filter =+« Delay ---

510243
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42. Fonction Beat Loop/Auto Loop

Votre logiciel Reloop Spin! est équipé d'une fonction Beat Loop intelligente.
Celle-ci permet sur pression d'une touche de définir automatiquement des
boucles synchronisées indépendamment du tempo réglé. Il n'est donc plus
nécessaire de définir manuellement les points In et Out.

Sélectionner le tempo désiré avec les touches de tempo Beat Loop -42 b- (tempo
1/2 - 16). Activer la fonction Beat Loop d'une pression sur la touche Beat Loop -
42 a-; celle-ci clignote en mode Beat Loop. La touche Play/Pause -32- permet de
quitter la fonction Beat Loop.

Utilisation avec le clavier :

+ En mode de lecture, appuyer sur ,,F4" (lecteur 1) ou ,,F12" (lecteur 2) pour
activer le mode Beat Loop.

« Utiliser les touches ,F5"/"F6" (lecteur 1) ou ,,F7"/“F8" (lecteur 2) pour
rallonger ou réduire la boucle.

« Appuyer sur la barre d'espace pour quitter le mode Auto Loop (sélectionner
le lecteur actif avec la touche TAB).

43/44. Fonction Loop manuelle

+ Pour définir une boucle manuellement, cliquer sur la touche Loop In -44-
pour définir le point initial et sur la touche Loop Out -44- pour définir le point
final désiré.

+ Appuyer une fois de plus sur la touche pour quitter la fonction Loop.

« Appuyer sur la touche Reloop -43- pour retourner a la derniere boucle
définie.

[Fonction [Player 1 [Player 2
Loop In F1 F8
Loop Out F2 F10
Reloop F3 F11

(i) o) (oo ] fommmn]
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45, Crossfader

Le Crossfader -45- est exclusivement réservé au mode de contréle PC. En mode
Timecode normal (console de mixage externe), ce curseur ne s'utilise pas. Il
permet d'enchainer entre le canal 1 et le canal 2.

NOTE
En mode Timecode, il doit rester positionné au milieu.

|HI-‘£'!IIII;J|{'

Ch Ch
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46. Fonction Beat Match

La fonction Beat Match est un outil pratique pour synchroniser rapidement les
tempi de deux différentes piste sur simple pression d'une touche. Vous pouvez
ainsi ajuster le lecteur de gauche sur celui de droite ou inversement.

Beatmatch Shortcut
Player 1 W
Player 2 X

47. Points Cue

Vous pouvez définir jusque 6 points Cue sur chaque piste. Ceux-ci sont
automatiqguement enregistrés jusqu'a ce qu'ils soient écrasés. Pour définir un
point Cue avec la souris, cliguer sur le bouton droit au moment respectif. Pour
rappeler un point Cue, il suffit de cliquer dessus avec le bouton gauche de la
souris. Un point Cue enregistré est signalé par le repéere vert de la touche Cue
correspondante. Définir le point Cue une fois pour le lecteur 1 avec les numéros
1-5 (uniqguement 5 points Cue par lecteur) et pour le lecteur 2 avec les touches
6 - 0. Appuyer de nouveau sur les numéros correspondants pour appeler le point
Cue respectif (Hot Cue).

.
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48. Info-View

Nathan Fake - The Sky Was F

Remain: 05:50.98

Repeat: OFF Out Port:

1. Title
— Affiche le titre de la piste actuelle. Cliquer sur le bouton droit de la souris pour
sélectionner l'affichage du titre, de I'artiste ou de I'artiste et du titre.

2. Elapsed
Affiche la durée écoulée de la piste (minutes/secondes/frames).

3. Remain
Affiche la durée restante de la piste (minutes/secondes/frames).

4. BPM
Affiche la valeur BPM actuelle.

5. Fonction Repeat
Sert a activer ou désactiver la répétition d'une piste. Si la fonction Repeat est
activée, le titre chargé est répété automatiquement.

6. Out Port

Affiche quel canal de sortie de l'interface est affecté au lecteur. Le réglage
correct est ,,01" pour le lecteur de gauche et ,,02" pour le lecteur de droite. Vous
pouvez modifier le port en cliguant dessus.

7. Pitch
Affiche la valeur Pitch actuelle.

49, Category View

Category View est un filtre de sélection rapide pour la Spin! Library. Il permet par
exemple d'afficher la Spin! Library View triée selon I'ordre alphabétique, I'année
ou la vitesse en BPM.

L'option ,,Groups" vous permet de créer des listes personnalisées ou de trier une
liste. Pour créer un nouveau groupe, cliguer avec le bouton droit de la souris sur
»Add Group" dans la Category View. Vous devez ensuite saisir un nom et le
valider en appuyant sur la touche Enter.

18




50. Music Explorer/Audio Input

Music Explorer est un navigateur de fichiers avec arborescence similaire a
I'Explorateur Windows. Il vous permet de rechercher des fichiers sur votre poste
de travail ou votre environnement réseau. L'interface Spin! est ici également
indiquée sous l'option ,,Audio Input”. Les différentes entrées sont affichées dans
une liste. Cliquer&tirer sur les entrées pour les charger simplement dans les
lecteurs.

NOTE

Le réglage correct des entrées a été effectué d'usine. Uniquement en cas
d'enregistrement microphone, il faut affecter I'entrée ,,0: Reloop Spin!-
Interface 1" a un lecteur.

51. Fonction Mic Rec

La fonction Mic Rec intégrée (Mic Spin!) permet d'enregistrer un échantillon
avec le microphone que vous pouvez par exemple scratcher ultérieurement.
Procéder comme suit :

e Enregistrement de I'échantillon

- Tirer I'entrée ,0: Reloop Spin!-Interface 1" sous Audio Input (Music
Explorer) par Drag & Drop dans un lecteur.

- Régler le niveau avec le régleur de volume Mic.

- Appuyer sur la touche Rec.

- Un dialogue de sauvegarde s'affiche ; entrer le nom et I'emplacement dans
lequel I'échantillon doit étre enregistré.

- L'enregistrement commence apres la pression sur ,,Enregistrer” ; appuyer
de nouveau sur la touche Rec pour terminer I'enregistrement.

¢ Fonction Mic Spin! (lire ou scratcher un échantillon)
- Tirer a présent la piste désirée de la Spin! Library ou de ['échantillon
microphone enregistré du Music Explorer par Drag & Drop dans le lecteur
pour pouvoir le manipuler avec le disque.

NOTE

L'entrée Mic est couplée a Input 1. L'entrée 1 Phono/Line se désactive dés
que vous branchez le microphone. Si vous désirez enregistrer un échantillon
lors d'une session de mixage, il faut veiller a ce que le lecteur 2 exécute la
lecture actuelle. Aprés I'enregistrement, il est indispensable de débrancher
le microphone pour pouvoir de nouveau controdler le lecteur 1 avec le disque.
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52. Fonction Monitor

La fonction logicielle Monitor permet de pré écouter une piste. Cependant, si une
console de mixage externe est utilisée, cette fonction n'est plus utile, car la pré
écoute s'effectue alors normalement avec la fonction Cue de la console.

3. GUIDAGE DES MENUS RELOOP SPIN! :

Cette section expliqgue les détails de toutes les rubriques de menu.

3.1 Rubrique File :

3.1.2 Options :

Sert a accéder au menu Options dans lequel vous pouvez effectuer divers
réglages. Veuillez trouver de plus amples informations au chapitre ,....."” de ce
manuel.

3.1.3. Quit SPINNING :
Quitte le logiciel Reloop Spin!

3.2. Rubrique Spin! Library :

La médiathéque Reloop Spin! sert a gérer vos fichiers audio. Vous pouvez au
choix créer et enregistrer diverses médiathéques. Vous pouvez importer votre
musique dans la médiatheque Spin! afin de regrouper vos fichiers. Vous pouvez
éditer les médiathéques, les exporter ou importer de nouvelles listes (par ex..
listes de lecture iTunes).

3.2.1 New :
Permet de créer une nouvelle médiatheque vide que vous pouvez au besoin
remplir avec des fichiers audio.

3.2.2 Open :
Ouvre une médiathéque existante.

3.2.3 Save :
Enregistre la médiatheque.

3.2.4 Save as...:
Enregistre la médiathéque actuelle sous un autre nom sans écraser la version
précédente de la médiatheque.

3.2.5 Import :
Permet d'importer des fichiers. [ iTunes (*.xml) / m3u (*.m3u)]

3.2.6 Export :
Sert a exporter des fichiers. [m3u (*.m3u)]

3.2.7 Automatic Search :
Lors d'importation de grands volumes de fichiers audio, cette fonction facilite la
recherche sur le disque dur ou dans des classeurs.

3.2.8 Add Track :
Ajoute différentes pistes a une médiathéque.

3.2.9 Select All :
Sélectionne toutes les pistes d'une médiatheque.



3.2.9.1 Delete :
Efface des fichiers de la médiathéque actuellement chargée, sans pour autant
supprimer les fichiers du disque dur.

VA

3.3 Menu Track :

3.3.1 Track Preferences :
Permet d'effectuer des réglages spécifiques pour une piste.

3.3.2 Save ID3 TAG Attributes :
Si vous modifiez les attributs ID3 TAG, vous pouvez les enregistrer.

3.3.3 Analyze BPM manually :

Cet outil permet de calculer les BPM (Beats Per Minute) manuellement. Cliquer
avec la souris sur le bouton Space ou utiliser la touche d'espace. Plus vous
cliquez sur la touche respective au rythme du tempo, plus la valeur calculée est
précise.

3.3.4 Analyze BPM automatically :

Cette fonction sert a calculer automatiquement la valeur BPM, mais les
battements ne peuvent pas étre calculés par le logiciel si la structure rythmique
n'est pas continue ou si les battements se distinguent trop faiblement du reste
de la piste pour pouvoir étre identifiés en tant qu'élément rythmique. Le tempo
4/4 est idéal pour le logiciel Reloop Spin!.

NOTE

Vous pouvez aussi analyser automatiquement plusieurs pistes. Au premier
chargement d'une piste dans un lecteur, les BPM sont calculés
automatiqguement et enregistrés.

3.3.5 Delete tracks permanently :
Cette fonction vous permet de supprimer une piste.

ATTENTION !
La piste est alors supprimée définitivement de votre disque dur et n'est pas
seulement effacée de la médiathéque.

SIVHANVYN 4

3.4 Menu Spin! List :

La Spin! List est une liste de lecture pour une session. La lecture des pistes de
cette liste et leur enchalnement automatique s'effectue alors alternativement
sur les lecteurs 1 et 2. Cette fonction est idéale pour utiliser le logiciel en mode
Stand Alone sans intervention d'un DJ.

3.4.1 Play Spin! List :
Lance la lecture de la liste de lecture Spinl.

3.4.2 Stop Spin! List :
Arréte la lecture de la Spin! Playlist.

3.4.3 Add to Spin! List :
Ajoute la piste actuellement sélectionnée a la médiathéque de la Spin! List.

NOTE
Vous pouvez aussi ajouter les pistes par Drag & Drop a la Spin! List.

3.4.4 Safe Mode :

Lorsque Safe Mode est activé, il n'est pas possible de charger une nouvelle piste
dans le lecteur actuel. Ceci empéche le chargement involontaire de fichiers
pendant une session en cours.
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3.5 Menu Spin! Workspace :
Ce menu permet d'afficher ou de masquer certains éléments afin de
personnaliser I'affichage.

3.5.1 Workspace Arrangeable :
Activer pour réorganiser et fermer différents éléments des fenétres.

3.5.2 Full Screen View :
Active le mode plein écran. Vous pouvez aussi entrer cette instruction avec la
combinaison de touches ALT+S.

3.5.3 Menu Bar View :
Afficher ou masquer la barre des menus.

3.5.4 Shortcut View :
Afficher ou masquer les raccourcis clavier.

3.5.5 Info View :
Afficher ou masquer la barre Infos.

3.5.6 Preview
Afficher ou masquer "Preview".

3.5.7 Spin! Library View :
Afficher ou masquer la médiathéque Spin!.

3.5.8 Spin! List View :
Afficher ou masquer la Spin! List.

3.5.9 Category View :
Afficher ou masquer les catégories.

3.5.9.1 Music Explorer / Audio Input :
Afficher ou masquer Music Explorer / entrées audio.

3.5.9.2 X-fader Match View :
Afficher ou masquer X-Fader match.

3.5.9.3 Master/REC-Volume :
Afficher ou masquer le volume Master/REC.

3.5.9.4 Beatmatch View :
Afficher ou masquer Beatmatch.

3.6 Menu Help :

3.6.1 Easy Setup :
Exécuter l'installation rapide.

3.6.2 Manual :
Accéder au manuel en tant que fichier PDF.

3.6.3 www.reloop-spin.de
Connecte au site Internet reloop-spin.de. Consulter régulierement cette page
pour étre informé des téléchargements ou informations actuelles.

3.6.4 Configuration Log :
Permet de créer un fichier texte contenant la vue d'ensemble de la configuration
actuelle du systéme. Ce fichier peut étre requis en cas de dépannage.

3.6.5 About Spin! :
Affiche la version Spin! actuelle.



4. REGLAGES

4.1 Options
Le menu Options est accessible sous > File > Options.

4.1.1 System
Optians %)

System | BPM and Tooks | Audio devices | Timecods | wirkspass | Shetteuts | MIDI-Contier |

i~ Track

. o — N
1 Fo gad T rak (SFN i [ =) 4
2 (it [ ) Set directory whers h
O L o] warveltommns ane saved J J 5
3 (Tags. I ID3Tag¥id
¥ ID3Taght2
~ Optimizatiol
6 £ Software Mult-Open Load back to RAM  [nomal = 8
7 % Sound before Graphic priority (Lnad trackin FAM  [T3 == lenath limit/minutes } 9

10 ¥ Easy Kepboard Search Tone pitch B 3: # n

Abbrechen

1. Load last Track
Si cette option est activée, en cas de démarrage logiciel, la derniére piste lue et
Spin! Library sont chargées.

2. Record Play

Si cette fonction est activée, toutes les pistes lues sont enregistrées avec la date
et I'heure dans une liste. Cliquer sur le bouton , View List" pour afficher ces
informations.

3. TAGs
Permet de sélectionner quelle version des ID3 TAGs doit étre affichée. Une seule
sélection est possible.

4. Play List Directory
Permet de sélectionner le chemin pour I'enregistrement/chargement de la Spin!
List.

5. Waveform Directory
Permet de spécifier le chemin dans lequel les informations Waveform Peaks
doivent étre enregistrées. (non recommandé/dépend de la version ASIO).

6. Software Multi Open
Si cette fonction est activée, vous pouvez ouvrir plusieurs Reloop Spin! (non
recommandé/dépend de la version ASIO).

7. Sound before Graphic Priority

Si cette option est activée, la performance du systéme est affectée en priorité
aux taches audio au lieu des taches graphiques. Ceci peut étre utile sur des
ordinateurs anciens ou peu performants (par exemple si la lecture saute).
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8. Load Track to RAM
Permet de régler la vitesse de chargement de la piste dans la mémoire RAM.
(lente/normale/rapide).

9. Load Track in RAM/Min.
Permet d'indiguer en minutes la longueur maximale de la piste devant étre
chargée dans la mémoire RAM.

10. Easy Keyboard Search
Activer cette fonction pour faciliter la recherche avec le clavier.

11. Tone Pitch
Permet de régler le pourcentage de la gamme dans laguelle la tonalité doit étre
variée (voir aussi chapitre 2, paragraphe 28).

4.1.2 BPM and tools
M

System  BPM and Took | udio devices | Timecods | workspase | Shortcuts | MIDI-Contoler |

[ Auto-BPM

(EPMHangefurAulo—Euuntmg Min: |78 3: BFM Max: |150 H: BFM)

¥ Shaow Pitch Walue

|v Calculate BPM and Waveform an load

¥ Auto-Gain Function

OI0I0I0I6

|» BPM Match Function

i~ Cus-Painl

{Autn-[lua'  Ne FYESJ (T\melangefnlseal:hlr\gfllstEue-Fnll’\t = s) (dE Sensitiviy [30  — )

(=)

- Time-Adj.
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Abbrechen
Q (10)

1. BPM Range

Permet de régler la marge BPM dans laquelle le logiciel doit calculer. Plus la
différence est faible, plus le calcul des BPM par Spin! est rapide et précis. Le
préréglage est entre 78 - 150 BPM.

Réglages recommandés :

+ All-Round 78 - 150 BPM
+  Hip Hop 80 - 120 BPM
+  House/Techno 110 - 150 BPM

2. Show Pitch Value
Active le témoin Pitch (préréglé et recommandé).

3. BPM and Waveform
Si cette option est activée, Spin! calcule les BPM et le tracé de I'onde au
chargement d'une piste.



4. Auto Gain

Si cette fonction est activée, les valeurs de Gain de pistes de volumes différents
sont ajustées. L'ajustement manuel avec le régleur de Gain -27- n'est alors plus
nécessaire.

5. BPM Match
Active la fonction Auto Match pour les nouvelles pistes chargées.

NOTE
La touche Beat Match -46- vous permet aussi de synchroniser chaque face.

6. Auto Cue
Activer et désactiver la fonction Auto Cue.

7. First Cue Point Search
Permet de définir une durée en secondes dans laquelle le premier point Cue doit
étre recherché.

8. Decibel Sensitivity
Permet de régler la sensibilité en décibels a partir de laquelle le point Cue doit
étre défini.

9. Fading Time
Permet de régler la durée d'enchainement pour la fonction Auto Mix de la Spin!
List.

10. End of Track Warning
Permet de régler la durée en secondes a partir de laquelle un signal optique doit
avertir la fin de la piste.

4.1.3 Audio Devices
M

System | BPM and Tooks Audio devices | Tinecods | workspass | Shortcuts | MIDI-Contoler |

Output Device Feloop Spw-ltte.faca - e ﬂ
G B
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Abbrechen

1. Output Device
L'interface Reloop Spin! Interface doit étre sélectionnée et affichée ici.

2. Out Ports
Sert a définir le nombre de sorties. Il faut régler ,,2".
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3. Setup
Permet de régler les différentes sorties pour les cotés gauche et droite. Le
bouton ,,Control Panel” dans ASIO-Setup permet de régler la taille du tampon.

NOTE

Tous les réglages Audio Devices sont effectués automatiquement lors du
Setup, aucune modification n'est requise de votre part.

T

>

4.1.4 Timecode
Options m

System | BPM and Tools | Audio devices  Timecods | warkspace | Shaiteuts | MIDI Contioler |

Mol E
Noiss Filtsr (=]

o]

~Player 1 Player 2
@— +—Timecads fiom [virgt | [vinyl =l
@——ww Mode | Battle SPIN! | | Classic SPINI =l
@— —Audio device Jasio =l Jasin =l
—Audio Sourcs | 0Retoop Spintinterace 1-Felaop Spintd x| | 2Relnop Spinnterface 3Reinop Spind > |
@— —Timecode ualy o 100
@— —{Adiusl Gain (0B) E= N = s = v = HE
—Direct Phana Input No = No o BB
45 RPM I ] I I
@— —Left/Right Inverse o u
—FPhase Inverse r o
— et [l =1 Saveposiion [0 = Saveposiion
o
(13}
(=)

Calibrate 1 Calibrate 2

Apply

Circle diagram | 1 Tumntable Mode |

EE Bbbrechen
Ce menu Timecode détaillé permet de procéder a différents réglages pour le
lecteur 1 et le lecteur 2. Cependant, ces réglages ne sont pas nécessaires si Easy

Setup a été correctement exécuté. Vous devez donc uniqguement paramétrer les
réglages avancés pour le dépannage et 'optimisation.

FRANCAIS

1. Timecode from
Sert a spécifier la source Timecode, donc disque vinyle ou compact.

2. Spin! Mode
Active le mode Spin! (voir chapitre 2, paragraphe 31).

3. Audio Device
Le pilote ASIO doit étre activé.

4. Audio Source
Sert a affecter les connecteurs respectifs de I'interface Spin!.

Les préréglages sont :

+ Lecteur1:0: Reloop Spin!-Interface1 - Reloop Spin!-Interface 2
+ Lecteur 2:2: Reloop Spin!-Interface 3 - Reloop Spin!-Interface 4
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5. Timecode Quality

Affiche la qualité de signal du Timecode en pourcentage. Une aiguille sale ou
usée peut causer des fluctuations ou un pourcentage de qualité faible.
Normalement, la valeur doit étre entre 90 - 100%.

6. Adjust Gain

Permet de régler la valeur en décibels du signal d'entrée pour les c6tés gauche
et droite. La barre de DEL virtuelle sert d'affichage de saturation. Cette valeur
ne doit étre modifiée manuellement qu'en cas de dépannage. Avec Easy Setup,
la valeur de Gain optimale est configurée automatiquement.

7. Direct Phono Input

Permet de spécifier si une platine vinyle est directement connectée a
I'ordinateur. Lorsque l'interface Spin! (Line Output) est utilisée, ,No" doit étre
affiché.

8. 45 RPM
Sert a régler si le disque Timecode doit étre lu avec 45 RPM (Rounds Per Minute
= tours par minute). La valeur usuelle de 33 RPM est préréglée.

9. Left/Right Inverse

Avec certaines aiguilles ou problémes de calibrage, il peut arriver que les cdtés
gauche et droite soient inversés. Cette option permet de supprimer ce probléme
au niveau logiciel.

10. Phase Inverse

Permet d'inverser la phase. Quelques systemes, par exemple Shure M44-7 ou
lecteurs de disques compacts requierent cette inversion pour fonctionner sans
probleme.

11. Timecode Start Delay.

Permet de définir le point de départ du disque Timecode. Etant donné que
normalement le premier tiers d'un disque Timecode s'use d'abord, le point de
départ peut étre décalé sur une position au choix. Poser ['aiguille sur la position
désirée et appuyer sur le bouton ,,Save Position”. La valeur est affichée en
millisecondes.

12. Noise Level/Noise Filter
Ces deux valeurs sont uniquement destinées au dépannage ou a I'optimisation.
Avec Easy Setup, ces valeurs sont préconfigurées.

e Noise Filter :
en cas de problémes de masse ou autres, vous pouvez augmenter le Noise
Filter, par exemple a 150, afin d'améliorer le signal d'entrée. Plus le plus est
élevé, plus la fréquence doit étre augmentée.

ATTENTION !
Un réglage excessif du Noise Filter peut affecter la précision Timecode.

e Noise Level :
permet de régler le niveau de bruit en décibels. Augmenter la valeur pour
une meilleure sensibilité. Le préréglage est 40 dB.

13. Affichage du calibrage

Représentation optique du signal Timecode. Normalement, le signal doit étre
représenté sous forme de courbe sinusoidale.

Si le signal est déformé (onde rectangulaire), il faut soit controler I'aiguille, soit
ajuster les réglages décrits plus haut.
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14. Circle Diagram
L'affichage de calibrage peut aussi étre représenté sous forme de cercle. Il suffit
pour cela de cliguer ce bouton.

15. Touche Calibrate
Appuyer sur cette touche pour calibrer automatiquement le lecteur respectif
avec les options préréglées.

16. 1 Turntable Mode

Si vous utilisez une seule platine vinyle, il faut activer ce mode pour controler les
deux lecteurs. Vérifier que I'entrée de l'interface utilisée soit la méme dans
Audio Source (voir paragraphe 4).

CONSEIL
Vous pouvez commuter le lecteur actuel avec la touche TAB.

17. More Options
Cliquer sur ce bouton pour afficher les options avancées (Noise Level/Noise
Filter et 1 Turntable Mode).

18. Apply
Cliguer sur ce bouton pour appliquer les réglages. Cliquer ensuite sur ,,OK" pour
quitter le menu.

4.1.5 Workspace

M

System | BPM and Tools | Audio devices | Timecads Warkspace | Sharteuts | MIDI Contoler |

- Workspace Fil

SPINI

(e

)

Resolution:

1280 Widescreen

=
Appl 2
"SPING 1280 —

Abbrechen

1. Resolution Selection
Affiche une liste des résolutions disponibles. Sélectionner la résolution adéquate
pour votre écran.

2. Apply
Appliquer les réglages avec le bouton Apply.



4.1.6 Shortcuts

System | BPH and Tools | Audic dvices | Timecods | Workspace  Shertcuts | MIDI-Contioler |

+ Shortcut-Setting Fil

Spin_Keyboardds
Spin_Kepboard?ZERTY
Spin_Kepboardd'W
Spin_KeyboarddWERTY

LooP BEATLOOP BEATLOOP LOOP

am— s |
[ o 3

Abbrechen

1. Shortcut Setting File
Permet de sélectionner I'organisation des raccourcis pour votre clavier.

Vous pouvez choisir :

+  Spin_keyboardQWERTZ

(Allemagne, Autriche, Suisse, Hongrie)
+  Spin_keyboardQWERTY

(USA, GB, Pays Bas, Italie, Pays scandinaves, Pologne, Espagne, Portugal)
+  Spin_keyboardAZERTY

(France, Belgique)

2. Layout Preview
Affiche une prévisualisation de I'affectation du clavier.
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4.1.7 MIDI Controller

Options

System | BPM and Tools | Audio devices | Timecods | Workspacs | Shortcuts MIDI-Contioler |

i~ MIDI Input

ActivateMIDI: [T

)

nnnnn D I (=]
- -

MIDI-Setup-Fils{s)

()

()

Abbrechen

1. Activate MIDI
Active le contrdle MIDI pour Spin!

2. MIDI Device
Affiche une liste des contrdleurs MIDI compatibles, par ex. Reloop Digital Jockey
(www.digital-jockey.d)).

3. MIDI Setup File
Affiche une liste des fichiers de configuration MIDI préconfigurés.

4. Omni Mode
Si cette option est activée, Spin! recoit sur tous les canaux MIDI.

NOTE
Vérifier régulierement les mises a jour Spin! sur le site : www.reloop-spin.de
par exemple pour télécharger des nouveaux MIDI-Mappings.



4.2 Auto Search

0 sCd r or directo
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La fonction Auto Search vous permet de trouver aisément des fichiers audio sur
votre disque dur et de les ajouter a votre Spin! Library.

1. Chemin
Affiche le chemin actuellement sélectionné.

2. Select Directory
Permet de sélectionner des classeurs individuels.

3. Add Directory
Si cette option est activée, un classeur est ajouté.

4. All Drives
Activer cette option pour sélectionner automatiquement tous les
lecteurs/disques de votre environnement pour la recherche de pistes.

5. Subdirectories
Activer cette option pour rechercher également dans les sous-classeurs.

6. No Duplicate
Si cette option est activée, les pistes déja contenues dans la Spin! Library ne sont
pas de nouveau ajoutées aprés une deuxiéme recherche dans un méme classeur.

7. Advanced Search
Permet d'utiliser des catégories telles que : artiste, titre ou genre pour la
recherche.

8. Exact Search
Si cette option est activée, seuls les résultats exacts seront ajoutés.

9. All Fields Search
Activer cette option pour rechercher dans tous les champs de catégorie.

10. Initialize Spin! Library
Activer cette option pour initialiser la Spin! Library.

N
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4.3 Track Preferences

Track Preferences vous permet d'activer ces réglages et les données d'une piste.
Pour accéder a Track Preferences, aller a la rubrique :

> Track > Track Preferences

ou cliquer sur la piste avec le bouton droit de la souris dans la Spin! Library.

4.3.1 Infos
Permet de consulter et d'éditer diverses informations telles que titre, interpréte
ou label. Vous pouvez aussi enregistrer des commentaires relatifs a la piste.

M
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Cover I E qualization I Cue-Points I Loop
Infoz | File | Track. zettings | Walume | Lyricz
Tile  |ChubKartuscheD3 Track |04
Arist  |typ2 Year |2003
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R emix |Fleh-1i:-: Label Ithru:unfu:ulger

Comments | muspace. com/typ?

Ok I Abbrechen

4.3.2 File

Affiche les informations d'emplacement de sauvegarde et de qualité audio.

M

Cover I
Infog File

E qualization I

Cue-Points I Loop
Track zeftings

IE: yp2_Clubk.artbuzche. mp3
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Encode by I
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4.3.3 Track Settings

Permet de consulter et d'éditer divers réglages tels que point initial et point

final, boucles ou tempo.

M

Cover I E qualization I Cue-Points I Loop
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Baze tempo IU 3: Saong gainlﬂ 3: Saong key I

0 : Out il =

oKk | Ahbrechenl

4.3.4 Volume

Permet de prérégler au choix Gain, Pan ou Fade In/Out pour une piste.

M

Cover I E qualization I Cue-Points I Loop
Irifios I File I Track setings Wolume | Lyrics
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4.3.5 Lyrics

Permet le cas échéant, d'entrer et de consulter les textes de chansons.
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4.3.6 Cover

Permet de charger et d'afficher une image de pochette pour la piste.
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4.3.7 Equalization

Sert aux réglages de I'égaliseur.

M

Infos
Cover

{ Bass

 Mid
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" Treble IEI 3:

File | Track zettings | Yalume I Lyricz
Equalization Cue-Pairts I Loop
Equalization Sterea
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" Mono
" Waice removal [center
 Vaice removal [phaze]

" Channels inverted [L<->R)
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4.3.8 Cue Points

Permet le cas échéant, de prédéfinir jusque 10 points Cue.
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4.3.9 Loop
Permet le cas échéant de prédéfinir jusque 10 boucles.

5 |

1t Irac
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5. FAQ

5.1 Faut-il monter une aiquille spéciale sur la platine vinyle pour pouvoir
utiliser Spin! ?
Non. Par principe, Spin! fonctionne avec n'importe quelle aiguille. Il faut
cependant vérifier quelgues points pour assurer un fonctionnement
irréprochable :

L'aiguille ne doit pas étre usée, ni encrassée. S'il s'agit d'une cellule, celle-ci doit
étre correctement ajustée. Elle doit en outre disposer d'une tension de sortie
élevée pour transmettre un signal Timecode ,,pur” au logiciel. Pour cette raison,
Spin! est aussi disponible avec ORTOFON DIGITRACKS. La construction Ortofon
»Concorde” supprime I'ajustement de ['aiguille sous une cellule et la tension de
sortie élevée de 8mV garantit un signal Timecode ,,puissant” et peu sensible aux
pannes.

5.2 Peut on aussi acheter les disques Timecode séparément ?

Bien s(r. Les disques Timecode s'usent plus vite que des vinyles normaux, car ils
restent inchangés pendant toute la session. Outre 'usure normale et les rayures
qui en résultent, les particules de poussiere, de graisse, de nicotine et de vodka-
martini mettent les disques a rude épreuve. Vous trouverez aisément des vinyles
noirs, blancs mat et vert dans le commerce spécialisé.

5.3 L'ordinateur ne détecte pas l'interface Spin!...

Ceci peut étre d0 a diverses causes spécifiques de I'ordinateur. Pour commencer,
nous recommandons de déconnecter tous les autres périphériques USB de
['ordinateur afin d'exclure tout conflit (par ex. avec d'autres cartes son).

Il faut en outre éviter de connecter l'interface a I'ordinateur par un Hub. Si
['utilisation d'un cable de rallonge USB est incontournable, appliquer la régle
,aussi long qu'il faut, le plus court possible”.



5.4 Une platine vinyle n'envoie pas de signal Timecode ?
Une platine vinyle peut aisément lire des fichiers MP3s, mais la deuxieme platine
ne fonctionne pas et Spin! affiche qu'il n'a pas trouvé le signal Timecode ?

Deux possibilités : un microphone est branché a l'interface et le lecteur 1 ne
fonctionne plus. Il suffit alors de débrancher le microphone de l'interface pour
gue tout fonctionne de nouveau normalement (le Mic est couplé avec Input 1).

Pas de microphone branché ? Deuxiéme possibilité pour chercher I'erreur : Si
sous ,,Options / Timecode" uniguement UNE ou AUCUNE onde n'est affichée, le
probléeme se situe au niveau du cablage entre l'aiguille et l'interface. Pour
dépanner Spin!, IL FAUT qu'une onde sinusoidale rouge et une blanche soit
affichées (donc DEUX ondes dans CHAQUE FENETRE) !

La premiére mesure consiste a interchanger les deux aiguilles pour vérifier si le
probleme persiste. Si le probléme passe avec l'aiguille a I'autre platine, I'aiguille
est cassée ou les contacts sont encrassés. Utiliser un coton-tige imbibé d'alcool
pour nettoyer l'aiguille, ainsi que les contacts du bras de lecture. Ne PAS
pulvériser un spray de contact dans le bras de lecture ! Pour vérifier si le signal
stéréo passe, lire un disque normal et s'assurer que le signal est audible a gauche
et a droite avec le régleur Pan de la console de mixage.

Si les deux aiqguilles fonctionnent parfaitement sur le lecteur de droite par ex.,
mais pas sur celui de gauche, bien que les contacts du bras de lecture aient été
nettoyés, il se peut que les cables de la platine soient défectueux. Il faut alors les
remplacer. Si les cables sont fixes, il faut alors confier le remplacement a un
commercant ou un atelier spécialisé.

5.5 D'ou vient ce sifflement ?

. Vinyl Bypass" (a droite sous Label Monitor) est activé. Cette fonction permet de
lire des disques normaux, le signal audio du disque est bouclé. Etant donné que
Timecode se compose essentiellement d'un sifflement, celui-ci est alors audible.
Il suffit de désactiver la fonction Bypass et de contrdler de nouveau les pistes
numeériques avec les vinyles Timecode.

5.6 Peut-on aussi lire des vinyles normaux ?

Oui. Il faut pour cela activer le commutateur ,,Bypass”, situé a droite dans les
lecteurs, au dessus du Label Monitor (le truc qui tourne au centre). Le signal du
disque est alors bouclé et audible. Les raccourcis sont ,,N" pour le lecteur de
gauche et ,M" pour le lecteur de droite.

5.7 Pourquoi la piste est lue a I'envers ?
La platine vinyle tourne en avant, mais Spin! restitue le son a I'envers ?

La platine vinyle peut étre mal connectée a l'interface, les canaux de droite et de
gauche sont intervertis. Il faut alors inverser le branchement des cables sur
I'interface pour restaurer ['état normal. Si pour une raison gquelconque, le
cablage est difficile d'acces, vous pouvez aller dans ,File -> Options -> Timecode"
et cocher la case ,Left/ Right Inverse" pour obtenir le méme résultat qu'en
invertissant les cables. Il est quand méme préférable de brancher les cables
correctement.

5.8 Puis-je lire en 45t au lieu de 33t ?
Oui, sous ,File -> Options -> Timecode", cocher la case ,,45 RPM" et recalibrer
Spin! (veiller a ce que le Pitchfader de la platine soit sur 0%),).
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5.9 Pourquoi les deux pistes sont lues sur le méme canal ?

Affectation de OUT PORT identique pour les deux lecteurs. Dans Info Screen,
cliquer sur le chiffre derriere ,,Out Port” pour modifier I'affectation.
Normalement, le canal de gauche est affecté au Port 1 et le canal de droite au
Port 2.

5.9.1 Suis-je sourd ?
L'absence de son a de nombreuses causes. Le meilleur moyen pour détecter la
panne est un controle systématique dans I'ordre de la liste :

« Console de mixage/ampli allumé ? Les régleurs de Gain et le Linefader ainsi
gue Master sont réglés a fond ? Entrée correcte sélectionnée (Phono au lieu
de Line) ?

+ Le contréle vinyle (le commutateur ,Vinyl” sous le Label Monitor doit étre
vert) est activé ?

« Spin! est configuré pour le contrdle avec disque vinyle ?

« Le cablage est correct ?

« Le signal Timecode est détecté ?

+ Un microphone est branché ? Débrancher le micro, il blogue Input 1.

« Out Port correct réglé dans Info Screen ? Lecteur de gauche : Out Port 1,
lecteur de droite : Out Port 2.

5.9.2 Puis-je aussi utiliser I'interface en tant que carte son ?

L'interface Spin! peut aussi faire fonction de carte son avec deux entrées stéréo
et deux sorties stéréo. L'interface dispose en outre d'une entrée microphone
avec niveau d'entrée réglable. Si un microphone est branché, il fonctionne a la
place de Stereoinput 1.

5.9.3 Que faut-il respecter avec une Shure M44-7 ?
Ces aiquilles requiérent une inversion de phase. Sous ,File -> Options ->
Timecode", cocher la case ,,Phase Inverse”.

5.9.4 Comment se fait-il que les pistes sautent parfois ?

La cause est un disque dur lent. Vous pouvez dans , Options -> System” régler
['option ,Load Tracks to RAM" sur ,rapid”. Nous recommandons en outre de
veiller a ce que le disque dur contenant les pistes soit défragmenté afin
d'accélérer les acces en lecture.

5.9.5 Pourquoi la vitesse/le Pitch varie lors de la lecture ?
Ceci peut avoir différentes causes :

+ Spin! n'est pas calibré.

+ Aiguille poussiéreuse/sale.

+ Poids d'appui de l'aiguille excessif.

+ Aiguille usée.

+ Vinyle Timecode usé (rayure, cue burn) ou encrassé.

5.9.6 L'interface posséde une fonction Automix / Partymix ?

Oui. Il suffit de charger guelgues pistes dans la Spin! List (pas la Spin! Library)
et de cliquer sur le bouton droit de la souris sur ,Play Spin! List". Les pistes de
la Spin! List sont alors lues alternativement par les deux lecteurs.



5.9.7 Comment optimiser mon ordinateur pour Spin! ?

Un ordinateur fonctionnant bien et stable est une condition essentielle pour
pouvoir travailler fiablement avec Spin!l. Quelques astuces permettent
d'optimiser votre ordinateur :

réglages pour la performance du systeme. Sélectionner le réglage , Adapter
pour une performance optimale”.

+ Désactiver le mode d'économie en énergie et les autres programmes
d'arriere-plan (scanner antivirus, moniteur de réseau, etc.).

[ R
+ Dans le Panneau de configuration sous ,Systéme -> Avancé", ouvrir les M

) . . , — -
+ Désactiver les connexions réseau et LAN/WLAN. %_
+ Dans le Panneau de configuration sous ,Systéme -> Avancé", ouvrir les .

réglages pour la performance du systéme. Sous ,,Avancé” régler la priorité
pour la puissance du processeur sur ,Services d'arriere-plan”.

« Défragmenter les disques durs.

+ Ne pas faire fonctionner d'autres programmes en méme temps que Spin!.

«  Pour améliorer la performance, vous pouvez sous ,,File -> Options" cocher la
case ,,Sound before Graphic priority".

5.9.8 Que faire en cas de ronflement ou vrombissement lorsque j'utilise un
ordinateur portable ?

Essayer de débrancher le bloc secteur de I'ordinateur portable. Si le ronflement
disparatft, il s'agit d'un probléme de mise a la terre ou de boucle de masse. Vous
pouvez tenter de remédier au probléme par les mesures suivantes :

« Utiliser un bloc secteur sans mise a la terre.

« Sipossible, brancher tous les équipement sur un seul circuit électrique.

«  Essayer de poser séparément le cordon secteur et le cable coaxial de
maniére a exclure tout contact.

« Vérifier la mise a la terre correcte de la platine vinyle.

+ Intercaler un filtre anti-ronflement.

6. DESIGNATION AU CLAVIER RAPIDE
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